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Overview of the environment

IBM Security Key Lifecycle Manager delivers simplified key lifecycle management
capabilities in a solution that is easy to install, deploy, and manage.

This document focuses on the tasks that you must complete to install and
configure IBM Security Key Lifecycle Manager.

Deployment on Windows, Linux, and AIX systems

Deployment of IBM Security Key Lifecycle Manager consists of an installation
process that gathers information for database preparation, user ID configuration,
and optional data migration from the Encryption Key Manager.

On Windows, Linux or AIX systems, the IBM Security Key Lifecycle Manager
installation program deploys the IBM Security Key Lifecycle Manager server and
required middleware components on the same computer. You must ensure that the
computer has the required memory, processor speed, and available disk space to
meet the workload.

IBM Security Key Lifecycle Manager can run on a member server in a domain
controller environment, but is not supported on a primary or backup domain

controller.

WehSphere Application Server
. IBM Security Key Lifecycle Manager
"""""""" DB2 Database

Figure 1. Main components on Windows, Linux, and AlX systems

Installation overview

IBM Security Key Lifecycle Manager installation involves preparing the software
and then running the installation program.

Installation of IBM Security Key Lifecycle Manager includes the following major
steps:
1. Plan your installation and complete the preinstallation worksheets. See

“Planning the installation” on page 5| and [“Preinstallation worksheets” on page|
B1] for details.

2. Install and configure IBM Security Key Lifecycle Manager. The installation falls
into these phases:

a. Introductory that includes the introduction and language selection window,
install packages selection window, license agreement window, and disk
space information window.

b. DB2®, WebSphere® Application Server, and IBM Security Key Lifecycle
Manager installations that include windows for gathering information. After



you enter the information, the installation program installs DB2, WebSphere
Application Server, and IBM Security Key Lifecycle Manager during this
phase.

3. Log in and verify the installation. Resolve the installation problems, if any. See
“Login URL and initial user ID” on page 53|and [“Installation verification” on|

page 68| for details.

Note: Installation might take more than half an hour.

Installation package preparation

The installation package is available on a DVD, or as one or more compressed files
that you download.

Installing from a DVD
1. Insert or mount the DVD, as required by the operating system.
2. Locate the installation scripts in the root directory of the DVD.

Installing from downloaded packages

The installation package files are archive files that contain the files that are used
for the installation. Packages that are labeled “elmage <integer>" require assembly
into a temporary installation directory on your computer. For example, a package
label might be eImage 1. Paths to temporary installation directories cannot contain
spaces or special characters.

To install from elmage images, follow these assembly steps:
1. Download the elmage package files to a convenient temporary directory.

2. Expand all the compressed files from the elmage packages into a different
temporary directory.

Windows systems

Extract the first elmage package into a temporary subdirectory that
matches the first elmage package name. Extract subsequent packages
into the subdirectory that matches the first elmage package name, not
the subsequent package name.

For example, by using temporary directory C:\mysklmV27download,

follow these steps:

a. First, extract elmage package 1 into a subdirectory such as
C:\myskIimV27download\CZJF3ML.

b. Next, extract package 2 into the same subdirectory that elmage
package 1 created, which in this example is C:\myskimV27download\
CZJF3ML.

c. Extract subsequent packages into the elmage package 1
subdirectory, which in this example is C:\myskimV27download\
CZJF3ML.

Linux systems
On Linux systems, the compressed files are expanded automatically
into the temporary directory without having to specify package names.

AIX systems
On AIX systems, the compressed files are expanded automatically into

the temporary directory without the addition of package names.
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You must use a GNU tar utility to extract the elmage packages. Run
these steps:

a. Download and install the GNU tar utility from this address:

ftp:/ / ftp.software.ibm.com/aix/ freeSoftware /aixtoolbox /RPMS /|
ppc/tar/tar-1.22-1.aix6.1.ppc.rpm|

b. Extract each package. For example, to extract a first elmage named
CZJD7ML.tar, run this command:

/usr/bin/gtar -xvf CZJD7ML.tar
C. Repeat the command by specifying each of the additional elmages.

3. Locate and run the installation files in the temporary directory into which you
expanded the installation packages. For example, locate:

* Windows systems: Taunchpad.exe
* Other systems: Taunchpad.sh
To upgrade to a fix pack, follow the readme file instructions on the IBM Fix

Central website at |http://www.ibm.com/support/fixcentrall Use the following
steps to access the website:

1. Click Select product.
2. From the Product Group drop-down list, select IBM Security.

3. From the Select from IBM Security drop-down list, select IBM Security Key
Lifecycle Manager.

Overview of the environment
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Planning the installation

Before you install IBM Security Key Lifecycle Manager, understand the
prerequisites and plan your environment accordingly.

Before you install IBM Security Key Lifecycle Manager, consider the following
steps:

Use the worksheet in [“Preinstallation worksheets” on page 31|to assist with your
planning.

Determine the IBM Security Key Lifecycle Manager topology, described in
[“Deployment on Windows, Linux, and AIX systems” on page 1)

Ensure that the system meets hardware requirements. For more information, see
[‘Hardware requirements” on page 7.

Ensure that the operating system is at the correct level, with all the required
patches in place. See [‘Operating system requirements” on page 8| for information
on required operating system versions.

Ensure that kernel settings are correct for those operating systems that requires
updating. See [“DB2 kernel settings” on page 13| for details.

If you intend to use your own previously installed version of DB2, ensure that
the copy of DB2 is at the required software level. See [“Software requirements”|
for information on supported versions of DB2.

Determine whether you want to migrate the configuration from an earlier

version of Encryption Key Manager. For more migration information, see
[“Migration planning” on page 21

Decide what installation mode you want to use to install IBM Security Key

Lifecycle Manager: graphical mode or silent mode. See [“Types of installation” on|

for a description of the installation modes.

Definitions for HOME and other directory variables

You can customize the HOME directory for your specific implementation. Make the
appropriate substitution for the definition of each directory variable.

The following table contains default definitions that are used in this information to
represent the HOME directory level for various product installation paths.

Table 1. HOME and other directory variables

Directory variable

Default definition Description

DB_HOME

The directory that contains the DB2
application for IBM Security Key
Lifecycle Manager.

Windows systems:
drive:\Program
Files\IBM\DB2SKLMV27

AIX and Linux systems:
/opt/IBM/DB2SKLMV27




Table 1. HOME and other directory variables (continued)

Directory variable

Default definition

Description

DB_INSTANCE_HOME

Windows
drive\db2adminID

For example, if the value of
drive is C: and the default DB2
administrator is sk1mdb27,
DB_INSTANCE_HOME is
C:\SKLMDB27.

Linux and AIX®
/home/db2adminID

The directory that contains the DB2
database instance for IBM Security
Key Lifecycle Manager.

WAS_HOME

Windows
drive:\Program
Files\IBM\WebSphere\AppServer

Linux and AIX

path/IBM/WebSphere/AppServer
For example: /opt/IBM/WebSphere/
AppServer

The WebSphere Application Server
home directory.

SKLM_HOME

Windows
WAS_HOME\products\skim

Linux and AIX
WAS_HOME/products/skim

The IBM Security Key Lifecycle
Manager home directory.

SKLM_INSTALL_HOME

The directory that contains the IBM

<WAS_HOME>\products\skim\data

C:\Program
Files\IBM\WebSphere\
AppServer\products\skim\data

Linux and AIX
<WAS_HOME>/products/skim/data

/opt/IBM/WebSphere/AppServer/
products/skim/data

Windows ; Security Key Lifecycle Manager
drive:\Program license and migration files
Files\IBM\SKLMV27 & '
Linux and AIX
path/1BM/SKLMV27
SKLM_DATA . The directory that contains the files
Windows

that are exported from IBM Security
Key Lifecycle Manager such as
backup files, exported certificates,
and device group export files. Also,
you must save the files that you want
to import into IBM Security Key
Lifecycle Manager in this directory.

IM_INSTALL_DIR

Windows
drive:\Program
Files\IBM\Installation
Manager

Linux and UNIX
/opt/ibm/InstallationManager

The directory where IBM Installation
Manager is installed.
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Table 1. HOME and other directory variables (continued)

Directory variable

Default definition

Description

IM_DATA_DIR

Windows

drive:\ProgramData\IBM\
Installation Manager

Linux and UNIX
/var/ibm/InstallationManager

The data directory, which is used to
store information about products that
are installed with Installation
Manager.

Note: ProgramData\ is a hidden
folder, and to see it you must modify
your view preferences in Explorer to
show hidden files and folders.

Hardware and software requirements

Your environment must meet the minimum system requirements to install IBM
Security Key Lifecycle Manager.

The hardware and software requirements that are published are accurate at the

time of publication.

Alternatively, see the detailed system requirements document at

http: / / www-969.ibm.com /software/reports /compatibility / clarity /|

softwareRegsForProduct.html|

—_

Select the product version. For example, 2.7.

2
3. Select the operating system.
4

Click Submit.

Hardware requirements

You must ensure that the system has the required memory, processor speed, and
available disk space to install IBM Security Key Lifecycle Manager.

Table 2. Hardware requirements

Specify IBM Security Key Lifecycle Manager.

System components

Minimum values*

Recommended values**

System memory (RAM)

4 GB

Processor speed

Linux and Windows systems

1.0 GHz single
processor

AIX systems
1.5 GHz (2-way)

8 GB

Linux and Windows systems
3.0 GHz dual
processors

AIX systems
1.5 GHz (4-way)

Disk space free for IBM
Security Key Lifecycle
Manager and
prerequisite products
such as DB2

16 GB

30 GB

Disk space free in /tmp
or C:\temp

4 GB

4GB

DB2 Disk space free in
/home directory or
system drive for DB2

7 GB

7 GB

Disk space free in /var
directory for DB2

1 GB on Linux and UNIX
operating systems

1 GB on Linux and UNIX
operating systems
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Table 2. Hardware requirements (continued)

System components | Minimum values* Recommended values**

All file systems must be writable.

files, your DB2 installation might fail.

directory.

available in that drive/partition.

* Minimum values: These values enable a basic use of IBM Security Key Lifecycle Manager.

** Recommended values: You must use larger values that are appropriate for your
production environment. The most critical requirements are to provide adequate system
memory, and free disk and swap space. Processor speed is less important.

On Linux and UNIX operating systems, you must install your DB2 product in an empty
directory. If the directory that you specify as the installation path contains subdirectories or

On Linux and UNIX operating systems, 4 GB of free space is required in the $HOME
Installing into mapped network drives/mounted partitions is not supported.

If installation locations of more than one system component fall on the same Windows
drive/UNIX partition, the cumulative space to contain all those components must be

Operating system requirements

IBM Security Key Lifecycle Manager is supported on multiple operating systems.
To install IBM Security Key Lifecycle Manager, ensure that your system meets the

operating system requirements.

Table 3. Operating system requirements

Operating system

Use DB2 Advanced
Workgroup Server
Edition Version 11.10

AIX version 7.1 and version 7.2 in 64-bit mode. POWER? processor-based servers are
supported.
* A 64-bit AIX kernel is required.

* Use AIX 7.1 Technology Level 4, Service Pack 6. The minimum XL C/C++ runtime
level requires the xIC.rte 12.1.2.0 files.

v

Windows Server 2012 on x86 64-bit mode for:
* Standard Edition

Windows Server 2012 R2 on x86 64-bit mode for:
¢ Standard Edition

Red Hat Enterprise Linux Version 6.7 on x86 64-bit mode

Red Hat Enterprise Linux Version 7.1 on x86 64-bit mode

Red Hat Enterprise Linux Version 7.1 (System z) on x86 64-bit mode

SuSE Linux Enterprise Server Version 12 (System z) on x86 64-bit mode

SIS TS IS S S

Do not install IBM Security Key Lifecycle Manager on systems with hardened

operating system.
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Ensure that Bash Shell is installed before you install IBM Security Key Lifecycle
Manager on UNIX operating systems.

Before you install IBM Security Key Lifecycle Manager on Red Hat Enterprise
Linux operating system, ensure that the required libraries described in this
technote are installed: [https:/ /www-304.ibm.com /support/|
[docview.wss?uid=swg21459143|

Before you install IBM Security Key Lifecycle Manager on AIX operating system,
ensure that the required libraries described in this technote are installed:
[http:/ /www-01.ibm.com/support/docview.wss?uid=swg21631478|

Access requirements
Install IBM Security Key Lifecycle Manager as an administrator (root user).

You can also install IBM Security Key Lifecycle Manager as a non-root user only on
Linux operating system.

Linux packages

On Linux operating systems, IBM Security Key Lifecycle Manager requires the
compat-1ibstdc++ package, which contains 1ibstdc++.s0.6. It also requires the
Tibaio package, which contains the asynchronous library that is required for DB2
database servers.

* libstdc package
To determine whether you have the package, run this command:
rpm -ga | grep -i "libstdc"

If the package is not installed, locate the rpm file on your original installation
media and install it.

find installation _media -name compat-libstdc++x
rpm -ivh full_path_to_compat-libstdc++_rpm_file

* libaio package
To determine whether you have the package, run this command:
rpm -qa | grep -i "libaio"

If the package is not installed, locate the rpm file on your original installation
media and install it.

find installation_media -name libaio=
rpm -ivh full path_to libaio_rpm file

On Red Hat Enterprise Linux 64-bit systems, DB2 installation requires that two
separate Tibaio packages must be installed before running db2setup. These
packages are both named Tibaio. However, there are two different RPM files to
install: one of which is an i386 RPM file, and the other is an x86_64 RPM file.

To install IBM Security Key Lifecycle Manager on Red Hat Enterprise Linux 6.7,
you must upgrade 32 bit glib library to version 7.3 or above.

1. Configure the system with Red Hat Enterprise Linux 6.7, to get the libraries.

wget -q0- --no-check-certificate https://rhn.linux.ibm.com/pub/bootstrap/bootstrap.sh | /bin/b
2. Upgrade the glib libraries.

yum install glibc-2.12-1.166.e16_7.3.1686
3. Execute IBM Security Key Lifecycle Manager installation.
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Installing required libraries on Red Hat Enterprise Linux systems:

Before you run the installation commands for graphical or silent mode installation,
you must install the required libraries on x86-64-bit Red Hat Enterprise Linux
Version 6.0 and Red Hat Enterprise Linux Version 7.0 systems.

Procedure

1.

Installing and configuring

Mount the Red Hat Enterprise Linux distribution DVD to the system. Insert the
DVD into the DVD drive.

Select open a terminal window as a root.
Execute the commands:

[root@localhost]# mkdir /mnt/cdrom
[root@localhost]# mount -o ro /dev/cdrom /mnt/cdrom

Create the text file server.repo in the /etc/yum.repos.d directory.

Note: To use gedit:
a. execute the command:

[root@localhost]# gedit /etc/yum.repos.d/server.repo
b. Add the following text to the file:

[server]

name=server
baseurl=file:///mnt/cdrom/Workstation
enabled=1

Where baseur] depends on the mounting point and the Red Hat Enterprise
Linux distribution.

In the example, the mounting point is cdrom and the Red Hat Enterprise
Linux distribution is Workstation, but can be sever.

Execute the command:

[root@localhost]# yum clean all

Execute the command to import related public keys:
[root@localhost]# rpm --import /mnt/cdrom/*GPG*
Execute the commands to install the required libraries:

[root@localhost]# yum install gtk2.i686
[root@localhost]# yum install 1libXtst.i686

If you received the missing libstdc++ message above, install the libstdc++
library:

[root@localhost]# yum install compat-Tibstdc++

During the install you might receive prompts similar to the example. Answer
with 'y'.

Example:

Total download size: 15 M

Installed size: 47 M
Is this ok [y/N]: y

Note: The package name extension (.i686) might change in the command
depending on the hardware platform that you use. The table lists valid values
for the package name extension. Red Hat Enterprise Linux 6.0 package names
on different platforms:



Platform 32-bit 64-bit
x86/x86_64 1686 x86_64
ppc/ppcbd ppc ppc64d
$390/s390x s390 $390x

Requirements for Linux on System z operating system
Before you install IBM Security Key Lifecycle Manager on Linux on System z
operating system, ensure that your system meets the requirements.

1.

Check whether the following libraries are present on the system, which are
necessary for DB2 installation.

* libpam.so.0
* libaio.so.1

* libstdc++.s0.5
* libstdc++33
* ksh93

If the system does not contain the necessary libraries, run the following
command.

zypper install <library_name>

You can use the following command to remove a library if any problem with
the libraries.

zypper remove <library_name>

For more information, see DB2 documentation |http:/ /www.ibm.com/support/|

knowledgecenter /en/SSEPGG_11.1.0/com.ibm.db2.luw.gb.server.doc/doc/|

r0008865.html|

Install IBM XL /XL C++ environment.
a. Extract the setup.
b. Run ./install.

c. Run the following command if an error message is displayed about missing
libraries.

zypper install <missing_Tib_name>
After you install the package, create a link between the libraries that are
installed by running the following steps.

In -s /opt/ibm/1ib/* /usr/1ib/ In -s
/opt/ibm/1ib64/* /usr/1ib64/

Set the LD_LIBRARY_PATH by using the following command.

LD_LIBRARY_PATH=/opt/ibm/1ib:/opt/ibm/1ib64:/usr/1ib64;
export LD_LIBRARY_PATH

Before you start the installation process, ensure that the /tmp directory has all
the permissions. To provide the permissions, run the following command.

chmod 777 /tmp

Disabling Security Enhanced Linux

IBM Security Key Lifecycle Manager on Linux operating systems might have
functional problems when the Security Enhanced Linux (SELINUX) setting is
enabled.
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About this task

For example, a problem might occur with the TCP/IP connections on the server
ports. Follow the steps provided in the Linux documentation to disable Security
Enhanced Linux.

Software requirements

IBM Security Key Lifecycle Manager requires middleware programs and other
software for its operations. IBM Security Key Lifecycle Manager installs the
middleware programs such as WebSphere Application Server, Java Runtime
Environment (JRE), and DB2 and are bundled with the IBM Security Key Lifecycle
Manager package.

If you have DB2 already installed on the system, see the details in

WebSphere Application Server requirements
IBM Security Key Lifecycle Manager requires WebSphere Application Server 9.0
and any applicable fix pack or APAR requirements.

IBM Security Key Lifecycle Manager includes and installs WebSphere Application
Server. During installation, IBM Security Key Lifecycle Manager customizes
WebSphere Application Server configuration and profiles to suit its operations. This
customization might cause problems with products that use the same server when
you uninstall IBM Security Key Lifecycle Manager. Therefore, you must consider
the following aspects to avoid the issues:

* Do not install IBM Security Key Lifecycle Manager in a WebSphere Application
Server instance that another product provides.

* Do not install another product in the instance of WebSphere Application Server
that IBM Security Key Lifecycle Manager provides.

Java Runtime Environment (JRE) requirements
IBM Security Key Lifecycle Manager requires Java Runtime Environment. IBM Java
Runtime Environment is included with WebSphere Application Server.

Use of an independently installed development kit for Java", from IBM® or other
vendors, is not supported. For more details, see |http://www.ibm.com/support /|
knowledgecenter /SSEQTP_9.0.0/com.ibm.websphere.base.doc/ae /|
covr_javase8.html|

DB2 requirements

The database stores the data of IBM Security Key Lifecycle Manager. Before you
install IBM Security Key Lifecycle Manager, ensure that the database requirements
are met.

IBM Security Key Lifecycle Manager requires DB2 Advanced Workgroup Server
Edition, Version 11.10 and the future fix packs on the same system on which the
IBM Security Key Lifecycle Manager server runs.

Note:

* You must use IBM Security Key Lifecycle Manager to manage the database. To
avoid data synchronization problems, do not use tools that the database
application might provide.

* For improved performance of DB2 Version 11.10 on AIX systems, ensure that
you install and configure the I/O completion ports (IOCP) package that is
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described in the DB2 documentation (http://www-01.ibm.com/support/
knowledgecenter /SSEPGG_11.1.0/com.ibm.db2.Juw.admin.perf.doc/doc/

t0054518.htm!|).

 If an existing copy of DB2 Advanced Workgroup Server Edition was installed as
the root user at the correct version for the operating system, you can use the
existing DB2 Advanced Workgroup Server Edition. IBM Security Key Lifecycle
Manager installer does not detect the presence of DB2. You must specify the DB2
installation path.

SuSE Linux Enterprise Server Version 12 (System z) systems contain the
Tibstdc++.6.s0 package. But, IBM Security Key Lifecycle Manager requires the
Tibstdc++.5.s0 package for DB2 installation.

For more information about DB2 prerequisites, see DB2 documentation
(http: / /www-01.ibm.com /support/knowledgecenter /SSEPGG_11.1.0/|
fcom.ibm.db2.luw.admin.cmd.doc/doc/r0059710.html).

DB2 kernel settings:

Ensure that kernel settings are correct for the operating system, such as the Linux
operating system, that might require updates.

AIX systems
None required.

Linux systems

For more information about kernel settings, see DB2 documentation
http:/ /www-01.ibm.com/support/knowledgecenter /SSEPGG_11.1.0/|
com.ibm.db2.luw.gb.server.doc/doc/t0008238.htmil

Window systems
None required.

XL C/C++ runtime requirements for Linux on z Systems
IBM Security Key Lifecycle Manager requires XL C/C++ runtime environment
package for Linux on z Systems.

For more information, see |http:/ /www-01.ibm.com /support/|
[docview.wss?uid=swg24041489)

Browser requirements
You must enable the session cookies and Java Script in the browser to establish a
session with IBM Security Key Lifecycle Manager.

Supported browsers are not included with the product installation. You must
deploy a browser on the same system on which IBM Security Key Lifecycle
Manager runs.

Table 4. Supported browsers

Browser Fix pack |AIX Windows Windows Red Hat SuSE Linux
Server 2012 | Server 2012 R2 | Enterprise Enterprise Server
Linux
Microsoft Internet None
Explorer, Version 9.0 \/ \/
Microsoft Internet None
Explorer, Version 10.0 v v
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Table 4. Supported browsers (continued)

Browser Fix pack |AIX Windows Windows Red Hat SuSE Linux
Server 2012 | Server 2012 R2 | Enterprise Enterprise Server
Linux

Microsoft Internet None

Explorer, Version 11.0 \/ \/

Firefox ESR, version |None

bire v v v v v
Firefox ESR, version |None

fire v v v v v
Firefox ESR, version |None

fire v v v v v

Audit files

IBM Security Key Lifecycle Manager has a default directory for audit data. The file
location depends on the value of Audit.handler.file.name property in
SKLM_HOME/config/SKLMConfig.properties file.

The default value is shown in the following example.
Audit.handler.file.name=1ogs/audit/skim_audit.log

User roles
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IBM Security Key Lifecycle Manager provides a super user (kImSecurityOfficer
and kTmGUICLIAccessGroup) role and the means to specify more limited
administrative roles to meet the needs of your organization. By default, the
SKLMAdmin user ID has the kimSecurityOfficer role.

For backup and restore tasks, IBM Security Key Lifecycle Manager also installs the
kTmBackupRestoreGroup to which no user IDs initially belong. Installing IBM
Security Key Lifecycle Manager creates predefined administrator, operator, and
auditor groups to manage LTO tape drives.

The WASAdmin user ID has the authority to create and assign these roles, and to
change the password of any IBM Security Key Lifecycle Manager administrator. To
set administration limits for IBM Security Key Lifecycle Manager, use the WASAdmin
user ID on the WebSphere Integrated Solutions Console to create roles, users, and
groups. Assign roles and users to a group. For example, you might create a group
and assign both users and a role that limits user activities to administer only LTO
tape drives. You must assign a role to a new user before that user attempts to log
in to IBM Security Key Lifecycle Manager.

Before you begin, complete the following tasks:
* Determine the limits on device administration that your organization requires.

For example, you might determine that a specific device group has its own
administration.

* Estimate how many administrative users might be needed over an interval of
time. For ease of use, consider specifying a group and a role to specify their
tasks.

For example, you might specify a group that has a limited range of permissions
to manage only 3592 tape drives.
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Available permissions

Installing IBM Security Key Lifecycle Manager creates the SKLMAdmin user ID,
which has the k1mSecurityOfficer role as the default super user. The installation
process also deploys predefined permissions to the WebSphere Application Server
list of administrative roles.

A permission from IBM Security Key Lifecycle Manager enables an action or the use
of a device group. A role in IBM Security Key Lifecycle Manager is one or more
permissions. However, in the WebSphere Application Server graphical user
interface, the term role includes both IBM Security Key Lifecycle Manager
permissions and roles.

IBM Security Key Lifecycle Manager installation creates the following default

groups.

klmSecurityOfficerGroup
Installation assigns the kimSecurityOfficer role to this group. The
kImSecurityOfficer role replaces the previous k1mApplicationRole role in
the group that was named k1mGroup. kTmSecurityOfficerGroup replaces
k1mGroup.

The kImSecurityOfficer role has:

* Root access to the entire set of permissions and device groups that are
described in [Table 5 on page 16| and [Table 6 on page 16|

* Permission to any role or device group that might be created.

* The suppressmonitor role.

The WebSphere Application Server provides the suppressmonitor role to
hide tasks in the left pane of the WebSphere Integrated Solutions
Console that an IBM Security Key Lifecycle Manager administrator does
not use. Hidden items are associated with the application server,
including WebSphere Application Server administrative tasks in the
Security, Troubleshooting, and Users and Groups folders.

klmBackupRestoreGroup
Back up and restore IBM Security Key Lifecycle Manager.

LTOAdmin
Administer devices in the LTO device family with actions that include
create, view, modify, delete, get (export), back up, and configure.

LTOOperator
Operate devices in the LTO device family with actions that include create,
view, modify, and back up.

LTOAuditor
Audit devices in the LTO device family with actions that include view and
audit.

klmGUICLIAccessGroup
Provides IBM Security Key Lifecycle Manager graphical user interface and
command-line interface access to the users. Every product user must be a
part of this group.

Note: Along with this access to the group, the users must be provided
other accesses to be a functional product user.

A user who has any one of the permissions in [Table 5 on page 16|can view:
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* IBM Security Key Lifecycle Manager global configuration parameters that are
defined in the SKLMConfig.properties file.

* The key server status and last backup date.

Table 5. Permissions for actions

Permission

Enables these actions

Unrelated to
device
groups

Associated
with device
groups

kimCreate

Create but not view, modify, or
delete objects.

v

kimDelete

Delete objects, but not view,
modify, or create objects.

k1mGet

Export a key or certificate for a
client device.

k1mModify

Modify objects, but not view,
create, or delete objects.

kTmView

View objects, but not create,
delete, or modify objects. For
example, you must have this
permission to see the tasks you
want to do on the graphical
user interface.

v
v
v
v

kTmAdminDeviceGroup

Administer. Create a device
group, set default parameters,
view, delete an empty device
group. This permission does
not provide access to devices,
keys, or certificates.

kTmAudit

View audit data by using the
tkimServedDatalist command.

k1mBackup

Create and delete a backup of
IBM Security Key Lifecycle
Manager data.

kImConfigure

Read and change IBM Security
Key Lifecycle Manager
configuration properties, or act
on SSL certificate. Add, view,
update, or delete the keystore.

kTmRestore

Restore a previous backup copy
of IBM Security Key Lifecycle
Manager data.

The kimSecurityOfficer role also has root access to permissions for all device

groups.

Table 6. Device groups

Permission Allows actions on these objects
LTO LTO device family

TS3592 3592 device family

DS5000 DS5000 device family

DS8000 DS8000 device family

BRCD_ENCRYPTOR

BRCD_ENCRYPTOR device group
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Table 6. Device groups (continued)

Permission Allows actions on these objects

ONESECURE ONESECURE device group

ETERNUS_DX ETERNUS_DX device group

XIV XIV device group

IBM_SYSTEM_X_SED IBM_SYSTEM_X_SED device group

GPFS (IBM Spectrum Scale) GPFS device group

GENERIC Objects in the GENERIC device family.

userdevicegroup A user-defined instance such as myLT0 that you manually
create, based on a predefined device family such as LTO.
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Types of installation

You can install IBM Security Key Lifecycle Manager in graphical user interface or
silent mode.

* A graphical user interface-based installation that is driven by a wizard.

* A silent installation that runs unattended, using response files for the
configuration options.

Notes:

* IBM Security Key Lifecycle Manager does not support a console mode
installation.

* Do not install IBM Security Key Lifecycle Manager from a network drive or
mounted drive. For example, do not specify either of these net use statements as
the directory location and attempt installation:

net use z: \\server\share
net use \\server\share

Graphical mode installation

IBM Security Key Lifecycle Manager provides a graphical user interface installation
program. IBM Installation Manager is used to install IBM Security Key Lifecycle
Manager and its components. It presents a series of panels that prompt for the
information that is required for installation.

Run the following steps to install IBM Security Key Lifecycle Manager in graphical
mode.

e Start the installation wizard.

* Complete the installation wizard pages by entering the configuration options.
For details, see [“Installing IBM Security Key Lifecycle Manager in graphical|
fmode” on page 36/

* Verify that IBM Security Key Lifecycle Manager server is operational. For details,
see [“Installation verification” on page 68|

Installation and migration panels

Installing IBM Security Key Lifecycle Manager in graphical mode requires you to
start the installation wizard, navigate through a series of installation panels, and
supply the requisite information.

You might see these panels during installation:
1. Language selection and introduction

2. Installation Manager window with installation packages such as IBM
Installation Manager, IBM DB2, IBM WebSphere Application Server, and IBM
Security Key Lifecycle Manager

3. Software license agreement

4. Installation directory selection for IBM Installation Manager and the other
installation packages.

5. Language selection for package translation
6. Package features selection for installation
7. DB2 configuration options
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8. IBM Security Key Lifecycle Manager configuration options
9. Encryption Key Manager migration selection
10. Installation package preview
11. Installation progress for IBM Security Key Lifecycle Manager
12. Installation summary

Notes:

* When you install IBM Security Key Lifecycle Manager, retain the default path
for Shared Resources Directory. IBM Installation Manager uses this location to
download artifacts and to store information about the installed packages.

* When the installation is complete, a page displays the status of the installation
and the list of packages that are installed. You must select None to instruct the
installer not to create a profile and click Finish.

You might see these panels when migration occurs during installation:
1. Language selection
2. Introduction

Software license agreement

DB2 directory

Migration information

Migration summary

Summary of prerequisites

Installation progress for DB2

Beginning IBM Security Key Lifecycle Manager installation

© ©®NO O RAO®
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Installation directory for IBM Security Key Lifecycle Manager and WebSphere
Application Server

11. WebSphere Application Server information

12. SKLMAdmin password

13. Pre-installation summary

14. Migration progress for IBM Security Key Lifecycle Manager
15. Installation summary

Silent installation

20

A silent installation is a noninteractive installation, which is driven by a response
file that provides installation settings.

No user input is required during a silent installation. This type of installation is
useful in environments where IBM Security Key Lifecycle Manager is to be
installed on multiple identical systems, such as in a data center.

Note: Silent mode installation uses a response file that might contain password
information. For more security, delete the response file immediately after the
installation of IBM Security Key Lifecycle Manager.

IBM Security Key Lifecycle Manager includes sample response files that you can
use as a template for creating your own response file. The sample file must be
modified for the specifics of your environment before it can be used. The sample
response files are in the directory in which your installation package is located. For
more information, see [Sample response files|
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Migration planning

Before you install IBM Security Key Lifecycle Manager at this version, check the
version of the previously installed IBM Security Key Lifecycle Manager on the
system. IBM Security Key Lifecycle Manager supports two methods of migrating
data, such as inline migration and cross-platform migration.

Inline migration
During installation, you can migrate data from IBM Security Key Lifecycle
Manager, Version 2.5, 2.6 and Encryption Key Manager 2.1.

Cross-platform migration
After the IBM Security Key Lifecycle Manager installation, the
cross-platform backup utility is used to migrate data from the following
earlier versions:
* IBM Security Key Lifecycle Manager, Version 2.5 and 2.6
* Encryption Key Manager, Version 2.1

* IBM Tivoli Key Lifecycle Manager, Version 1.0, 2.0, and 2.0.1

For more information, see [Backup and restore operations for earlier|
versions of IBM Security Key Lifecycle Manager and IBM Tivoli Key]|
Lifecycle Manager|

The following table lists the supported migration method for earlier versions of
IBM Security Key Lifecycle Manager, IBM Tivoli Key Lifecycle Manager, and
Encryption Key Manager.

Version

Minimum Required
Level

Inline Migration

Cross-platform
Migration

Encryption Key
Manager, Version 2.1

v

v

IBM Tivoli Key
Lifecycle Manager,
Version 1.0

Fix pack 7

v

IBM Tivoli Key
Lifecycle Manager,
Version 2.0

Fix pack 6

IBM Tivoli Key
Lifecycle Manager,
Version, 2.0.1

Fix pack 5

IBM Security Key
Lifecycle Manager,
Version 2.5

Fix pack 3

IBM Security Key
Lifecycle Manager,
Version 2.6

Fix pack 2

If migration fails from the installer, you can manually run the IBM Security Key
Lifecycle Manager, Version 2.7 migration utility from the SKLM_HOME\migration\bin
directory after you exit the installation.
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* Run migrate.bat or migrate.sh to migrate Encryption Key Manager, Version 2.1
to IBM Security Key Lifecycle Manager. On Linux or AIX systems, ensure that
you are logged in as the root user before you run migrate.sh.

* Run migrateToSKLM.bat or migrateToSKLM.sh in the <SKLM _INSTALL HOME>\
migration directory to migrate IBM Security Key Lifecycle Manager earlier
version to version 2.7. On Linux or AIX systems, ensure that you are logged in
as the root user before you run migrateToSKLM. sh.

Do not run other *.bat utilities that you might see in this directory. The utilities
are for use only by the automatic installation process.

Before migration

Before you begin, ensure that your enterprise allows a time interval for a
temporary halt to key serving activity.

A window of time for testing is also required to ensure that the new IBM Security
Key Lifecycle Manager has the expected keys and other configuration attributes
that you intended to migrate.

Disk space requirements

Before you migrate data from earlier versions to IBM Security Key Lifecycle
Manager, Version 2.7, ensure that there is sufficient disk space on your system.
These disk space requirements are in addition to disk space requirements identified
by the installer for installing IBM Security Key Lifecycle Manager, Version 2.7 and
its prerequisite software.

The additional disk space is required for the migration program to move users,
keys, and other meta data in database from the old system to IBM Security Key
Lifecycle Manager, Version 2.7.

Migration restrictions and requirements for Encryption Key Manager
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You must follow certain rules and guidelines before you can migrate from

Encryption Key Manager to IBM Security Key Lifecycle Manager.

* IBM Security Key Lifecycle Manager supports migration of Encryption Key
Manager, Version 2.1 only.

* Copy the Encryption Key Manager configuration file and all other related files to
a destination system where IBM Security Key Lifecycle Manager, Version 2.7 is
installed.

 Edit the Encryption Key Manager configuration file to change from relative file
path to absolute path for the parameters.

* Migrate only one Encryption Key Manager server to one IBM Security Key
Lifecycle Manager server. To migrate a second Encryption Key Manager, use a
second IBM Security Key Lifecycle Manager server.

* Both the Encryption Key Manager server and the IBM Security Key Lifecycle
Manager server that receives migrated data must be on the same host. After
migration, IBM Security Key Lifecycle Manager server uses the keystore, TCP
port, and SSL port that Encryption Key Manager server previously used.

* You must set the following two properties the migration:
— config.keystore.file
Absolute path of the keystore. For example, C:/EKM21/test.keys.jceks.
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— TransportListener.ss1.keystore.name

SSL keystore name of Encryption Key Manager. For example, C:/
EKM21/test.keys.ssT.

* To migrate key groups, if your Encryption Key Manager was configured with
key groups to work with LTO tape drives, ensure that the
config.keygroup.xml.file property exists in the Encryption Key Manager
properties file and is specified as an absolute path.

This property might not be in the properties file because Encryption Key
Manager might use the file from a default directory from which the Encryption
Key Manager was started.

* The Encryption Key Manager component supports only the English locale.
Therefore, you must do the migration from Encryption Key Manager to IBM
Security Key Lifecycle Manager in the English locale.

Migration for Encryption Key Manager from IBM i systems

You must relocate Encryption Key Manager from a IBM i system to an IBM
Security Key Lifecycle Manager supported operating system before you can
migrate Encryption Key Manager to IBM Security Key Lifecycle Manager.

1. On an IBM i system, the keys must be in a JCEKS keystore. Otherwise, you
must first move the keys to a JCEKS keystore.

2. Move the JCEKS keystore and Encryption Key Manager properties file, which
you must update for the new operating system, from the IBM i system to a
system that IBM Security Key Lifecycle Manager, Version 2.7 supports.

3. Use the keystore and modified properties file that you moved to set up
Encryption Key Manager on the system that IBM Security Key Lifecycle
Manager, Version 2.7 supports.

4. Ensure that Encryption Key Manager is functional on the new system.

5. Migrate from the new Encryption Key Manager to IBM Security Key Lifecycle
Manager, Version 2.7 as part of installing IBM Security Key Lifecycle Manager,
Version 2.7. For the installation steps, see [Installation of IBM Security Key]|
[Lifecycle Manager| You can migrate only Version 2.1 of Encryption Key
Manager.

Note: To obtain Encryption Key Manager, Version 2.1, contact IBM Software
Support at: [http:/ /www.ibm.com /software /support|

Migration restrictions for Encryption Key Manager

You can migrate only version 2.1 of Encryption Key Manager to IBM Security Key
Lifecycle Manager, Version 2.7.

If you are using earlier versions of Encryption Key Manager, upgrade to version
2.1. To obtain Encryption Key Manager, version 2.1, contact IBM Software Support
at: [ttp:/ /www.ibm.com /software /support]

There are certain restrictions on what you can migrate from Encryption Key
Manager.

* Migration of Administrator SSL keystores and truststores is not supported. IBM
Security Key Lifecycle Manager server does not support Administrator sync
capability.

* Migration of PKCS11Impl keystores and truststores is not supported. IBM
Security Key Lifecycle Manager server does not support PKCS11Impl keystores.

Migration planning 23


cpt_insguide_config.dita
cpt_insguide_config.dita
http://www.ibm.com/software/support
http://www.ibm.com/software/support

24

* IBM Security Key Lifecycle Manager does not support the use of a key in

multiple groups, unlike Encryption Key Manager, which supports the use of a
key in multiple groups.

When you migrate key data in KeyGroup.xml from Encryption Key Manager to
IBM Security Key Lifecycle Manager, each key is attached to one group. A key
that was previously in multiple groups in Encryption Key Manager is created in
only one group in IBM Security Key Lifecycle Manager.

The migration process logs the event that the key is not created in multiple
groups, and continues. If the symmetricKeySet property specifies a list or range
or keys, and not a group, all keys that are specified by symmetricKeySet are
migrated into a key group named DefaultMigrateGroup. If the keys from
symmetricKeySet are created as a part of other groups, and the key group named
DefaultMigrateGroup is empty, IBM Security Key Lifecycle Manager does not
create the DefaultMigrateGroup key group, and also does not migrate the
symmetricKeySet property.

To work around the problem, use the IBM Security Key Lifecycle Manager
graphical or command-line interface to define a default key group, for example,
for LTO tape drives.

After migration of Encryption Key Manager

After Encryption Key Manager is migrated, you must validate the configuration
and protect data.

* Do not run Encryption Key Manager. After migration, the Encryption Key

Manager retains its ability to serve keys.
Resolve possible problems with certificates and keys.

Encryption Key Manager does not restrict device groups to which a certificate
and its keys can be associated. Certificates and keys that belong to multiple
device types are marked as CONFLICTED after migration to IBM Security Key
Lifecycle Manager, Version 2.7. You cannot change their device group to another
device group. IBM Security Key Lifecycle Manager can use a certificate or key
that is marked as CONFLICTED for both read and write operations.

Migration might also cause a certificate to appear with an UNKNOWN label in the
IBM Security Key Lifecycle Manager graphical user interface.

— Unknown certificates can be used as rollover certificates. Once scheduled as a
rollover, the unknown certificate is updated to the specific device group of the
rollover. An SSL server certificate with an UNKNOWN label is updated to be an
SSL certificate.

— Pending certificates might be listed on the graphical user interface with a
device group that has an UNKNOWN status. First, accept the pending certificate,
which then has an UNKNOWN status. Next, use the tklmCertUpdate command to
update the certificate usage to a specific device group. The update changes
the certificate status to a state such as active.

— After migration completes, one or more devices might be associated with the
UNKNOWN device group. You can assign the device group for UNKNOWN devices to
a new group, or allow the group to be determined when the devices make a
first key service request.

Use the tkimCertList command to find certificates that are marked as

CONFLICTED or UNKNOWN. Specify no value for the -usage parameter, or specify a

parameter value of 3592, DS8000, or SSLSERVER. For example, this

Jython-formatted command lists all certificates for the 3592 device group:

print AdminTask.tkImCertList('[-usage 3592 -v y]')
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* Verify that the migrated Encryption Key Manager configuration is in the state
that you expect before making any updates or any configuration changes to IBM
Security Key Lifecycle Manager.

The Encryption Key Manager configuration keystore becomes the IBM Security
Key Lifecycle Manager keystore after migration is complete. You cannot migrate
Encryption Key Manager server data a second time to the same IBM Security
Key Lifecycle Manager server.

If migration fails and you choose to complete the remaining IBM Security Key
Lifecycle Manager installation process, there is a stand-alone migration-recovery
script that you can start only if you are not made any updates or changes to the
IBM Security Key Lifecycle Manager configuration. For more information, see
[“Recovery from migration failure” on page 73

Data objects and properties migrated from Encryption Key
Manager

The data objects and properties are also migrated from Encryption Key Manager.

Properties that must be in the Encryption Key Manager configuration file include:
* Audit.metadata.file.name

File must exist in the same directory as the configuration file itself and must be
read enabled.

* config.drivetable.file.url

File must exist in the same directory as the configuration file itself and must be
read enabled.

* config keystore.file

File must exist in the same directory as the configuration file itself and must be
read and write enabled.

* config.keystore.password.obfuscated
* config keystore.type

The keystore type must not be PKCS11IMPLKS.
* TransportListener.ssl.keystore.name

File must exist in the same directory as the configuration file itself and must be
read enabled.

* TransportListener.ssl.keystore.password.obfuscated
* TransportListener.ssl.keystore.type

The keystore type must not be PKCS11IMPLKS.
* TransportListener.ssl.port

The value must be a positive integer between 1 and 65535 and must not be
identical to the value for TransportListener.tcp.port.

* TransportListener.ssl.truststore.type
The truststore type must not be PKCS11IMPLKS.
* TransportListener.tcp.port
The value must be a positive integer between 1 and 65535 and must not be

identical to the value for TransportListener.ssl.port.
Migration includes the following data objects:

Keystores
IBM Security Key Lifecycle Manager stores all keys and certificates in the
database. During migration, the keys and certificates from the two
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Encryption Key manager keystores, Config, and TransportListner are all
copied to the IBM Security Key Lifecycle Manager database. Keys and
certificates are copied from the Config keystore. The certificates are copied
from the TransportlListner truststore.

A certificate from the TransportListener keystore is set as the SSL
certificate for IBM Security Key Lifecycle Manager. The
config.keystore.ssl.certalias property is updated with the alias of this
certificate.

Other Encryption Key Manager keystores are not used.

Devices

All the device information is read from the drive table pointed at by the
config.drivetable.file.url property, and is entered in an IBM Security Key
Lifecycle Manager database. If the drive has the symalias property that is
defined, the drive type is set to LTO. If the drive has aliases that are
defined, the drive type is set to 3592. Migration sets a type of UNKNOWN
for a drive that has none of these properties that are defined and that has
no type that can be determined.

Keygroups

The keygroup.xml file that is pointed at by the config.keygroup.xml.file
property, is parsed, and the keygroup information is stored in an IBM
Security Key Lifecycle Manager database. All the group members and
group relationships are also migrated.

If the symmetricKeySet property has a list of aliases or range of aliases, a
default key group named DefaultMigrationGroup is created with all the
aliases as members of the group. In this case, the symmetricKeySet
property is set to DefaultMigrationGroup. If the symmetricKeySet property
is already a group alias, the default migration group is not created.

Metadata

All the metadata information that is pointed at by the
Audit.metadata.filename property is migrated into an IBM Security Key
Lifecycle Manager database.

The properties that are migrated from the Encryption Key Manager configuration
file to the SKLMConfig.properties file might include:

* Audit.eventQueue.max
* Audit.handler file.size

¢ Audit.event.outcome

* Audit.event.types

* config.keystore.name (set to defaultKeyStore)
* cert.valiDATE

* drive.acceptUnknownDrives is migrated to the database as the default entry in
the specified device group.

* fips

* TransportListener.ssl.ciphersuites

* TransportListener.ssl.clientauthentication

* TransportListener.ssl.port

* TransportListener.ssl.protocols

* TransportListener.ssl.timeout

* TransportListener.tcp.port
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TransportListener.tcp.timeout
useSKIDefaultLabels
zOSCompatibility

These properties are migrated from the Encryption Key Manager configuration file
to the IBM Security Key Lifecycle Manager database:

drive.default.aliasl
drive.default.alias?2

symmetricKeySet (set to an already-specified group alias, otherwise set to
DefaultMigrationGroup)

Migration restrictions and requirements for an older version of IBM
Security Key Lifecycle Manager to version 2.7

Before migrating your old version of IBM Security Key Lifecycle Manager such as
version 2.5 and 2.6 to version 2.7, you must follow certain rules and guidelines.

Ensure that you applied the most current fix pack for IBM Security Key Lifecycle
Manager for the version that you are migrating.

Back up IBM Security Key Lifecycle Manager earlier version 2.5 or 2.6. Also,
back up any replica. If migration fails, restore IBM Security Key Lifecycle
Manager earlier version from a backup copy.

Note: After you successfully migrate IBM Security Key Lifecycle Manager to
version 2.7, earlier version backup files that are created by using the CLI
command, graphical user interface, or REST interface cannot be used to restore
IBM Security Key Lifecycle Manager at version 2.7.

You can use the backup utility of IBM Security Key Lifecycle Manager, Version
2.7 to create the cross-platform compatible backup files for earlier versions.
Then, you can restore these backup files from earlier versions on an IBM
Security Key Lifecycle Manager, Version 2.7 system.

Migration does not remove the previous version of IBM Security Key Lifecycle
Manager. To remove, follow the uninstall instructions for the version of IBM
Security Key Lifecycle Manager you have migrated from.

Note: Since the IP ports are shared between the two versions, do not run both
versions at the same time.

Stop IBM Security Key Lifecycle Manager and any replica server. Key serving
cannot be active during migration.

You cannot use passwords with special characters for the IBM Security Key
Lifecycle Manager database. You can use only alphabetical characters (A-Z and
a-z), numeric characters (0-9), the underscore (_), and hyphen (-). If you
previously modified a password, change the password before migration to use
only the character set that migration allows. After migration, you can reset the
password to use special characters.

During migration, examine the <IM App Data Dir>/1ogs/skimLogs/
migration.log file frequently to determine how far migration is progressed. If
migration fails, run the migration utility to print messages to the migration.log
file and to the command-line interface.

To avoid errors while migration is in progress, do not start or stop the DB2
server or the WebSphere Application Server outside of the migration process. Do
not interrupt the migration process.
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* When you are migrating IBM Security Key Lifecycle Manager version 2.5 or 2.6
to version 2.7 in silent mode, ensure that the correct admin password is specified
in the response file.

* When an earlier version of IBM Security Key Lifecycle Manager system with
LDAP configured is migrated to version 2.7, all the LDAP users from the earlier
version system are not migrated. Only the LDAP user who is used for the IBM
Security Key Lifecycle Manager Administrator role during the installation
process is migrated. You must explicitly add all other LDAP users after the
installation. To add the users, run the addLDAPUserToGroup LDAP configuration
script as described in Step 3 of the [Running the LDAP configuration scripts|
topic.

Migration from unsupported operating systems

Use the cross-platform backup utility to migrate data from IBM Security Key
Lifecycle Manager, IBM Tivoli Key Lifecycle Manager, and Encryption Key
Manager that are running on the operating systems that version 2.7 does not
support.

You can restore the backup files on IBM Security Key Lifecycle Manager, Version
2.7 to an operating system that is different from the one it was backed up from.
For more information, see [Backup and restore operations for earlier versions off
[[BM Security Key Lifecycle Manager and IBM Tivoli Key Lifecycle Manager|

After migrating IBM Security Key Lifecycle Manager
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After IBM Security Key Lifecycle Manager is migrated, you must validate the
configuration and protect the data.

* Immediately after you install IBM Security Key Lifecycle Manager, Version 2.7,
run the backup operation for IBM Security Key Lifecycle Manager, Version 2.7.

Migration to version 2.7 does not remove the earlier version of IBM Security Key
Lifecycle Manager. You must not run two versions simultaneously to avoid port
conflict.

If migration fails and you choose to complete the remaining IBM Security Key
Lifecycle Manager installation process, there is a stand-alone migration-recovery
script that you can start only if you have not made any updates or changes to
the IBM Security Key Lifecycle Manager configuration. For more information,
see [“Recovery from migration failure” on page 73 You must complete the
migration recovery process before you can use IBM Security Key Lifecycle
Manager, Version 2.7.

* Retain a replica of IBM Security Key Lifecycle Manager previous version, but do
not run. Retaining replica of the previous version ensures that you have an
environment and data in case validation determines that there is a problem with
version 2.7.

* Resolve possible problems with certificates and keys.

IBM Security Key Lifecycle Manager earlier version 2.5 or 2.6 does not restrict
device groups to which a certificate and its keys can be associated. Certificates
and keys that belong to multiple device types at version 2.5 or 2.6 are marked as
CONFLICTED at version 2.7. You cannot change their device group to another
device group. IBM Security Key Lifecycle Manager can use a certificate or key
that is marked as CONFLICTED for both read and write operations.
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+ After migration completes, one or more devices might be associated with the

UNKNOWN device group. You can assign the device group for UNKNOWN devices to a
new group, or allow the group to be determined when the devices make a first
key service request.

After you complete migration of IBM Security Key Lifecycle Manager earlier
version to version 2.7, the migration program will not remove the previous
version. To remove, follow the uninstall instructions for the version of the
product you have migrated from.

Note: Because the IP ports are shared between the two versions, do not run
both versions at the same time. If migration cannot complete these steps,
migration process issues a warning and a successful completion message.
Examine the <IM App Data Dir>/logs/skimLogs/migration.log file for messages
and take the appropriate manual actions.

For future administrative use in IBM Security Key Lifecycle Manager previous
version, you might have marked a certificate for use as a 3592 rollover or a key
group as an LTO rollover. If the scheduled future date for rollover is earlier than
the time of migration, the migration program adds an appropriate message and
does not migrate these rollover entries. After successfully installing IBM Security
Key Lifecycle Manager, Version 2.7, use the command-line interface or graphical
user interface to manually add these rollover entries.

You cannot use the graphical user interface to delete a migrated rollover that
you added with the command-line interface by using the
tkimCertDefaultRolloverAdd or the tk1mKeyGroupDefaultRolloverAdd command.
Use the command-line interface to delete a migrated rollover that you created by
using the command-line interface.

After you ensure that the primary IBM Security Key Lifecycle Manager at
version 2.7 is configured and running correctly, back up the version 2.7 IBM
Security Key Lifecycle Manager server and install the backup on a replica
computer.

— Validate that the version 2.7 replica computer is configured and running
correctly.

— Retain a copy of version 2.7 backup files in a location that is not in the IBM
Security Key Lifecycle Manager, Version 2.7 directory path. The separate
location ensures that other processes cannot remove backup files if IBM
Security Key Lifecycle Manager is removed.

Additionally, retain the <IM App Data Dir>/1ogs/skimLogs/migration.log files
for future reference.

Data objects and properties migrated from IBM Security Key Lifecycle

Manager

The data objects and properties are also migrated from IBM Security Key Lifecycle
Manager earlier versions 2.5 and 2.6.

Keystore

The keystore, including all certificates and metadata from earlier versions,
are added to the IBM Security Key Lifecycle Manager, Version 2.7 database.
The keystore is identified by the config.keystore.name property in the
SKLMConfig.properties file.

Devices

All the device information is read from the IBM Security Key Lifecycle
Manager database.
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Keygroups
The key group information is read from the IBM Security Key Lifecycle
Manager database.

Rollover certificates and keygroups
Certificates and keygroups from the earlier versions might be marked for
future 3592 tape drive administration. The migration program detects and
marks these rollovers for future administration with IBM Security Key
Lifecycle Manager, Version 2.7.

Metadata
All the metadata information is migrated from earlier version database and
made usable by the IBM Security Key Lifecycle Manager, Version 2.7
database.

Properties
Properties in the SKLMConfig.properties file are migrated from the IBM
Security Key Lifecycle Manager database. The datastore.properties file is
migrated.

These properties are replaced in the version 2.7 SKLMConfig.properties
file:
* ds8k.acceptUnknownDrives
The device.AutoPendingAutoDiscovery property replaces this property.
* drive.acceptUnknownDrives
The device.AutoPendingAutoDiscovery attribute in the IBM Security Key
Lifecycle Manager database replaces this property.
These IBM Security Key Lifecycle Manager, version 2.0.1 properties are
obsolete and are not migrated:
* tkim.internal.gui.jagworkflow
e tkim.internal.gui.ltodworkflow
These properties are migrated from the version 2.7 SKLMConfig.properties
file to the IBM Security Key Lifecycle Manager database:
* drive.default.aliasl
* drive.default.alias2

+ symmetricKeySet (removed from the SKLMConfig.properties file and
replaced with an entry for the device group in the IBM Security Key
Lifecycle Manager database)
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Preinstallation worksheets

Before you install and configure IBM Security Key Lifecycle Manager, you can
complete the preinstallation worksheets to define the configuration parameters that
are required to complete the IBM Security Key Lifecycle Manager installation.

The preinstallation worksheets list all of the values that you must specify during
an IBM Security Key Lifecycle Manager installation process. Completing the
preinstallation worksheets before you install the components can help you plan
your installation, save time, and enforce consistency during the installation and
configuration process.

General installation parameters

Use the worksheet to record general installation parameters.

Table 7. General installation parameters

Default or example
Option Description value Your value
Installation Mode in which to |gui (default)
mode run the installation |silent
program.
Important Step: |Ensure that you See |”Hardwar5|
have enough free |[requirements” on page 7|
Check the disk space for values.
available free available.
disk space.
Installation Directory in which Windows
Directory - IBM | to install IBM ,
Installation Installation d’? tve:\Program
Manager Manager. FiTes\IBM\
Installation
Manager\
eclipse
AIX and Linux
/opt/ibm/
InstallationManager/
eclipse
Installation Directory in which Windows
Directory - IBM | to install IBM DB2. ,
DB2 drive:\Program
Files\IBM\
DB2SKLMV27
AIX and Linux
/opt/ibm/
DB2SKLMV27
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Table 7. General installation parameters (continued)

Default or example
Option Description value Your value
Installation Directory in which .
. . Windows
Directory - IBM | to install drive:\p
WebSphere WebSphere rive:\rrogram
Application Application Server. Files\IBM\
S WebSphere\
erver
AppServer
AIX and Linux
/opt/IBM/
WebSphere/
AppServer
Installation Directory in which Wind
Directory - IBM | to install IBM Indows .
S . . drive:\Program
ecurity Key Security Key .
: . Files\IBM\
Lifecycle Lifecycle Manager.
SKLMv27
Manager
AIX and Linux
/opt/ibm/
SKLMv27

DB2 configuration parameters

Use the worksheet to record your entries that are related to the installation and
configuration of DB2.

Table 8. DB2 configuration parameters
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Field name

Description

Default or example
value

Your value

Installation
Directory - DB2

Directory in which
to install DB2.

Windows
drive:\Program
Files\IBM\
DB2SKLMV27

AIX and Linux
/opt/1BM/
DB2SKLMV27

Install DB2 or
Use an existing
installation of
DB2

Specify whether to
use an existing
DB2 instance or a
new DB2
installation.

If an existing DB2
instance is used, you
must specify the DB2
installation location and
the other details.

DB2
Administrator ID

User ID for the
IBM Security Key
Lifecycle Manager
database
administrator (also
called the instance
owner).

skimdb27

DB2 Password for the
Administrator database
Password administrator user

ID.
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Table 8. DB2 configuration parameters (continued)

Default or example

instance and
formatted tables
are created.

Linux and AIX

/home/sk1mdb27

Field name Description value Your value
Database Name |Name of the IBM | SKLMDB27
Security Key
Lifecycle Manager
database.
DB2 Port DB2 service 50030
listening port.
Administrator / | Directory where Wind
Database Home |the database m ows(;:.

Administrator
group

Operating system
user group in
which the instance
owner of the
database is a
member on Linux
or AIX systems.

If DB2 is on AIX or
Linux, your user ID

must be in the bin or

root group, or in a

separate group in which

root is a member.

WebSphere Application Server and IBM Security Key Lifecycle
Manager server configuration parameters

Use the configuration worksheet to record your entries for installation and
configuration of the application server, which is used to host your IBM Security
Key Lifecycle Manager server.

Table 9. WebSphere Application Server configuration parameters

Field name

Description

Default or example
value

Your value

User Name

Specifies the
WebSphere
Application Server
login user ID for
the IBM Security
Key Lifecycle
Manager
Administrator
profile.

wasadmin

Password

Specifies the
WebSphere
Application Server
password for the
IBM Security Key
Lifecycle Manager
profile.

Preinstallation worksheets
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Table 9. WebSphere Application Server configuration parameters (continued)

Field name

Description

Default or example
value

Your value

HTTPS Admin
Port

Specifies the
WebSphere
Application Server
port for the IBM
Security Key
Lifecycle Manager
profile.

9083

Table 10. IBM Security Key Lifecycle Manager configuration parameters

Field name

Description

Default or example
value

Your value

User Name

Specifies the user
ID to administer
IBM Security Key
Lifecycle Manager.

SKLMAdmin

Password

Specifies the
password for the
IBM Security Key
Lifecycle Manager
administrator.

HTTPS Port
Number

Specifies the secure
port to access IBM
Security Key

Lifecycle Manager.

443

HTTP Port
Number

Specifies the
non-secure port to
access IBM
Security Key
Lifecycle Manager.

80
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Installation of IBM Security Key Lifecycle Manager

The IBM Security Key Lifecycle Manager installer can run in two modes, such as
graphical mode and silent mode. Select a mode that suits your requirements when
you install IBM Security Key Lifecycle Manager.

Installation guidelines

For a successful installation, ensure that you understand and follow the rules and
guidelines to install IBM Security Key Lifecycle Manager.

Installation can take more than an hour.
Do not install from a network drive or mounted drive.

Ensure that you select the correct language at prompts during installation.
Correcting a locale error requires uninstalling and reinstalling IBM Security Key
Lifecycle Manager and DB2.

When you install IBM Security Key Lifecycle Manager, the DB2 password that
you specify must comply with the password policy of the underlying operating
system.

If you are using an existing user as DB2 Administrator, ensure that the password
is correctly specified.

When you install IBM Security Key Lifecycle Manager on Linux, certain DB2
configuration changes made during installation might require that you restart
the system. Close any other applications before you restart the system. After the
system restarts, run the installation program again.

Ensure that the host name of the system is set correctly.

Entries for all fields are restricted to alphabetical characters (A-Z and a-z),
numeric characters (0-9), and the underscore character (_). The restriction also
applies to the values in the response file that is used for silent installations.

Ensure that the installation path does not contain Unicode characters.
Ensure that there are no non-ASCII characters in the installation path.

When you install IBM Security Key Lifecycle Manager, retain the default path
for Shared Resources Directory. IBM Installation Manager uses this location to
download artifacts and to store information about the installed packages.

Do not install IBM Security Key Lifecycle Manager on systems with hardened
operating system.

In a hardened system, you might have restricted access to the specific
directories, or you might not be a part of the administrator group. On Windows,
you might not have access to certain directories in the system even if you are
part of the administrator group. To install IBM Security Key Lifecycle Manager,
you must have access to all the installation directories with Read, Write, and
Execute permissions.

Ensure that Bash Shell is installed before you install IBM Security Key Lifecycle
Manager on UNIX operating systems.

If you have IBM Security Key Lifecycle Manager earlier version in your
environment, consider the following guidelines before you install and migrate to
version 2.7:

— Obtain the administrative passwords for your earlier version of IBM Security
Key Lifecycle Manager.
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— Apply the most current fix pack to your earlier version of IBM Security Key
Lifecycle Manager.

— On Windows systems, ensure that the IBM ADE Service is started.

On Windows systems, open the Services console. Verify that the IBM ADE
Service is started. If the service is not started, select and start the service.

Installing IBM Security Key Lifecycle Manager in graphical mode
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Use the IBM Installation Manager installation wizard to install IBM Security Key
Lifecycle Manager and its components in a graphical user interface mode.

Before you begin

* Download and extract the files for IBM Security Key Lifecycle Manager to a
directory. These files are available for download from the IBM Passport
Advantage website. See the [Installation images and fix packs| topic for details.

* Review the [Installation guidelines| topic to know the considerations and
restrictions for installing and configuring IBM Security Key Lifecycle Manager.

* Review the [Planning the installation| topic to understand the requirements.

About this task

When you start the installation process from the Launchpad program, IBM
Installation Manager is automatically installed if it is not already on your system.
When the installation task is complete, IBM Security Key Lifecycle Manager is
installed along with the installation of required middleware components, such as
WebSphere Application Server and DB2 on the same system.

Procedure
1. Go to the directory of your installation package and open diskl. For example:
download path/diskl
2. Start the Launchpad program.
Operating system Command to run
Windows launchpad. exe
Linux or AIX launchpad.sh

3. Select a language in which to run the Launchpad and Installation Manager.
4. Click the Install IBM Security Key Lifecycle Manager link. The Install
Packages window is displayed.

5. Click each of the product packages to highlight them. The description of the
package is displayed in the Details section at the bottom of the window. If
more information about the package is available, a More info link is included.
To fully understand the package that you are installing, review all
information.

6. Select the product packages to install. All the packages are selected for
installation by default.

7. Click Next. The prerequisite checks verify the prerequisite requirements for
the installation.

8. Select I accept the terms in the license agreements and click Next.

9. Select a location for the shared resources directory and click Next.

Installing and configuring



Note: Retain the default path for shared resources directory, for example,
C:\Program Files\IBM\IBMIMShared. IBM Installation Manager uses this
location to download artifacts and to store information about the installed
packages.

10. On the Location page, the location of the package group into which each
product is installed is displayed. Click each product to see its package group
location. Click Next.

11. On the next page, select the translation packages to install and click Next.
12. On the Features page, select the package features to install.

a. To see the dependency relationships between features, select Show
dependencies.

b. Click a feature to view its brief description under Details.
c. When you are finished selecting features, click Next.

13. On the Configuration for IBM DB2 page, specify the database configuration
information and click Next.

For more details about DB2 configuration, see [DB2 configuration parameters|
and [DB2 configuration during installation}

14. On the Configuration for IBM Security Key Lifecycle Manager page, specify
the configuration information for IBM Security Key Lifecycle Manager and
WebSphere Application Server. Then, click Next.

For more configuration details, see [WebSphere Application Server and IBM|
Security Key Lifecycle Manager server configuration parameters|and
Configuration during installation}

15. On the next page, to migrate an existing Encryption Key Manager
configuration, select Migrate Encryption Key Manager, and specify the
property file location. Then, click Next.

For more information and guidelines about Encryption Key Manager
configuration, see [Migrating Encryption Key Manager configuration|

16. On the Summary page, review your choices before you install the product
package. To change a selection, click Back to return to your selections.

17. To begin the installation, click Install.

A progress indicator shows the percentage of the installation that is
completed. When the installation process is complete, a message confirms the
completion of the process.

18. Click View Log File to open the installation log file and to verify that all of
the components were installed properly.

19. In the Install Package wizard, select None to instruct the installer not to create
a profile.

20. Click Finish to complete the installation task and to close the wizard.
What to do next

Before you use IBM Security Key Lifecycle Manager, run the postinstallation tasks
that are described in [Postinstallation steps|

Installing IBM Security Key Lifecycle Manager in silent mode

You can install IBM Security Key Lifecycle Manager in silent installation mode.
This installation method is useful if you want identical installation configurations
on multiple workstations. Silent installation requires a response file that defines the
installation configuration.
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Before you begin

* Download and extract the files for IBM Security Key Lifecycle Manager to a
directory. These files are available for download from the IBM Passport
Advantage website. See the [Installation images and fix packs| topic for details.

* Review the [Installation guidelines| topic to know the considerations and
restrictions for installing and configuring IBM Security Key Lifecycle Manager.

+ Review the [Planning the installation| topic to understand the requirements.

* IBM Security Key Lifecycle Manager includes sample response files that you can
use as a template for creating your own response file. The sample response files
are in the directory in which your installation package is located. Modify the
sample file for the specifics of your environment before it can be used.

About this task

Before installation, you must also read and agree to the license terms for this
product. To locate the response files and license term files, look in the root
directory of the installation image files. The/11icense subdirectory has the license
files in text format.

Installation fails unless you take these steps.

In the response file, make following changes to the line that specifies the license:

* Set the default value to true to indicate that you agree with the terms of the
license.

* Uncomment the line by removing the pound sign (#) character at the beginning
of the line.

Procedure

1. Edit the repository location information and other details in the response file.
The sample response files are in the directory in which your installation
package is located.

Note: If you enter an invalid value for the full_path_to_response_file
parameter, such as an incomplete path, the installation program exits. No error
message is displayed or logged.
You must update the response file with the correct repository location. The
repository location is the place where your installation package is located.
<repository location='<user repository location>\im'/>
<repository location='<user repository location>\'/>
If you have extracted the installation package in C:\sk1m27, update repository
location in the SKLM_install_Win_Resp.xml response file as shown in the
following example.
<repository Tocation='<C:\skim27\disk1\im'>\im'/>
<repository Tocation='<C:\skIim27\disk1\'/>

2. To add the encrypted passwords to the relevant elements of the response file,
use the IBM Installation Manager utility to create encrypted passwords.

For information about how to encrypt the password, see [Encrypted password|
[for response file elements|

3. Open a command prompt and run the silent installation command.

Windows
Go to the <installation package directory>\diskl directory and run
the following command.
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Linux

silent_install.bat SKLM_Silent_Linux_Resp.xml

Go to the <installation package directory>/diskl directory and run
the following command.

silent_install.sh SKLM_Silent_Win_Resp.xml

4. Verify that the installation was successful by reviewing the log files. You can
view the Installation Manager logs at the following locations.

Windows

Linux

drive:\<IM App Data Dir>\logs\native. For example,
C:\ProgramData\IBM\Installation Manager\logs\native.

drive:\<IM App Data Dir>\Togs\skIimLogs\. For example,
C:\ProgramData\IBM\Installation Manager\logs\skimLogs\.

/<IM App Data Dir>/logs/native. For example, /var/ibm/
installationmanager/logs/native.

/<IM App Data Dir>/1ogs/skimLogs/. For example,
/var/ibm/InstallationManager/logs/skimLogs/.

What to do next

Before you use IBM Security Key Lifecycle Manager, run the postinstallation tasks
that are described in [Postinstallation steps}

Encrypted password for response file elements

You must add the encrypted passwords to the relevant elements of the response
file. Use the IBM Installation Manager utility to create an encrypted password.

You must add the encrypted passwords to the relevant elements of the response
file. Use the IBM Installation Manager utility to create an encrypted password.

Windows

For example, if you extract the IBM Security Key Lifecycle Manager
product image to the C:\SKLM\disk1 directory, run the following command
to create an encrypted password.

cd C:\SKLM\diskl\im\tools
imcl.exe encryptString password

Add the encrypted password that you created in the response file as
shown in the following example.

<data key='user.DB2_ADMIN_PWD,com.ibm.db2.0fng"

value='<encrypted password>"'/>

<data key='user.CONFIRM_PASSWORD,com.ibm.db2.0fng'
value='<encrypted password>"'/>

<data key='user.WAS_ADMIN_PASSWORD,com.ibm.sklm.win32'
value='<encrypted password>"'/>
<data key='user.WAS_ADMIN_CONF_PWD,com.ibm.sklm.win32'
value='<encrypted password>'/>

<data key='user.SKLM_ADMIN_PASSWORD,com.ibm.sklm.win32'
value='<encrypted password>'/>
<data key='user.SKLM_ADMIN_CONF_PWD,com.ibm.sklm.win32'
value='<encrypted password>"'/>

Linux For example, if you extract the IBM Security Key Lifecycle Manager
product image to the /SKLM/diskl directory, run the following command to
create an encrypted password.
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cd /SKLM/diskl/im/tools
./imc1 encryptString password

Add the encrypted password that you created in the response file as
shown in the following example.

<data key='user.DB2_ADMIN_PWD,com.ibm.db2.aix.ofng'
value='<encrypted password>'/>

<data key='user.CONFIRM_PASSWORD,com.ibm.db2.aix.ofng"
value='<encrypted password>"'/>

<data key='user.WAS_ADMIN_PASSWORD,com.ibm.skim.aix"
value='<encrypted password>'/>
<data key='user.WAS_ADMIN_CONF_PWD,com.ibm.skim.aix"
value='<encrypted password>'/>

<data key='user.SKLM_ADMIN_PASSWORD,com.ibm.skIm.aix'
value='<encrypted password>'/>
<data key='user.SKLM_ADMIN_CONF_PWD,com.ibm.skim.aix'
value='<encrypted password>'/>

You can create a different encrypted password for each user.

DB2 configuration during installation
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IBM Security Key Lifecycle Manager requires DB2 Advanced Workgroup Server
Edition at a version 11.1 level.

The installation program runs one of the following actions:

* If an existing copy of DB2 Advanced Workgroup Server Edition is installed as
the root user at the correct version for the operating system, you can use the
existing DB2 Advanced Workgroup Server Edition. IBM Security Key Lifecycle
Manager installer does not detect the presence of DB2. You must specify the DB2
installation path.

You can also install a new copy of DB2 Advanced Workgroup Server Edition. An
existing DB2 must be locally installed on the system and not on a network or
shared drive.

On a Windows system, if a new copy of DB2 is installed, the DB2_COPY_NAME is
set to DBSKLMV27.

* If IBM Security Key Lifecycle Manager earlier version and an earlier version of
DB2 exist on the system, the process installs DB2 Advanced Workgroup Server
Edition at a version 11.1 level that depends on the operating system. You can
also use another existing, installed version of DB2 11.1 that is at the correct level.

The process also migrates data from the previous version of IBM Security Key

Lifecycle Manager to the new version. For example:

— The new copy of DB2 Advanced Workgroup Server Edition uses the previous
db2admin user ID and password.

— On a Windows system, if a new copy of DB2 is installed, the DB2_COPY_NAME is
set to DBSKLMV27.

* If no IBM Security Key Lifecycle Manager exists on the system and there is
either no copy or an earlier version of DB2, the installation process installs at a
version 11.1 level that depends on the operating system.

No DB2 upgrade occurs.
During DB2 configuration, you are prompted for the following information, which
might differ from this list, depending on the operating system and on whether IBM
Security Key Lifecycle Manager is installing DB2 or by using an existing copy:
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DB2 Selection

The directory for the DB2 installation.

On Linux or AIX systems, the entry must start from the root directory. The
first character in the entry must be a forward slash ('/").

The installation process provides a default value. See [“Definitions for|
[HOME and other directory variables” on page 5

DB2 Administrator ID

The local DB2 administrator user ID. The installation process provides a
default Administrator user ID with the necessary permissions. Do not use a
domain user ID as the DB2 administrator. Do not specify a user ID greater
than eight characters in length.

Note: Do not use a hyphen (-) or underscore character (_) when you
specify a user ID for an existing copy of DB2.

On a Windows system, the DB2 Administrator user ID must be a member
of the Administrator group. The user ID is subject to the security policy
active on the Windows system.

On a Linux or AIX system, the user ID of the IBM Security Key Lifecycle
Manager DB2 instance owner must be a member of a group in which the
root user ID is also a member. If it is available, use bin as the group. If bin
is not available, ask the system administrator for the name of a
general-purpose group to use.

Note: The Administrator ID cannot be a DB2 reserved word, such as db2,
users, admins, guests, pubTlic, private, properties, local, or root.

DB2 Administrator Password

The password for the administrator. The maximum length is 20 characters.

The password for the DB2 Administrator user ID is subject to the security
policy active on the system. In addition, the login password for the DB2
Administrator user ID and the DB2 password for the user ID must be the
same. When you change one, you must change the other.

Note: If you are using an existing user as DB2 Administrator, ensure that
the password is correctly specified during installation.

Database Name

Name of the IBM Security Key Lifecycle Manager database, SKLMDB27.

DB2 Port

The port that DB2 uses.

Administrator's Group

Access group in which the Administrator user ID exists. If DB2 is on AIX
or Linux, your user ID must be in the bin or root group, or in a separate
group in which root is a member.

Administrator / Database Home

Notes:

The directory (AIX or Linux systems) or drive (Windows systems) in which
the database instance and the formatted tables that are used by IBM
Security Key Lifecycle Manager are created.
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* Entries for all fields are restricted to alphabetical characters (A-Z and a-z),
numeric characters (0-9), and the underscore character (_). The restriction also
applies to the values in the response file that is used for silent installations.

* Do not specify spaces in any of the directory paths or file names.

* The name of the computer on which you install DB2 cannot start with "ibm,"
"sql," or "sys," in lowercase or uppercase. The name of the computer also cannot
contain the underscore character (_).

* If you are using an existing user as DB2 Administrator, ensure that the password
is correctly specified during installation.

DB2 password security issues on Windows systems

On Windows systems, the DB2 Administrator user ID and password are subject to
the security policy that is active on the system.

If there is a password expiration restriction in effect, you must change the login
password and DB2 password for the Administrator user ID before the expiration
period expires.

In addition, the login password for the DB2 Administrator user ID and the DB2
data source password that is used by WebSphere Application Server must be the
same. When you change one, you must change the other.

Run the following steps to change the DB2 database password:

1. Stop the WebSphere Application Server and all Windows services that are
related to DB2.

2. Open the Windows user management tool by opening the Control Panel and
clicking Administrative tools > Computer Management > Local Users and
Groups > Users.

3. Change the password for the IBM Security Key Lifecycle Manager database
owner.

4. Open the Windows Services console by opening the Control Panel and clicking
Administrative Tools > Computer Management.

5. On the following services, change the password by using the Logon tab of the
Properties dialog box:

* DB2 - DBSKLMV?27 - sklminstance
For example, the value of skiminstance might be:

DB2 - DBSKLMV27 - DBSKLM27
DB2 - DBSKLMV27 - SKLMDB27

For example, with the default instance name, the value of sklminstance is:
DB2 - DBSKLMV27 - SKLMDB27

* DB2 Governor (DBSKLMV27)

* DB Remote Command Server (DBSKLMV27)

* DB2DAS - DB2DAS00

When the passwords are changed for all the services, restart the services.

The following services must be stopped and restarted. Password change is not
required:

* DB2 License Server (DBSKLMV27)
* DB2 Management Service (DBSKLMV27)
6. Start the WebSphere Application Server.
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7. Using the wsadmin interface that the WebSphere Application Server provides,
specify the Jython syntax.

Windows

wsadmin.bat -username WASAdmin -password mypwd -lang jython

Linux

./wsadmin.sh -username WASAdmin -password mypwd -lang jython

8. Use the wsadmin command to change the password of the WebSphere
Application Server data source:

a.

f.

The following command lists JAASAuthData entries:
wsadmin>print AdminConfig.list('JAASAuthData')

The result might be:
(cells/SKLMCel1|security.xml#JAASAuthData_1379859888963)

Identify the data source ID with the alias that matches the string sk1m_db.

Also, identify the data source ID with the alias that matches the string
sk1mdb:

print AdminConfig.showAttribute('JAASAuthData_Tlist_entry', 'alias')
For example, type on one line:

print AdminConfig.showAttribute
(' (cells/SKLMCel1|security.xml#JAASAuthData 1379859888963)', 'alias')

The result is:

sklm_db

Change the password of the skim_db alias, entering this command on one
line:

print AdminConfig.modify('JAASAuthData list _entry',
'[[password newpassword]]"

If you specify special characters in the password, use quotation marks as
delimiters when you specify the password value.

For example, type on one line:

print AdminConfig.modify
(" (cells/SKLMCel1|security.xml#JAASAuthData_1379859888963) ',
'[[password tucs@naz]]"')

Save the changes:
print AdminConfig.save()

Stop and restart the IBM Security Key Lifecycle Manager server by using

the stopServer and startServer commands.

Alternatively, stop and restart the IBM Security Key Lifecycle Manager

server by using Windows Computer Management.

1) Open the Control Panel and click Administrative Tools > Computer
Management > Services and Applications > Services.

2) Stop and start the IBM Security Key Lifecycle Manager server service,
which has a name like IBM WebSphere Application Server V9.0 -
SKLM27Server.

Verify that you can connect to the database by using the WebSphere
Application Server data source.

1) First, type:
print AdminConfig.list('DataSource')
The result might be:

"Default Datasource(cells/SKLMCell/nodes/SKLMNode/servers/serverl|
resources.xml#DataSource 1183122153625)"
"SKLM DataSource(cells/SKLMCel1/nodes/SKLMNode/servers/serverl |
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resources.xml#DataSource_1379859893896) "

"SKLM scheduler XA Datasource(cells/SKLMCell/nodes/SKLMNode/servers/
serverl|resources.xml#DataSource 1379859896273)"
DefaultEJBTimerDataSource(cells/SKLMCel1/nodes/SKLMNode/servers/
serverl|resources.xml#DataSource 1000001

2) Test the connection on the first data source. For example, type:
print AdminControl.testConnection('SKLM DataSource(cells....)")
For example, type on one line:

print AdminControl.testConnection
(" (SKLM DataSource(cells/SKLMCel1/nodes/SKLMNode/servers/serverl|
resources.xml#DataSource_1379859893896) ')

3) Test the connection on the remaining data source. For example, type:

print AdminControl.testConnection
(' (SKLM scheduler XA Datasource(cells/SKLMCell/nodes/SKLMNode/
servers/serverl | resources.xml#DataSource_1379859896273) ')

4) In both cases, you receive a message that the connection to the data
source was successful. For example:

WASX72171: Connection to provided datasource was successful.
Now you can run an IBM Security Key Lifecycle Manager operation.

DB2 password security issues on Linux or AIX systems

On Linux or AIX systems, you might want to change the password for the DB2
Administrator user ID. The login password for the DB2 Administrator user ID and
the DB2 password for the user ID must be the same.

The IBM Security Key Lifecycle Manager installation program installs DB2 and
prompts the installing person for a password for the user named skimdb27.
Additionally, the DB2 application creates an operating system user entry named
skimdb27. For example, the password for this user might expire, requiring you to
resynchronize the password for both user IDs.

Before you can change the password of the DB2 Administrator user ID, you must
change the password for the user at the operating system level.

1. Log on to IBM Security Key Lifecycle Manager server as root.
2. Change user to the skimdb27 system user entry. Type:
su skimdb27
3. Change the password. Type:
passwd
Specify the new password.
4. Exit back to root.
exit
5. In the WAS_HOME/bin directory, use the wsadmin interface that the WebSphere
Application Server provides to specify the Jython syntax.

./wsadmin.sh -username WASAdmin
-password mypwd -Tang jython

6. Change the password for the WebSphere Application Server data source:
a. The following command lists the JAASAuthData entries:
wsadmin>print AdminConfig.list('JAASAuthData')
The result might like this example:

(cells/SKLMCel1|security.xml#JAASAuthData_1228871756187)
(cel1s/SKLMCel1|security.xml#JAASAuthData_1228871757843)
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b. Type the AdminConfig.showall command for each entry to locate the alias
skim_db. For example, type on one line:

print AdminConfig.showall
(' (cells/SKLMCel1|security.xml#JAASAuthData_1228871756187) ")

The result is like this example:

{alias skim_db}

{description "SKLM database user j2c authentication alias"}
{password #¥¥xx}

{userId skimdb27}

And also type on one line:

print AdminConfig.showall
(' (cells/SKLMCel1|security.xml#JAASAuthData 1228871757843)")

The result is like this example:

{alias sklmdb}

{description "SKLM database user J2C authentication alias"}
{password xxxxx}

{userId skimdb27}

c. Change the password for the sklm_db alias that has the identifier
JAASAuthData_1228871756187:

print AdminConfig.modify('JAASAuthData list _entry', '[[password
passwOrdc]]!

For example, type on one line:

print AdminConfig.modify
(" (cells/SKLMCel1|security.xml#JAASAuthData_1228871756187) ',
'[[password tucs@naz]]"')

d. Change the password for the sklmdb alias that has the identifier
JAASAuthData_1228871757843:

print AdminConfig.modify('JAASAuthData list_entry', '[[password
passwlrdc]]"

For example, type on one line:

print AdminConfig.modify
(' (cells/SKLMCell|security.xml#JAASAuthData_1228871757843) ',
'[[password tucsOnaz]]"')

e. Save the changes:
print AdminConfig.save()

f.  Exit back to root.
exit

g. In the WAS_HOME/bin directory, stop the WebSphere Application Server
application. For example, as WASAdmin, type on one line:
stopServer.sh serverl -username wasadmin -password passwOrd
The result is like this example:

ADMUO116I: Tool information is being logged in file
//opt/1BM/WebSphere/AppServer/profiles/KLMProfile/logs/serverl/stopServer.log
ADMUO128I: Starting tool with the WASProfile profile
ADMU3100I: Reading configuration for server: serverl
ADMU3201I: Server stop request issued. Waiting for stop status.
ADMU4000I: Server serverl stop completed.

h. Start the WebSphere Application Server application. As the WebSphere
Application Server administrator, type on one line:

startServer.sh serverl

i. In the WAS_HOME/bin directory, use the wsadmin interface that the
WebSphere Application Server provides to specify the Jython syntax.

./wsadmin.sh -username wasadmin -password mypwd -lang jython
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j. Verify that you can connect to the database by using the WebSphere
Application Server data source.

1) First, query for a list of data sources. Type:
print AdminConfig.list('DataSource')
The result might be like this example:

"SKLM DataSource(cells/SKLMCel1/nodes/SKLMNode/
servers/serverl|resources.xml#DataSource_1228871762031)"

"SKLM scheduler XA Datasource(cells/SKLMCell/nodes/SKLMNode/
servers/serverl|resources.xml#DataSource_1228871766562)"

"Tivoli Common Reporting Data Source(ce]]s/SKLMCe]]|resources.xm1#
DataSource 1227211230078)"

DefaultEJBTimerDataSource(cells/SKLMCel1/nodes/SKLMNode/
servers/serverl|resources.xml#DataSource 1000001)

ttssdb(cel1s/SKLMCel11|resources.xml#DataSource_1227211144390)

2) Type:
print AdminControl.testConnection('SKLM DataSource(cells....)")
For example, type on one line:

print AdminControl.testConnection
('SKLMDataSource(cel1s/SKLMCel1/nodes/SKLMNode/
servers/serverl|resources.xml#DataSource 1228871762031)")

3) Test the connection on the remaining data source. For example, type:

print AdminControl.testConnection
('SKLM scheduler XA Datasource(cells/SKLMCel1/nodes/SKLMNode/
servers/serverl|resources.xml#DataSource_1228871766562) ")

4) In both cases, you receive a message that the connection to the data
source was successful. For example:

WASX72171: Connection to provided data source was successful.

WebSphere Application Server and IBM Security Key Lifecycle
Manager server configuration during installation

The installation wizard gathers configuration information for IBM Security Key
Lifecycle Manager and for the WebSphere Application Server runtime environment.

Application Server Administration

User Name
Specifies the WebSphere Application Server login user ID for the IBM
Security Key Lifecycle Manager administrator profile.

Password
Specifies the WebSphere Application Server password for the IBM Security
Key Lifecycle Manager profile.

HTTPS Admin Port
Specifies the HTTPS port to access WebSphere Integrated Solutions Console
for the IBM Security Key Lifecycle Manager profile.

Default value is 9083.

IBM Security Key Lifecycle Manager Application Administration

User Name
Specifies the user ID to administer IBM Security Key Lifecycle Manager.

Password
Specifies the password for the IBM Security Key Lifecycle Manager
administrator.
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HTTPS Port Number
Specifies the secure port to access IBM Security Key Lifecycle Manager.

Default value is 443.

HTTP Port Number
Specifies the non-secure port to access IBM Security Key Lifecycle
Manager.

Default value is 80.
Note:

The User Name string cannot contain leading and trailing spaces, and cannot
contain the following characters:

/ forward slash
\ backslash

* asterisk
comma

colon

; semi-colon

= equal sign

+ plus sign

? question mark

| vertical bar

< left angle bracket
>

&

N

right angle bracket
ampersand (and sign)

%  percent sign

single quotation mark

double quotation mark

1I> No specific name exists for this character combination.
period (not valid if first character; valid if a later character)

# Hash mark

$ Dollar sign

~ Tilde

( Left parenthesis
) Right parenthesis

Migrating Encryption Key Manager configuration

Installation provides an option to migrate an existing Encryption Key Manager
configuration to IBM Security Key Lifecycle Manager.

Before you begin, obtain the password to log in to the Encryption Key Manager
server.

To migrate an existing configuration, select this option:

Migrate Encryption Key Manager
Check this box if you have an old Encryption Key Manager properties file
to migrate to IBM Security Key Lifecycle Manager. If you select the check
box, you must specify the properties file from the previous Encryption Key
Manager system.

You can migrate from Version 2.1 of Encryption Key Manager.
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Encryption Key Manager must not be active when you are doing the migration. To
stop a running Encryption Key Manager process, complete these steps:

1. Start an administrative session. At version 2.1, enter this command:
java com.ibm.keymanager.KMSAdminCmd KeyManagerConfig.properties -i
2. After the administrative session starts, complete these steps:

a. Authenticate to the Encryption Key Manager server by using the login
command. Type:

login -ekmuser EKMAdmin -password password
b. Stop the server. Type:
stopekm
3. Exit the session.

For restrictions on migration, see [“Migration restrictions and requirements fod
[Encryption Key Manager” on page 22|

Back up the server that has the configuration data that you intend to migrate.
Migrated data includes the following files:

* A configuration properties file

* Keys and certificates that are referenced by the configuration properties file
* Drive tables

* An optional metadata file pointed at by the configuration properties file

* An optional key groups file

Note: You can also use the cross-platform backup utility to run backup operation
on Encryption Key Manager 2.1 to back up critical data. You can restore the
backup files on IBM Security Key Lifecycle Manager, Version 2.7 to an operating
system that is different from the one it was backed up from. For more information,
see [Backup and restore operations for earlier versions of IBM Security Keyl
[Lifecycle Manager and IBM Tivoli Key Lifecycle Manager]

Errors during installation

48

Errors that you must correct can occur during installation. Many error messages
contain enough information to correct the situation that caused the error. However,
some error conditions require more information.

Silent installation might exit with no error message displayed, but errors do
exist in the log file.
If silent installation exits with a zero return code, also check the log file for
error messages.

Windows
\<IM App Data Dir>\Tlogs

Linux or AIX
/<IM App Data Dir>/1ogs

If you get an error message about a disk or file system not having enough disk
space available:
Remove files to free up space, or add storage to the system to expand the
size of the file system.

Do not correct the problem while the installation program is running. Exit
the installation program before you make the corrections, and restart the
program after the corrections are made.
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See |“Hardware requirements” on page 7| for information about disk space
and other hardware requirements.

If you install IBM Security Key Lifecycle Manager using an Exceed X Server on
a local machine while exporting the display from a Linux system to the local
machine, do not decline the license agreement.
If you decline the license agreement, the installation program can be
rendered unresponsive. Accept the license agreement, or use a Cygwin X
Server or a Virtual Network Connection instead.

Removing the skimdb27 administrator using Windows user and group
management tool requires removing the previous skimdb27 subdirectory before
reinstalling IBM Security Key Lifecycle Manager and DB2.
During IBM Security Key Lifecycle Manager installation, you might
encounter a problem if you used the Windows user and group
management tool to previously delete the skimdb27 user ID as the DB2
administrator. Reinstalling IBM Security Key Lifecycle Manager then fails
to install DB2.

To fix the problem, take these steps:

1. Change to the appropriate subdirectory:
* Windows Server 2012: drive:\Users

2. Remove the skimdb27 subdirectory.

3. Reinstall IBM Security Key Lifecycle Manager. The skimdb27
subdirectory is not automatically removed when you use the Windows
user and group management tool to delete the user account skimdb27.

Non-root installation of IBM Security Key Lifecycle Manager on Linux

systems

You can install IBM Security Key Lifecycle Manager as a non-root user on Linux
operating systems.

Best practices for a non-root installation of IBM Security Key
Lifecycle Manager on Linux systems

When planning for your non-root installation of IBM Security Key Lifecycle
Manager on Linux systems, there are a number of best practices to consider.
Review these best practices before you start your installation.

* Ensure that non-root user belongs to a non-root primary group. The non-root
user must have a primary group other than guests, admins, users, and local.

* The home directory for non-root user ($HOME) must point to the correct location.
For example: /home/<user_name>

* Verify that the previous installation (if any) of IBM Security Key Lifecycle
Manager and DB2 in the system were completely removed without any
remnants.

* When you install IBM Security Key Lifecycle Manager, Prerequisite Scanner for
non-root installation might fail. Ensure that all the prerequisites that are
indicated in the Prerequisite Scanner check are met except for the requirement
for Administrator privileges before you proceed with the installation.

To continue with the installation, skip running Prerequisite Scanner. To skip the
prerequisite scan, create skimInstall.properties file in the /tmp directory with
the following property.

SKIP_PREREQ=true
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* Ensure that the operating system level kernel settings are correct for DB2
installation. For more information on DB2 kernel settings, see DB2
documentation at: fhttp://www.ibm.com/support/knowledgecenter /|
[SSEPGG_11.1.0/com.ibm.db2.luw.gb.server.doc/doc/t0008238.html|

* During the installation, database Administrator ID must be same as the non-root
user who is logged on to system for performing the installation. Ensure the
following requirements for database Administrator ID:

— Password for database Administrator ID must be same as the operating
system level password for the non-root user.

— Database Administrator group is same as the primary group of the non-root
user at operating system level.

— Database home points to the home directory of the non-root user.
* Non-root installation is not supported with silent mode.

* Migration from IBM Security Key Lifecycle Manager previous version 1.0, 2.0,
2.0.1, 2.5, 2.6, and Encryption Key Manager to non root installation of version 2.7
is not supported.

» DB2 might not start on system boot when installed as a non-root user. Correct
by starting DB2 before WebSphere Application Server starts. Run the
nonrootconfig.sh script after installer completed the installation.

Installing IBM Security Key Lifecycle Manager on Linux
systems as a non-root user

You can install IBM Security Key Lifecycle Manager as a non-root user on Linux
operating system. Non-root installation of IBM Security Key Lifecycle Manager
installs both DB2 and WebSphere Application Server as a non-root user.

About this task

Note:

 If you install IBM Security Key Lifecycle Manager as a non-root user, you cannot
migrate IBM Security Key Lifecycle Manager version 2.5, 2.6 and Encryption Key
Manager to version 2.7.

* You cannot install IBM Security Key Lifecycle Manager as a non-root user in
silent mode.

Procedure

1. Ensure that your target environment meets IBM Security Key Lifecycle
Manager installation prerequisites. See |“Planning the installation” on page 5.

2. Create a non-root User ID. Ensure that the User ID must have a primary group
other than guests, admins, users, and local.

3. Open a command prompt and run launchpad.sh.

4. Specify the DB2 configuration parameters. See [‘DB2 configuration during]
[non-root installation” on page 51

5. Specify the WebSphere Application Server configuration parameters.

6. After the IBM Security Key Lifecycle Manager installation process is complete,
open the command prompt in a new terminal window.

7. Stop WebSphere Application Server and DB2.
Run the following command to stop WebSphere Application Server.

cd <WAS_HOME>/bin
./stopServer.sh <server name> -username <WAS Admin User ID> -password <WAS Admin password>

./stopServer.sh serverl -username wasadmin -password wasadmin_pwd
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Run the following command to stop DB2.

cd ~/sqllib/adm
./db2stop

8. Open /home/username/skimV27properties/scripts and run the following
command.

Non-root DB2 installation requires root access to configure DB2 instance with a
specific port number and service name.

sudo nonrootconfig.sh <instance_home> <user_name> <port_number>
9. Restart WebSphere Application Server.

cd <WAS_HOME>/bin
./startServer.sh <server name>

./startServer.sh serverl

What to do next

In the SKLM_HOME/config/SKLMConfig.properties file, update the SSL port number
higher than 1024 by using graphical user interface, command-line interface or
REST interface. For example:

TransportListener.ssl.port=4411

After the installation, you must log in as a non-root user to start or stop IBM
Security Key Lifecycle Manager sever and DB2 server.

DB2 configuration during non-root installation

IBM Security Key Lifecycle Manager requires DB2 Advanced Workgroup Server
Edition at a version 11.1 level that depends on the operating system.

During DB2 configuration, you are prompted for the following information:

DB2 Administrator ID
The local DB2 administrator user ID. Because non-root DB2 user can have
a single instance, the DB2 administrator ID must be same as the User ID
who is logged on the system.
User IDs have the following restrictions and requirements:
* Must have a primary group other than guests, admins, users, and local.
* Can include lowercase letters (a-z), numbers (0-9), and the underscore

character ( _).

* Cannot be longer than eight characters.
* Cannot begin with IBM, SYS, SQL, or a number

* Cannot be a DB2 reserved word (USERS, ADMINS, GUESTS, PUBLIC, or
LOCAL), or an SQL reserved word

 Cannot use any User IDs with root privilege for the DB2 instance ID,
DAS ID or fenced ID.

* Cannot include accented characters.

DB2 Administrator Password
The password for the administrator. The maximum length is 20 characters.

The password for the DB2 Administrator user ID is subject to the security
policy active on the system. Password for DB2 Administrator ID must be
same as the operating system level password for the non-root user who is
logged on to the system. When you change one, you must change the
other.
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Database Name
The name of the IBM Security Key Lifecycle Manager database, which is
SKLMDB27.

DB2 Port
The port that DB2 uses.

Administrator's Group
Access group in which the Administrator user ID exists. Database
Administrator group must be same as the primary group for the non-root
user at operating system level.

Administrator / Database Home
The directory in which the database instance and the formatted tables that
are used by IBM Security Key Lifecycle Manager are created. Database
home must point to the home directory of the non-root user.

Notes:

1. Entries for all fields are restricted to alphabetical characters (A-Z and a-z),
numeric characters (0-9), and the underscore character (_). The restriction also
applies to the values in the response file that is used for silent installations.

2. Do not specify spaces in any of the directory paths or file names.
3. The name of the computer on which you install DB2 cannot start with “ibm”,

“sql”, or “sys” in lowercase or uppercase. The name of the computer also
cannot contain the underscore character ().

For more information about how to modify kernel parameters and non-root
installation, see DB2 documentation.

+ Ihttp:/ /www-01.ibm.com /support/knowledgecenter /SSEPGG_11.1.0/|
com.ibm.db2.luw.gb.server.doc/doc/t0008238.html|

* |http:/ /www-01.ibm.com/support/knowledgecenter /SSEPGG_11.1.0//
com.ibm.db2.luw.gb.server.doc/doc/t0050571 .htrnl|
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Post-installation steps

After you install IBM Security Key Lifecycle Manager, ensure that the DB2 and
WebSphere Application Server services are correctly configured.

Login URL and initial user ID

To get started after you install IBM Security Key Lifecycle Manager, obtain the
login URL and the initial IBM Security Key Lifecycle Manager administrator user
ID and password.

Login URL for IBM Security Key Lifecycle Manager

Use login URL to access the IBM Security Key Lifecycle Manager web interface.
The login URL for the IBM Security Key Lifecycle Manager administrative console
is:

https://ip-address:port/ibm/SKLM/Togin.jsp

The value of ip-address is an IP address or DNS address of the IBM Security Key
Lifecycle Manager server.

The value of port is the port number that IBM Security Key Lifecycle Manager
server listens on for requests.

By default, IBM Security Key Lifecycle Manager server listens to non-secure port
80 (HTTP) and secure port 443 (HTTPS) for communication. During IBM Security
Key Lifecycle Manager installation, you can modify these default ports. If you are
using the default port for HTTP or HTTPS, the port is an optional part of the URL.
For example:

https://ip-address/ibm/SKLM/Togin.jsp
Do not use a port value greater than 65520.

On Windows systems, the information is on the Start screen:

1. On the desktop, hover the mouse cursor in the lower left corner of the screen,
and click when the thumbnail of the Start screen appears.

2. Click the down arrow in the lower-left corner of the Start screen.

3. Click IBM Security Key Lifecycle Manager 2.7 > Launch IBM Security Key
Lifecycle Manager Application.

Short login URL for IBM Security Key Lifecycle Manager

IBM Security Key Lifecycle Manager has a short login URL as well that you can
easily remember.

Short login URL to access IBM Security Key Lifecycle Manager when standard
default port 80 (HTTP) and port 443 (HTTPS) are used:

https://ip-address/

Short login URL to access IBM Security Key Lifecycle Manager when you use
custom ports instead of standard default ports 80 and 443:
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https://ip-address:port/
Login URL for WebSphere Application Server

Login URL for the WebSphere Application Server administrative console:
https://ip-address:port/ibm/console/logon.jsp

The value of ip-address is an IP address or DNS address of the WebSphere
Application Server.

The value of port is the port number that WebSphere Application Server listens on
for requests.

The default port on the WebSphere Application Server information panel is 9093.
You can modify the default port during IBM Security Key Lifecycle Manager
installation. During migration, or if the default port has a conflict for other reasons,
WebSphere Application Server automatically selects another free port.

The Windows start menu contains an entry to connect to the WebSphere
Application Server with the correct port number.

Click IBM WebSphere > Administrative console.
Administrator user IDs and passwords

Installing IBM Security Key Lifecycle Manager provides default administrator user
IDs of WASAdmin, SKLMAdmin, and skimdb27.

Table 11. Administrator user IDs and passwords

Program

| User ID | Password

The installation must be run by a local administrative ID, which is root for AIX or Linux systems or a member of
the Administrators group on Windows systems. Do not use a domain user ID to install IBM Security Key Lifecycle

Manager.

You might have one or more of these user IDs:
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Table 11. Administrator user IDs and passwords (continued)

Program

User ID

Password

IBM Security Key Lifecycle
Manager administrator

SKLMAdmin

As the primary administrator with full
access to all operations, this user ID has
the kImSecurityOfficer super user role,
in the group that is named
kimSecurity0fficerGroup. This user ID
is not case-sensitive. Alternatively, use
skimadmin. Use the SKLMAdmin user ID to
administer IBM Security Key Lifecycle
Manager.

With the SKLMAdmin user ID, you can:

* View and use the IBM Security Key
Lifecycle Manager interface.

* Change the password for the IBM
Security Key Lifecycle Manager
administrator.

However, you cannot:

* Create one or more extra IBM Security
Key Lifecycle Manager administrator
user IDs.

* Do WebSphere Application Server
administrator tasks such as creating or
assigning a role.

* Start or stop the server.

Specify and securely store a password
during installation.

Post-installation steps
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Table 11. Administrator user IDs and passwords (continued)

Program

User ID

Password

WebSphere Application Server
administrator

WASAdmin

This user ID is not case-sensitive.
Alternatively, use wasadmin or a user ID
that you specify during installation.

Do not use the:

e SKLMAdmin user ID to administer
WebSphere Application Server.

* WASAdmin user ID to administer IBM
Security Key Lifecycle Manager. The
WASAdmin user ID has no roles to use
IBM Security Key Lifecycle Manager.

This administrator user ID is the
WebSphere Application Server
administrator user ID.

With the wasadmin user ID, you can:

* View and use only the WebSphere
Application Server interface.

* Create one or more extra IBM Security
Key Lifecycle Manager administrator
user IDs, groups, and roles.

* Reset the password of any IBM
Security Key Lifecycle Manager user
ID, including the SKLMAdmin
administrator.

* Start and stop the server.

However, you cannot:

* Use the IBM Security Key Lifecycle
Manager to complete tasks. For
example, you cannot create IBM
Security Key Lifecycle Manager device
groups.

* Do other tasks that require access to
IBM Security Key Lifecycle Manager
data. The wasadmin user ID does not
have access to IBM Security Key
Lifecycle Manager data as a
superuser.

Specify and securely store a password
during installation.

Protect the WASAdmin user ID in the same
way that you protect the use of the
SKLMAdmin user ID. The WASAdmin user ID
has authority to reset the SKLMAdmin
password and to create and assign
permissions to new IBM Security Key
Lifecycle Manager users.

The IBM Security Key Lifecycle Manager DB2 database
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Table 11. Administrator user IDs and passwords (continued)

Program

User ID

Password

Instance owner of the database

Windows, Linux, or AIX systems: The
default value is sk1mdb27. You might
specify a different value during
installation. The ID is the installation
default user ID for the instance owner of
the database.

Do not specify a user ID greater than
eight characters in length.

The instance name is also sk1mdb27.

If DB2 is on AIX or Linux, your user ID
must be in the bin or root group, or in a
separate group in which root is a
member.

If you use an existing user ID as
instance owner of the IBM Security Key
Lifecycle Manager database, the user ID
cannot own another database instance.
Note: Do not use a hyphen (-) or
underscore character (_) when you
specify a user ID for an existing copy of
DB2.

Database instance

The administrator ID skimdb27 owns a
DB2 instance named skImdb27.

Specify and securely store a password
during installation. This password is an
operating system password. If you
change the password on the operating
system, you must change this password.

For more information, see [Resetting a|

[password].

Services, ports, and processes

After you install IBM Security Key Lifecycle Manager server, validate that required
services, ports, and processes are running.

Windows

Services

Component

Service Name

WebSphere Application Server

IBM WebSphere Application
Server V9.0 - SKLM27Server

DB2 DBSKLMV27 - SKLMDB27

Ports The following ports must be open for communication and not used by any
other processes.

Description Port Number

Default HTTPS port to access IBM Security Key
Lifecycle Manager graphical user interface and REST
services

You can configure this port at the time of IBM Security
Key Lifecycle Manager installation.

443
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Description Port Number
Default HTTP port to access IBM Security Key Lifecycle |80
Manager graphical user interface

You can configure this port at the time of IBM Security

Key Lifecycle Manager installation.

Default HTTPS port to access WebSphere Integrated 9083
Solutions Console

You can configure this port at the time of IBM Security

Key Lifecycle Manager installation.

Default port for DB2 50030
You can configure this port at the time of IBM Security

Key Lifecycle Manager installation. This value might be

another port number, depending on the installation

settings. There are other ports, which are associated with

the default port number.

Default installation time SSL port that listens for KMIP | 5696
messages

SSL port for device messages 441
TCP port for device messages 3801
WebSphere Application Server 9080 - 9099
WebSphere Application Server installation requires these

ports for various services it provides.

User configured replication ports in the replication

configuration file for master and clone servers. If a

firewall is used between the master and clone servers,

the firewall must be configured to pass Internet Control

Message Protocol (ICMP).

Processes

Name Process

IBM Security Key Lifecycle Manager

WASService.exe and java.exe

DB2

db2fmp64.exe and db2syscs.exe

When version 2.7 is migrated from version 1.0, 2.0, or 2.0.1

Services

Component

Service Name

Tivoli Integrated Portal

TIPProfile_Port_16340

DB2 DB2TKLMV?2 - TKLMDB2
Ports
Description Port Number

IBM Security Key Lifecycle Manager

16340, 16341, 16342, 16343,
16345, 16346, 16350, 16352,
16353
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Description Port Number

DB2 The port number is the same as
the DB2 port number at IBM
Security Key Lifecycle Manager
Version 1. There are other
ports, which are associated
with the default port number.

Processes

Component Process

IBM Security Key Lifecycle Manager

WASService.exe and java.exe

DB2

db2fmp.exe and db2syscs.exe

Linux

Ports The following ports must be open for communication and not used by any

other processes.

Description

Port Number

Default HTTPS port to access IBM Security Key Lifecycle
Manager graphical user interface and REST services

You can configure this port at the time of IBM Security Key
Lifecycle Manager installation.

443

Default HTTP port to access IBM Security Key Lifecycle
Manager graphical user interface

You can configure this port at the time of IBM Security Key
Lifecycle Manager installation.

80

Default HTTPS port to access WebSphere Integrated
Solutions Console

You can configure this port at the time of IBM Security Key
Lifecycle Manager installation.

9083

Default port for DB2

You can configure this port at the time of IBM Security Key
Lifecycle Manager installation. This value might be another
port number, depending on the installation settings. There
are other ports, which are associated with the default port
number.

50030

Default installation time SSL port that listens for KMIP
messages

5696

SSL port for device messages

441

TCP port for device messages

3801

WebSphere Application Server

WebSphere Application Server installation requires these
ports for various services it provides.

9080 - 9099
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Description Port Number

User configured replication ports in the replication
configuration file for master and clone servers. If a firewall
is used between the master and clone servers, the firewall
must be configured to pass Internet Control Message
Protocol (ICMP).

Processes

Component Process

IBM Security Key Lifecycle Manager WebSphere Application
Server and Java

DB2 db2fmp64 and db2syscs

Post-installation security

After you install IBM Security Key Lifecycle Manager, you must take several steps
to ensure certificate recognition by your browser, and protect sensitive user IDs
and passwords.

Specifying a certificate for browser access

All browsers trigger a certificate error that you must overwrite to gain access to
WebSphere Application Server.

About this task

The error occurs because the owner of the internal certificate is not in the list of
trusted signing authorities. Install the certificate into each browser that you use to
access IBM Security Key Lifecycle Manager. You can use the WebSphere
Application Server user interface to overwrite the certificate.

To configure the certificate, follow these steps:

Procedure

1. Using the WASAdmin user ID, log in to the IBM Security Key Lifecycle
Manager server.

2. On the Security tab, click SSL certificate and key management.

3. On the SSL certificate and key management page, click Manage endpoint
security configuration -> serverl. In the local topology tree, you might need to
click SKLMCell > nodes > SKLMNode > servers > serverl to expand the tree
and locate serverl in the outbound branch.

4. To set the specific SSL configuration for this endpoint, click Manage
Certificates.

5. Extract the certificate.

The browser needs only the certificate. Extract retrieves the certificate (the
public key) and stores it into a file. Do not export the certificate, which obtains
both the public and the private key.

6. Import the certificate into your browser.
* Firefox
a. Click Tools > Options > Advanced > Encryption.
b. Select View Certificates > Import buttons.
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c. Navigate to the directory from which the certificate is exported. Select the
certificate and click Open.

d. On the Certificate Manager dialog, select the imported certificate and
click Edit.

e. On the Edit website certificate trust settings dialog, select Trust the
authenticity of this certificate and click OK.

f. On the Certificate Manager dialog, click OK.
g. On the Options dialog, click OK.
* Internet Explorer
a. Click Tools > Internet Options.
b. Select the Content tab and click the Certificates button.

c. Select the Trusted Root Certification Authorities tab and click the Import
button.

d. On the Certificate Import Wizard dialog, click Next.

e. Browse to locate the certificate and click Next.

f. Type the password for the certificate and click Next.

g. Complete the remaining steps that the wizard provides.

h. On the Security Warning dialog, read the warning. If you agree, click Yes.

7. On the browser address field, enter the fully qualified Universal Resource
Locator to point to the IBM Security Key Lifecycle Manager server. Press Enter.

Changing the WebSphere Application Server keystore
password

SSL certificates for the browser are stored in WebSphere Application Server
keystores. On WebSphere Application Server, these keystore passwords are public
and must be changed.

About this task

When you install the application server, each server creates a keystore and
truststore for the default SSL configuration with the default password value of
WebAS.

Procedure
1. Change the password by using the graphical user interface:

a. Using the WASAdmin user ID, log in to the WebSphere Integrated Solutions
Console.

https://localhost:9083/ibm/console/Togon. jsp
b. On the Security tab, click SSL certificate and key management.

€. On the SSL certificate and key management page, click Key stores and
certificates > NodeDefaultKeyStore.

d. Change the keystore password.

e. On the SSL certificate and key management page, click Key stores and
certificates > NodeDefaultTrustStore.

f. Change the truststore password.
2. Save the password in a secure location.
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WebSphere Application Server security

You must take several steps to ensure WebSphere Application Server security for
sensitive information.

Support might determine that tracing is required to debug an issue in a function
that the WASService.exe command runs. Turning on tracing for this function
writes potentially sensitive trace information to the WASService.Trace file in the
Windows root directory. Use information protection steps that are appropriate for
your site to protect the WASService.Trace file.

Additionally, use caution when you run the stopServer command. Do not put the
password directly on the command line. Instead, enter the user name and
password for the WebSphere Application Server administrator when prompted.

For example, to stop all processes that are bound to WAS_HOME, type:
stopServer serverl

Enter the user name and password at the prompts.

Avoid including the user ID and password in the command. For example, do not
type:

Windows
stopServer.bat serverl -username wasadmin -password mypwd

Linux or AIX
./stopServer.sh serverl -username wasadmin -password mypwd

After the ps -aef command is run to display information about the active process,
can potentially display the WebSphere Application Server password.

Automatic services enablement

The IBM Security Key Lifecycle Manager installation process starts the DB2 and
WebSphere Application Server services that IBM Security Key Lifecycle Manager
requires. The installation process also sets the services to start automatically.
However, you might want to correct error conditions with the automatic starting of
services.

Windows systems

On Windows systems, use the Windows Services console to configure the services
to start automatically.

Locate the services in the following list. For each service in the list, open the
Properties dialog box for the service, and ensure that the Startup Type is set to
Automatic. If the Service status field has a value of Stopped, click Start to start the
service.

DB2 - db2 copy name - SKLM_INSTANCE_OWNER
For example, DB2 - DBSKLMV27 - SKLMDB27

DB2 Governor (db2 copy name)
For example, DB2 Governor (DBSKLMV27)

DB2 License Server (db2 copy name)
For example, DB2 License Server (DBSKLMV27)

62 Installing and configuring



DB2 Management Service (db2 copy name)
For example, DB2 Management Service (DBSKLMYV27)

DB2 Remote Command Server (db2 copy name)
For example, DB2 Remote Command Server (DBSKLMV27)

DB2DAS - DB2DAS_entry
For example, DB2DAS - DB2DAS00

Note: Disable DB2 Administration Server (DAS) only if DAS service is
hosted in Windows service.

WAS Service- IBM Security Key Lifecycle Manager
For example, IBM WebSphere Application Server V9.0 - SKLM27Server

Linux systems

On Linux systems, enter the following commands to configure the IBM Security
Key Lifecycle Manager DB2 instance owner to start automatically:

<DB_home_dir>/sq11ib/db2profile
DB_HOME/instance/db2iauto -on sklmdb27

Where skimdb2 is the default instance owner user ID. If you changed the value
during installation, use that user ID instead.

Installing IBM Security Key Lifecycle Manager on Linux systems adds command to
start the WebSphere Application Server to the /etc/inittab file. On Linux systems,
the installer creates the SecurityKeyLifecycleManager was.init file in /etc/init.d.
You can add similar command into the /etc/initttab file:

s1p:2345:wait:/bin/sleep 60
tt:23456789:wait:WAS_HOME/bin/startServer.sh serverl

AIX systems

On AIX systems, enter the following commands to configure the IBM Security Key
Lifecycle Manager DB2 instance owner to start automatically:

<DB_home_dir>/sq11ib/db2profile
DB_HOME/instance/db2iauto -on skimdb27

Where skimdb2 is the default instance owner user ID. If you changed it during
installation, use that user ID instead.

Installing IBM Security Key Lifecycle Manager on AIX systems adds commands to
start the WebSphere Application Server to the /etc/inittab file. You might edit
these commands in the /etc/inittab file:

s1:2345:wait:/bin/sleep 60
tt:23456:wait:WAS_HOME/bin/startServer.sh serverl

To configure the WebSphere Application Server to start automatically, follow the
steps that are described in the section that describes creating an SMF service
definition, in the IBM WebSphere Application Server V6.1 on the Solaris 10 Operating
System Redbooks publication. This document is available at: |http:/ /
fwww.redbooks.ibm.com /abstracts /sg247584.htmi|

Adapt the information from the web page with values based on your IBM Security
Key Lifecycle Manager installation. For example, use the directories from your
system in the script:
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WAS_DIR="//opt/IBM/WebSphere/AppServer/profiles/KLMProfile"

On some systems, it might be necessary to increase the timeout value in the
manifest file from 60 to 300.

Setting the session timeout interval

The IBM Security Key Lifecycle Manager user interface session can be configured
to time out after thirty minutes (default) of inactivity or to stay alive with no time
restriction.

Procedure
1. You can set the session timeout interval by using the graphical user interface:

a. Using the WASAdmin user ID, log in to the WebSphere Integrated Solutions
Console.

https://localhost:9083/ibm/console/Togon.jsp

b. On the Applications tab, click Application Types > WebSphere enterprise
applications.

On the Enterprise Applications page, click sklm_kms.
In the Web Module Properties section, click Session management.

In the General Properties section, select Override session management .

~ o oo

In the Session timeout section, select No timeout to stay alive with no
timeout.

g. To set the inactivity timeout in minutes, select Set timeout and specify the
desired inactivity timeout value.

2. Click Apply.
3. Click OK.

Setting the maximum transaction timeout

The total transaction timeout value is set to 600 seconds by default. Depending on
the setting, some long running IBM Security Key Lifecycle Manager operations
might timeout.

About this task

Long running IBM Security Key Lifecycle Manager operations might timeout with
an error message like this example:

[16/21/08 14:28:41:693 CDT] 00000020 TimeoutManage I
WTRNOOO6W: Transaction 00000110001 has timed out after xxx seconds.

To configure the transaction timeout interval to a larger value, take these steps:

Procedure
1. Stop the server.
* Windows systems:
In the WAS_HOME\bin directory, type:
stopServer.bat serverl
* AIX and Linux systems:
In the WAS_HOME/bin directory, type:
./stopServer.sh serverl
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2. Edit this file:

..\profiles\KLMProfile\config\cel1s\SKLMCe11\nodes\SKLMNode\
servers\serverl\server.xml

3. Change the propogatedOrBMTTranLifetimeTimeout parameter to a larger value.
4. Save the file.
5. Start the server.
* Windows systems:
In the WAS_HOME\bin directory, type:
startServer.bat serverl
* AIX and Linux systems:
In the WAS_HOME/bin directory, type:
./startServer.sh serverl

IBM Security Key Lifecycle Manager system host name change

You must change the host name of WebSphere Application Server and DB2 when
the IBM Security Key Lifecycle Managersystem host name is changed.

Changing the DB2 server host name

After you change the IBM Security Key Lifecycle Manager system host name, you
must change the host name of the DB2 server.

About this task

Obtain the current steps to change the host name for your level of the DB2 server
from the technote at this web address: |http:/ /www.ibm.com /support/|
docview.wss?rs=71&context=SSEPGGé&context=SSEPDU&context=SSVGXH]
&context=SSVGZB&context=SSFHEG&context=SSYK8P&context=SSTLZ9)|
&q1=db2+change+hostname&uid=swg21258834&loc=en_USé&cs=utf-8&lang=en|

Changing an existing WebSphere Application Server host
name

You must change the host name of WebSphere Application Server before you
change the system host name.

Procedure

1. Change the host name of WebSphere Application Server. For more information
about how to change the host name, see IBM WebSphere Application Server
documentation (http:/ /www.ibm.com/support/knowledgecenter/|
[SSEQTP_9.0.0/ com.ibm.websphere. base.doc/ae/tagt_hostname.html).

2. When this task succeeds, change the host name of the DB2 server. For more
information, see [‘Changing the DB2 server host name.”|

Stopping the DB2 server

Some operational procedures might require you to stop the DB2 server server. You
must stop WebSphere Application Server before you stop the DB2 server server.

About this task

You must be the database instance owner on AIX or Linux systems, or the Local
Administrator on Windows systems.
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Procedure

1. Log in as the database instance owner on AIX or Linux systems, or log in as
Local Administrator on Windows systems.

2. Run the following command to stop WebSphere Application Server.

Windows
cd C:\Program Files\IBM\WebSphere\AppServer\bin
.\stopServer.bat serverl -username wasadmin -password mysecretpwd

AIX or Linux

/opt/1BM/WebSphere/AppServer/bin/stopServer.sh serverl -username wasadmin
-password mysecretpwd

3. Run the following command to stop the DB2 server.

Windows
set DB2INSTANCE=sk1mdb27
db2stop

AIX or Linux
su -skimdb27
db2stop

Configuring SSL

After you install IBM Security Key Lifecycle Manager, you must configure secure
communication by using SSL.

About this task

This option is controlled by the config.keystore.ss1.certalias property in the
SKLM_HOME/config/SKLMConfig.properties file.

If transport ports are specified, this alias points at an existing certificate that is
used for SSL authentication for secure communication between a drive and the
IBM Security Key Lifecycle Manager server.

If you migrate data from Encryption Key Manager, all the certificates from the
TransportlListener truststore are imported into the IBM Security Key Lifecycle
Manager keystore.

A certificate from the TransportListener keystore is set as the SSL certificate for
IBM Security Key Lifecycle Manager. The config.keystore.ss1.certalias property
is updated with the alias of this certificate.

To configure SSL for secure communication, follow these steps:

Procedure
1. Navigate to the appropriate page or directory.
* Graphical user interface:
Log on to the graphical user interface. You can select either of these paths:

— Click IBM Security Key Lifecycle Manager > Configuration >
SSL/KMIP.

— IBM Security Key Lifecycle Manager > Advanced Configuration >
Server Certificates.

¢ Command-line interface
a. Go to the <WAS_HOME>/bin directory. For example,
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Windows
cd drive:\Program Files\IBM\WebSphere\AppServer\bin
Linux cd /opt/IBM/WebSphere/AppServer/bin
b. Start the wsadmin interface by using an authorized user ID, such as
SKLMAdmin. For example,

Windows
wsadmin.bat -username SKLMAdmin -password mypwd -lang jython

Linux
./wsadmin.sh -username SKLMAdmin -password mypwd -lang jython
2. Specify the certificate that is used for SSL communication.
* Graphical user interface:
Specify a certificate as the SSL certificate:

— On the SSL/KMIP for Key Serving page, select the option to use an
existing certificate from the keystore as the SSL certificate. Select a
certificate and click OK.

— Alternatively, on the Administer Server Certificates page, select an existing
certificate and click Modify. Specify that the certificate is the currently
used certificate and click Modify Certificate.

* Command-line interface:

— To see the value of the property, use the tkiImConfigGetEntry command.
For example, you might want to validate that a migrated certificate is set
as the SSL certificate.

This Jython-formatted command obtains the current value of the
config.keystore.ssl.certalias property.

wsadmin>print AdminTask.tkImConfigGetEntry
(' [-name config.keystore.ssl.certalias]"')

— To change the value of the property, use the tkimConfigUpdateEntry
command to specify the certificate that the IBM Security Key Lifecycle
Manager server uses.

For example, this Jython-formatted command example changes the value of
the config.keystore.ssl.certalias property.

print AdminTask.tkImConfigUpdateEntry
(' [-name config.keystore.ssl.certalias
-value mycert]')

3. A success indicator varies, depending on the interface:
* Graphical user interface:

On the Success page, under Next Steps, click a related task that you want to
carry out.

¢ Command-line interface:

A completion message indicates success.

Checking the current port number

After IBM Security Key Lifecycle Manager server installation, you might want to
determine the secure and non-secure port numbers for the IBM Security Key
Lifecycle Manager server and the WebSphere Integrated Solutions Console.
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About this task

The value of the port numbers is specified by the WC_adminhost_secure,
WC_defaulthost, and the WC_defaulthost_secure, property in the
WAS_HOME/profiles/KLMProfile/properties/portdef.props file. For example, the
file might specify these values:

WC_adminhost_secure=9083

WC_defaulthost=80
WC_defaulthost_secure=443

The WC_adminhost_secure property value corresponds to the WebSphere Integrated
Solutions Console secure port. The WC_defaulthest property value corresponds to
the IBM Security Key Lifecycle Manager server non-secure port and
WC_defaulthost_secure corresponds to secure port.

Installation verification

After the installation, verify that the IBM Security Key Lifecycle Manager
installation was successful.

1. Start and stop the server. See [“Starting and stopping the IBM Security Keyl
[Lifecycle Manager server” on page 69| for details.

2. Open IBM Security Key Lifecycle Manager in a web browser.

a. Use login URL to access the IBM Security Key Lifecycle Manager web
interface.
https://ip-address:port/ibm/SKLM/Togin.jsp
The value of ip-address is an IP address or DNS address of the IBM Security
Key Lifecycle Manager server.
The value of port is the port number that IBM Security Key Lifecycle
Manager server listens on for requests.

By default, IBM Security Key Lifecycle Manager server listens to non-secure
port 80 (HTTP) and secure port 443 (HTTPS) for communication. During
IBM Security Key Lifecycle Manager installation, you can modify these
default ports. If you are using the default port for HTTP or HTTPS, the port
is an optional part of the URL. for example:

https://ip-address/ibm/SKLM/Togin.jsp

IBM Security Key Lifecycle Manager has a short login URL as well that you
can easily remember. Short login URL to access IBM Security Key Lifecycle
Manager when default ports are used is:

https://ip-address/
On Windows systems, the information is on the Start screen:

1) On the desktop, hover the mouse cursor in the lower left corner of the
screen, and click when the thumbnail of the Start screen appears.

2) Click the down arrow in the lower-left corner of the Start screen.

3) Click IBM Security Key Lifecycle Manager 2.7 > Launch IBM Security
Key Lifecycle Manager Application.

b. Log in with your credentials and ensure that the IBM Security Key Lifecycle
Manager welcome page is displayed.

3. Use the command-line interface to list the IBM Security Key Lifecycle Manager
command group. For example, from WAS_HOME/bin, enter:

./wsadmin.sh -username <sklmadmin id> -password <skimadmin passwd> -lang jython

When the wsadmin tool prompts you, enter this command:
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wsadmin>print AdminTask.help("-commandGroups")

The IBM Security Key Lifecycle Manager command groups are displayed. For
example, the list contains backup commands and other command groups:

TKLMBackupCommands - IBM Security Key Lifecycle Manager backup/restore commands

Enabling scripting settings for Internet Explorer, Version 9.0, 10, and
11

Ensure that scripting settings for Internet Explorer, version 9.0, 10, and 11 are
enabled.

About this task

Unless some scripting settings are enabled for Internet Explorer, version 9.0, 10,
and 11.0, you might later be unable to create an IBM Security Key Lifecycle
Manager user.

Ensure that these browser settings are enabled:
* Allow status bar updates through scripts

* Active Scripting

* Scripting of Java applets

Procedure
1. Open the browser and click Tools > Internet Options > Security.

2. Scroll the list of security settings to the Scripting options and ensure that these
settings are enabled:

 Allow status bar updates through scripts
* Active Scripting
* Scripting of Java applets

3. Click OK.

Starting and stopping the IBM Security Key Lifecycle Manager server

You might want to use the startServer or stopServer command to start or stop
the IBM Security Key Lifecycle Manager server. For example, after a restore task
completes, restart the IBM Security Key Lifecycle Manager server.

About this task

The IBM Security Key Lifecycle Manager server automatically restarts after a
backup file is restored when the autoRestartAfterRestore property value is true
(default value) in the SKLMConfig.properties file.

Scripts to start and stop the IBM Security Key Lifecycle Manager server are in the
WAS_HOME/bin directory.

Procedure
1. Navigate to the WAS_HOME/bin directory.
2. Start or stop the server.

 Start
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Windows
startServer.bat serverl

Linux or AIX
./startServer.sh serverl
* Stop

Windows
stopServer.bat serverl

Linux or AIX
./stopServer.sh serverl
Global security is enabled by default. Enter the user ID and password of the
WebSphere Application Server administrator as parameters to the stopServer
script. The script prompts for these parameters when they are omitted, but you
can specify them on the command line:

Windows
stopServer.bat serverl -username wasadmin -password mypwd

Linux or AIX
./stopServer.sh serverl -username wasadmin -password mypwd

What to do next

Determine whether IBM Security Key Lifecycle Manager is running. For example,
open IBM Security Key Lifecycle Manager in a web browser and log in.

Enabling

global security

Conditions might occur in which you must enable global security.

About this task

Do

not disable global security when you use IBM Security Key Lifecycle Manager.

Procedure

1.

B

© N oo

To enable global security, log in as the WebSphere Application Server
administrator WASAdmin.

In the navigation bar, click Security.
Click Secure administration, applications and infrastructure.
Check the Enable administrative security check box.

Ensure that Enable application security is also selected and that Use Java 2
security to restrict application access to local resources is not selected.

Click Apply.
Click Save in the Messages box. Click Logout.
Stop and restart the server.

Reload the IBM Security Key Lifecycle Manager login page. Verify that the page
requires a password.

Disabling global security

Conditions might occur in which you must disable global security.

About this task

Do

Installing and configuring

not disable global security when you use IBM Security Key Lifecycle Manager.



Procedure

1.

© N Ok~ DN

To disable global security, log in as the WebSphere Application Server
administrator WASAdmin.

In the navigation bar, click Security.

Click Secure administration, applications and infrastructure.
Clear the Enable administrative security check box.

Click Apply.

Click Save in the Messages box. Click Logout.

Stop and restart the server.

Reload the IBM Security Key Lifecycle Manager login page. Verify that the page
does not require a password.
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Recovery from migration failure

During inline migration process for Encryption Key Manager or IBM Security Key
Lifecycle Manager earlier versions to version 2.7, you might encounter migration
failure. You can run the migration recovery steps in case of a migration failure.

Recovery from Encryption Key Manager migration failure

During inline migration process for Encryption Key Manager, you might encounter
migration failure. If the migration failure occurs, run the migration recovery steps.

The installation process completes the installation step for IBM Security Key
Lifecycle Manager and starts a migration process to migrate data from Encryption
Key Manager to IBM Security Key Lifecycle Manager.

* When the migration process starts, an error might occur during the installation
program is validating the values in the Encryption Key Manager properties file
for the following conditions:

— The properties file cannot be read because of inadequate access permissions.
— A required property does not exist or does not have a value.
— The value of a property is malformed.

— The file that a property points to does not exist or cannot be read because of
inadequate access permissions.

* An error might occur after the migration operation completes significant
activities. In this case, review the error log file:

Windows
<IM App Data Dir>\1ogs\sklmLogs\migration.log

AIX and Linux
<IM App Data Dir>/1ogs/skimLogs/migration.log

If Encryption Key Manager migration fails and you choose to complete the
remaining migration process, you can start a migration-recovery script if you do
not make changes or otherwise configure IBM Security Key Lifecycle Manager
server before you run the script. For information about how to run the script, see
[Migration recovery script for Encryption Key Manager|

If Encryption Key Manager migration fails, and no data were migrated, remove the
tkimKeystore.jceks file to start the migration process again. You can locate the file
in the WAS_HOME\products\skim\keystore directory.

Migration recovery script for Encryption Key Manager

You can start a migration-recovery script for Encryption Key Manager if you do
not make any changes or otherwise configure IBM Security Key Lifecycle Manager
server before you run the script. For example, do not significantly change the
available disk space on the system.

The migration script is in the <SKLM_INSTALL_HOME>\migration\bin directory. The
commands to run the script are:
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Windows systems:
cd <SKLM_INSTALL_HOME>\migration\bin
.\migrate.bat skim_instance_owner_password

Linux and AIX systems:
cd <SKLM_INSTALL_HOME>/migration/bin
./migrate.sh sklm_instance_owner_password

On Linux or AIX systems, ensure that you are logged in as the root user
before you run migrate.sh.

Where the skim_instance_owner_password parameter is the password for the IBM
Security Key Lifecycle Manager server DB2 instance owner.

The <SKLM_INSTALL_HOME> parameter is only used on Windows systems and
must be enclosed in quotation marks.

Windows systems:

cd "C:\Program Files\IBM\SKLMV27\migration\bin"
.\bin\migrate.bat password
echo %ERRORLEVEL%

Note:

* If you do not want to specify the password as an argument, omit the
password. The recovery script prompts you for the value. The password
is not in clear text. For example:
migrate.bat
echo §$?

* During its runtime progress, the migration recovery script creates a
migration.log file.

* If migrate.bat or migrate.sh is not available,

1. Copy migrate.bat.template or migrate.sh.template to migrate.bat
or migrate.sh.

2. Specify the required parameters.
3. Run the file.
Linux and AIX systems:
cd /opt/IBM/SKLMV27/migration/bin

./bin/migrate.sh password
echo §$?

On Linux or AIX systems, ensure that you are logged in as the root user
before you run migrate.sh.

Recovery from migration failure for IBM Security Key Lifecycle
Manager

These error scenarios might occur during migration for IBM Security Key Lifecycle
Manager:

* As migration starts, an error message might be caused by one or more of the
following conditions:

— Inadequate access permissions prevent reading required files, or properties or
files are missing.

— Other applications are using a required file.

— During DB2 server migration, WebSphere Application Server unexpectedly
stopped running.
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+ After migration is complete, or has performed significant activities, An error
might occur after the migration operation has begun.

The installation program displays an error message. In this case, review the error
log file:
Windows systems:
<IM App Data Dir>\1ogs\sklmLogs\migration.log
AIX and Linux systems:
<IM App Data Dir>/1ogs/sklmLogs/migration.log

If repeated running of the migration program fails and you choose to go back to
earlier version, complete these tasks for a new version of DB2:

— Uninstall IBM Security Key Lifecycle Manager earlier version. On AIX or
Linux systems, navigate to the home directory of the instance owner such as
/home/sk1mdb27. If the sq11ib_v91 directory exists, remove the directory.

— Restart the computer.

— Reinstall IBM Security Key Lifecycle Manager previous version and restore
the most recent backup. Apply the most recent fix pack.

Migration recovery script for IBM Security Key Lifecycle Manager

You can start a migration-recovery script for IBM Security Key Lifecycle Manager if
you do not make any changes or otherwise configure IBM Security Key Lifecycle
Manager server before you run the script. For example, do not significantly change
the available disk space on the system.

The migration utility creates a migration.log file in the <IM App Data
Dir>\logs\sklmLogs directory.

The migration script is in the <SKLM_INSTALL_HOME>\migration directory. Before you
run the migration script ensure that JAVA_HOME is set correctly. Following example
shows the path for JAVA_HOME:

Windows systems
C:\Program Files\IBM\WebSphere\AppServer\java\jre

Linux and AIX systems
/opt/I1BM/WebSphere/AppServer/java/jre

The commands to run the migration script are:

Windows systems

cd <SKLM_INSTALL HOME>\migration
.\migrateToSKLM.bat

Note: You must specify value for the migration parameters in the
migration.properties file, which exists under the <SKLM_INSTALL_HOME>\
migration directory.

For example:
cd "C:\Program Files\IBM\SKLMV27\migration"
.\migrateToSKLM.bat

Linux and AIX systems
cd <SKLM_INSTALL HOME>/migration
./migrateToSKLM.sh
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Note: You must specify value for the migration parameters in the
migration.properties file, which exists under the <SKLM_INSTALL HOME>/
migration directory.

For example:
cd /opt/IBM/SKLMV27/migration
./migrateToSKLM. sh

On Linux or AIX systems, ensure that you are logged in as the root user
before you run migrateToSKLM. sh.

Note: After you run the migration recovery script, restart WebSphere Application
Server manually.

Parameters in the migration.properties file

WAS_HOME
The directory where WebSphere Application Server for IBM Security Key
Lifecycle Manager, Version 2.7 is installed.

TKLM_TIP_HOME
The directory where Tivoli Integrated Portal for IBM Tivoli Key Lifecycle
Manager, Version 1.0, 2.0, or 2.0.1 is installed. You can also use this
parameter to set <WAS_HOME> for version 2.5 and 2.6.

WAS_ADMIN_ID
The Tivoli Integrated Portal administrator user name for the earlier
version.

WAS_ADMIN_PASSWORD
Password for the Tivoli Integrated Portal administrator user name.

SKLM_INSTALL_PATH
The directory where IBM Security Key Lifecycle Manager is installed.

SKLM_ADMIN_USER
Administrator user name, for the earlier version of IBM Security Key
Lifecycle Manager. The user name must be TKLMAdmin.

MIG_LOG_PATH
The file path where the migration.log is stored.

TKLM_VERSION
The version number of IBM Tivoli Key Lifecycle Manager that is installed
on the system.

TKLM_DB_PWD
The DB2 administrator password for IBM Tivoli Key Lifecycle Manager.

KEYSTORE_PWD
The key store password for IBM Tivoli Key Lifecycle Manager, Version 1.0,
2.0, or 2.0.1. This parameter is not required for version 2.5 and 2.6.

IM_INSTALL_DIR
The directory where IBM Installation Manager is installed.

Note: All the values except passwords are pre-filled in the properties file. Do not
modify any values except for the fields that are blank.
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Starting DB2 automatically

If you completed a failed migration by running the migration script in recovery
mode, you must enable DB2 to start automatically when the computer restarts.

Windows systems

On Windows systems, take these steps to start DB2 automatically:

1. Open the Control Panel and click Start > Control Panel > Administrative Tools
> Services.

2. Right-click the DB2 - DBSKMV27 - SKLMDB27 service and right-click
Properties.

3. On the Properties dialog, on the General tab, change the Startup Type to
Automatic and click Apply.

4. Restart the system to verify that the database server starts automatically.
AIX and Linux systems

If you enabled crontab in IBM Security Key Lifecycle Manager, type this command
to enable DB2 to start automatically:

. <DB_home_dir>/sql1ib/db2profile
DB_HOME/instance/db2iauto -on skimdb27

Where skimdb27 is the default instance owner user ID. If you changed the value
during installation, use that user ID instead.

Migration properties file

The IBM Security Key Lifecycle Manager server migration utility maintains a
<SKLM_INSTALL_HOME>\migration\migratestatus.properties file to track completed
tasks.

If migration fails, the properties file is retained for debugging purposes. The
migration utility also uses the retained file to determine at what point to start a
new migration process. If you accidentally run migration again, the utility uses the
properties file to determine whether migration already succeeded.

Recovery from migration failure 77



78 Installing and configuring



Uninstallation of IBM Security Key Lifecycle Manager

You must consider a few factors to successfully uninstall IBM Security Key
Lifecycle Manager.

* The default uninstallation mode is the same as the mode used to install IBM
Security Key Lifecycle Manager. You can also uninstall by using a different
mode. For more information, see [“Syntax and parameters for the uninstallation|

* Uninstalling IBM Security Key Lifecycle Manager does not uninstall DB2 if it is
installed before you install IBM Security Key Lifecycle Manager. This task a
separate, optional step. For information, see |“DB2 uninstallation” on page 85

In addition, although uninstalling IBM Security Key Lifecycle Manager
disassociates the DB2 database instance from the user ID used for the IBM
Security Key Lifecycle Manager DB2 instance owner, the deletion of the user ID
is a separate step. For information, see |“Remova1 of user ID from the DBZ|
[instance owner” on page 87

Unsuccessful uninstallation might indicate the need to return to a known state of
IBM Security Key Lifecycle Manager, see [“Reinstalling previous version if|
[migration repeatedly fails” on page 83

Syntax and parameters for the uninstallation program

You must use the uninstallation commands to uninstall IBM Security Key Lifecycle
Manager.

Silent unstallation
imc1 -input full path _to_response file -silent
imc1  Command to uninstall IBM Security Key Lifecycle Manager in
silent mode, which is located at:

Windows
<IBM_ Installation_Manager_install_dir>\eclipse\tools

For example: C:\Program Files\IBM\Installation
Manager\eclipse\tools

Linux and AIX
<IBM_Installation_Manager_install_dir>/eclipse/tools

For example: /opt/IBM/InstallationManager/eclipse/
tools

-input Specifies the full path and file name for the response file with the
uninstallation options to use during the silent uninstallation.

-silent
Specifies that the IBM Installation Manager installer must run in
silent mode.

Graphical mode unstallation
uninstall_program

Where uninstall_program is:
<IM_INSTALL_DIR>/IBMIM.exe on Windows systems.
<IM_INSTALL_DIR>\IBMIM on Linux or AIX systems.
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Uninstalling on Windows systems

Use IBM Installation Manager to uninstall IBM Security Key Lifecycle Manager,
DB2, and the WebSphere Application Server.

Before you begin

Stop WebSphere Application Server before you uninstall IBM Security Key
Lifecycle Manager. If WebSphere Application Server is not stopped before you
uninstall IBM Security Key Lifecycle Manager, the following false message is
displayed after Step 4:

Running processes have been detected that may interfere with the current
operation. Stop all WebSphere and related processes before continue.

Click Recheck Status to proceed with the uninstallation task.

Procedure

1. Browse to <IM_INSTALL_DIR>/eclipse. For example: C:\Program
Files\IBM\Installation Manager\eclipse

2. Double-click IBMIM to start IBM Installation Manager in GUI mode.

3. In IBM Installation Manager, click Uninstall. The Uninstall Packages window
opens.

4. Select the check boxes to uninstall IBM Security Key Lifecycle Manager, DB2,
and the WebSphere Application Server.

5. Click Next. Type the WebSphere Application Server Administrator user ID and
the password.

6. Click Next. The Summary panel window opens.

7. Review the software packages to be uninstalled and their installation
directories; click Uninstall.

What to do next

Note: After you uninstall IBM Security Key Lifecycle Manager, delete the
C:\Program Files\IBM\WebSphere and C:\Program Files\DB2SKLMV27 directories if
not already removed.

Recovering from a failed uninstallation on Windows systems
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You must recover a failed attempt to uninstall IBM Security Key Lifecycle Manager
on a Windows system.

About this task

This task assumes that the uninstallation program failed to complete successfully.
Take these recovery steps:

Procedure
1. Stop the WebSphere Application Server service.

a. Open the Windows Services Console by opening the Control Panel and
clicking Administrative Tools > Services.

b. Locate the WebSphere Application Server service.
For example: IBM WebSphere Application Server V9.0 - SKLM27Server
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10.

c. Open the Properties dialog box for the service. If the Service status is not
Stopped, click Stop.

d. Click OK to close the dialog box and exit the Windows Services Console.

If you cannot stop the service from inside the Windows Service Console, open
a command prompt window and enter these commands to stop the service
manually:

cd WAS_HOME\bin

WASService -stop SKLMServer

Remove the WebSphere Application Server service, if it is not already
removed. Open a command prompt window and enter these commands:

cd WAS_HOME\bin

WASService -remove SKLMServer

Uninstall WebSphere Application Server, if exists and other products are not
using it.

For uninstallation instructions, see the following links:

Graphical user interface

http:/ /www.ibm.com /support/knowledgecenter /SSAW57_9.0.0/|
com.ibm.websphere.installation.nd.doc/ae/|
tins_uninstallation_dist_gui.html|

Command-line interface

http:/ /www.ibm.com/support/knowledgecenter/SSAW57 9.0.0/|
com.ibm.websphere.installation.nd.doc/ae/tins_uninstallation_cl.html|
If the WAS_HOME or WAS_HOME\bin directories are already removed, skip Steps 1,
2, and 3.

Uninstall DB2, if exists and other products are not using it.

For uninstallation instructions, see [“Optional removal of DB2” on page 85

Open the C:\ProgramData\IBM\Installation Manager\installRegistry.xml
file in a text editor.

Note: Back up the installRegistry.xml file.

Remove the entries that are relating only to IBM Security Key Lifecycle
Manager. For example:

<profile id='IBM Security Key Lifecycle Manager v2.7' kind='product'>
</profile>

Remove the installation log files in this directory:

\<IM App Data Dir>\1ogs

Remove Control Panel > Add or remove programs > IBM Installation
Manger.

Remove the following folders, if exists:

* C:\Program Files\IBM\DB2SKLMV27

* C:\Program Files\IBM\WebSphere

* C:\Program Files\IBM\SKLMV27

e C:\Program Files\IBM\Installation Manager
e C:\Program Files\IBM\IBMIMShared

Restart the computer.
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Uninstalling on Linux and AIX systems

You must stop WebSphere Application Server before you uninstall IBM Security
Key Lifecycle Manager.

Procedure

1.

Browse to <IM_INSTALL_DIR>/eclipse. For example: /opt/IBM/
InstallationManager/eclipse

Run IBMIM.

In IBM Installation Manager, click Uninstall. The Uninstall Packages window
opens.

Select the check boxes to uninstall IBM Security Key Lifecycle Manager, DB2,
and the WebSphere Application Server.

Click Next. Type the WebSphere Application Server Administrator user ID and
the password.

Click Next. The summary panel opens.

Review the software packages to be uninstalled and their installation
directories.

Click Uninstall.

Recovering from a failed uninstallation on Linux or AIX systems
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You might want to recover a failed attempt to uninstall IBM Security Key Lifecycle
Manager on Linux or AIX systems.

About this task

This task assumes that the uninstallation program failed to complete successfully.
Take these recovery steps:

Procedure

1.
2.

5.
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Log in as root.

Stop the WebSphere Application Server processes if they are running.

cd WAS_HOME/profiles/KLMProfile/bin

./stopServer.sh serverl

Uninstall WebSphere Application Server, if exists and other products are not
using it.

For uninstallation instructions, see the following links:

Graphical user interface

http:/ / www.ibm.com /support/knowledgecenter /SSAW57 9.0.0/|
com.ibm.websphere.installation.nd.doc/ae /|
tins_uninstallation_dist_gui.html|

Command-line interface
http:/ /www.ibm.com /support/knowledgecenter /SSAW57 9.0.0/|
com.ibm.websphere.installation.nd.doc/ae/ tins_uninstallation_cl.html|

If the WAS_HOME or WAS_HOME/bin directories are already removed, skip Steps 2
and 3.

Uninstall DB2, if exists and other products are not using it.

For uninstallation instructions, see [“Optional removal of DB2” on page 85

Open the /var/ibm/InstallationManager/installRegistry.xml file.
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Note: Back up the installRegistry.xml file.

6. Remove the entries that are relating only to IBM Security Key Lifecycle
Manager. For example:

<profile id='IBM Security Key Lifecycle Manager v2.7' kind='product'>
</profile>

7. Remove the installation log files from the /var/ibm/InstallationManager/logs
directory by using the following command:
rm -rf /var/ibm/InstallationManager/logs

8. Uninstall IBM Installation Manger.

9. Remove the following folders, if exist:
* opt/IBM/DB2SKLMV27
* opt/IBM/WebSphere
* opt/IBM/SKLMV27
* opt/IBM/Installation Manager
 opt/IBM/IBMIMShared

10. Restart the computer.

Reinstalling previous version if migration repeatedly fails

Migration process does not affect the earlier version of IBM Security Key Lifecycle
Manager. If the migration continues to fail, uninstall IBM Security Key Lifecycle
Manager, Version 2.7 and continue to run the pervious version.

Note: On Windows platform, after you migrate IBM Security Key Lifecycle
Manager, Version 2.5 or 2.6 to version 2.7, DB2 associated with the earlier version
might not start if you uninstall IBM Security Key Lifecycle Manager, Version 2.7
before uninstalling the earlier version.

You can uninstall IBM Security Key Lifecycle Manager, Version 2.7 by following
the steps in [“Uninstallation of IBM Security Key Lifecycle Manager” on page 79|
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Optional removal of DB2

After you uninstall IBM Security Key Lifecycle Manager, you have the option of
leaving DB2 installed or uninstalling the program.

Uninstalling IBM Security Key Lifecycle Manager does not uninstall DB2 if it is
installed before you install IBM Security Key Lifecycle Manager. DB2 is uninstalled
when you uninstall IBM Security Key Lifecycle Manager if it is installed by the
IBM Security Key Lifecycle Manager installer. You might also ensure that related
automatic startup services are disabled.

DB2 uninstallation

After uninstalling IBM Security Key Lifecycle Manager, you have the option of
leaving DB2 installed or uninstalling the program.

If you choose to leave DB2 installed, you have the option of keeping or removing
the IBM Security Key Lifecycle Manager DB2 instance owner. Unless you have a
specific reason for keeping the instance owner, such as keeping a connection to a
database, disassociate the user ID from the DB2 database instance. For more
information, see [“Disassociation of a user ID from the DB2 instance” on page 86

If you choose to uninstall DB2, follow these steps:

Windows
Open the Control Panel.

Windows Server 2012: Click Programs and Features. Locate the entry for
DB2, and click Remove to uninstall it.

Note: After uninstalling DB2, extra steps might be required to finish

removing DB2 artifacts.

1. To delete the user ID that was used for the IBM Security Key Lifecycle
Manager DB2 instance owner, open Server Manager and click Tools >
Computer Management > Local Users and Groups > Users.

Review the list of user IDs. If the user ID for the IBM Security Key
Lifecycle Manager DB2 instance owner still exists, delete it.

Close the Computer Management console.

2. Review the entries and verify that the entries for the DB2 ports are
removed from the C:\WINDOWS\system32\drivers\etc\services file. Edit
the file and search for the port numbers that are used by DB2. If any
are found, remove the entries from the file.

3. Open Server Manager and click Tools > Services. Review the list of
services and verify that the DB2 related service entries are removed.
Close the Services console when you are finished.

4. Remove the DB2 installation directory if the directory is not already
removed.

For more information on DB2 uninstallation on Windows systems, see DB2
documentation (http://www-01.ibm.com/support/knowledgecenter /|
ISSEPGG_11.1.0/com.ibm.db2.luw.gb.server.doc/doc/t0007436.html).

AIX and Linux
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1. Log in as the root user.

2. Remove the user ID of the IBM Security Key Lifecycle Manager DB2
instance owner:

a. Change to the user ID of the IBM Security Key Lifecycle Manager
DB2 instance owner, run the db2istop command for the instance
owner user ID and exit back to the root user ID:

su - sklm_instance_owner_userid

cd DB_HOME/instance
./db2istop skim_instance_owner_userid /home/sklm_instance_owner_userid

exit
b. Run the db2idrop command on the instance owner user ID:

cd DB_HOME/instance
./db2idrop skim_instance_owner_userid

c. Remove the user ID from the system:
userdel -r sklm_instance_owner_userid
3. Remove DB2 from the system:

cd DB_HOME/install/
./db2_deinstall -a

4. Edit the services file:

vi /etc/services

Locate the port numbers that are used by DB2, and remove the entries
from the file.

5. Remove the DB2 installation directory if it is not removed.
For more information on uninstalling DB2 on Linux and AIX systems, see

DB2 documentation (http:/ /www-01.ibm.com /support/knowledgecenter /|
[SSEPGG_11.1.0/com.ibm.db2.luw.gb.server.doc/doc/t0007439.html).

The following example shows the steps that are involved, by using the
default DB2 instance owner user ID, skimdb27, and the default DB2
directory, /opt/IBM/DB2SKLMV27.

Starting as root, type:

su - skimdb27

cd /opt/IBM/DB2SKLMV27/instance
./db2istop skimdb27/home/skimdb27
exit

# Exit back to root.

cd /opt/IBM/DB2SKLMV27/instance
./db2idrop skimdb27

userdel -r skimdb27

cd /opt/IBM/DB2SKLMV27/install
./db2_deinstall -a

vi /etc/services

# Locate and remove the DB2 port entries in the services file.
rm -rf /opt/IBM/DB2SKLMV27

Disassociation of a user ID from the DB2 instance

You can disassociate a user ID from the IBM Security Key Lifecycle Manager DB2
instance.

If the user ID is already disassociated from the DB2 instance, a step might return a
message that the user was not found. If you get this message, continue with the
next step.

* Windows systems:
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1. Open the Windows Services console, and stop the DB2 service for the IBM
Security Key Lifecycle Manager instance owner.

To locate the DB2 instance service, search the list of services for services
whose names begin with "DB2." The entry for the instance service contains
the user ID of the IBM Security Key Lifecycle Manager DB2 instance owner
as part of the service name. For example, DB2 - DBSKLMV27 - SKLMDB?27.

Open the properties dialog for the service and set the Service status to
Stopped, and the Startup type to Manual.

2. Click Start > Programs > IBM DB2 > instance_owner > Command Line
Tools > Command Window to open the DB2 Command Window, and enter:

db2idrop db databasename
db2idrop sklm_instance_owner_userid

3. If the C:\sklm_instance_owner_user_id directory still exists, remove it:
del /s /q C:\sklm_instance_owner_user_id
* AIX and Linux systems:
Log in as the root user, and follow these steps.

1. Change to the user ID of the IBM Security Key Lifecycle Manager DB2
instance owner, run the db2istop command for the instance owner user ID
and exit back to the root user ID:

su - sklm_instance_owner_userid
cd DB_HOME/instance
./db2istop sklm_instance_owner_userid /home/sklm_instance_owner_userid
exit
2. Run the db2idrop command on the instance owner user ID:

cd DB_HOME/instance
./db2idrop sklm_instance_owner_userid

3. If the sklm_instance_owner_user_id/sql1ib directory still exists, remove it:
rm -rf skim_instance_owner_user_id/sqllib

Removal of user ID from the DB2 instance owner

To remove the user ID that was used as the IBM Security Key Lifecycle Manager
DB2 instance owner, use the user management utilities of the operating system to
delete the user ID.

Before you delete a user ID that is used as the instance owner for the IBM Security
Key Lifecycle Manager databases, ensure that the user ID is no longer associated
with the DB2 instance.

Follow the steps in [“Disassociation of a user ID from the DB2 instance” on page
If the user ID is already disassociated from the DB2 instance, a step might
return a message that the user was not found. If this message, continue with the
next step.

After verifying that the user ID is not associated with the DB2 database instance,
follow these steps to remove the user ID from the system:

* Windows systems:

Use the user management tool for the version of Windows you are running to
delete the DB2 administrative user from the system. For example, on some
versions of Windows, carry out these steps:

1. Open the Control Panel.
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2. Click Administrative tools > Computer Management > Local Users and
Groups > Users.

3. Delete the user from the system.

* AIX and Linux systems:
Log in as the root user, and enter this command to remove the user ID:
userdel -r sklm_instance_owner_userid

Disablement of automatic services
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The IBM Security Key Lifecycle Manager uninstall process disables the DB2 and
WebSphere Application Server services that are associated with IBM Security Key
Lifecycle Manager. To correct error conditions, you might also want to ensure that
these services are disabled.

Windows systems

On Windows systems, use the Windows Services console to prevent the DB2 and
WebSphere Application Server services that are associated with IBM Security Key
Lifecycle Manager from starting automatically.

Open the Windows Services console and locate the services in the following list.
For each service in the list, open the Properties dialog box for the service, and
ensure that the Startup Type is set to Disabled, and the Service status field is set
to Stopped.

DB2 - db2 copy name - SKLM_INSTANCE_OWNER
For example, DB2 - DBSKLMV27 - SKLMDB27

DB2 Governor (db2 copy name)
For example, DB2 Governor (DBSKLMV27)

DB2 License Server (db2 copy name)
For example, DB2 License Server (DBSKLMV27)

DB2 Management Service (db2 copy name)
For example, DB2 Management Service (DBSKLMV27)

DB2 Remote Command Server (db2 copy name)
For example, DB2 Remote Command Server (DBSKLMV27)

DB2DAS - DB2DAS_entry
For example, DB2DAS - DB2DAS00

Note: Disable DB2 Administration Server (DAS) only if DAS service is
hosted in Windows service.

AIX and Linux systems

On AIX or Linux systems, enter the following commands to configure the IBM
Security Key Lifecycle Manager DB2 instance owner so that it does not start
automatically:

. “skimdb2/sq11ib/db2profile
DB_HOME/instance/db2iauto -off skimdb27

Where skimdb2 is the default instance owner user ID. If you changed it during
installation, use that user ID instead.
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Next, edit the /etc/inittab file and remove the entry that autostarts the
WebSphere Application Server server:

/opt/IBM/WebSphere/AppServer/bin/startServer.sh serverl
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Installation and migration log files

If the installation or migration encounters an unexpected error condition, use the
log files to determine the cause of the problem.

Background information

The installation program uses several subprograms, components, and subsystems
during installation. Many error conditions occur because a subprogram fails.

Installation subprograms, components, and systems

You might see these names or abbreviations in the log files:
* DB2
* IBM Installation Manager

Installation phases

Error conditions that occur and the log files available to you depend on the phase
in which the error occurred:

1. Introductory that includes panels for language selection, details of the packages
to be installed, and the license agreement. The installation program also runs a
system prerequisites check to verify the minimum requirements to install the
product.

2. DB2 installation that includes panels to gather information for installing DB2.
After you enter the information, the installation program installs DB2.

3. Middleware installation that includes panels that gather information to install
WebSphere Application Server middleware. After you enter the information, the
installation program installs the middleware.

IBM Security Key Lifecycle Manager is installed during this phase.

Important log files and locations

The installation of IBM Security Key Lifecycle Manager and its components
generates log files that you can read to ensure that the installation is completed
successfully. The installation error logs provide critical information.

The following table list the log files and the file locations that are generated when
you use the default installation settings.
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Table 12. Location of installation log files

Log File

Description

Location

db2_install.log

DB2 installation log file.

Windows systems
drive:\<IM App Data
Dir>\1ogs\skimLogs\

C:\ProgramData\IBM\
Installation
Manager\logs\sklmLogs\

Linux systems
/<IM App Data
Dir>/1ogs/skimLogs/

/var/ibm/InstallationManager/
Togs/skimLogs/

db_config.Tog

Contains information
about IBM Security Key
Lifecycle Manager
database creation and
table creation.

Windows systems
drive:\<IM App Data
Dir>\Togs\skimLogs\

C:\ProgramData\IBM\
Installation
Manager\logs\skIimLogs\

Linux systems
/<IM App Data
Dir>/1ogs/skimLogs/

/var/ibm/InstallationManager/
Togs/sklmLogs/

Various *.xml and
*,1og files

IBM Security Key
Lifecycle Manager
installation log files.

You can verify the
installation, modification,
or uninstallation of IBM
Security Key Lifecycle
Manager by checking the
log file that the IBM

Windows systems
drive:\<IM App Data Dir>\logs\

C:\ProgramData\IBM\
Installation Manager\logs\

Linux systems
/<IM App Data Dir>/1ogs/

/var/ibm/InstallationManager/

*.err files

files that are generated
during installation.

The .err file sizes are
zero bytes if the
operation they represent
was successful. Examine
error files with sizes
greater than zero.

. logs/
Installation Manager
creates.
Various *.out and STDOUT and STDERR .
Windows

WAS_HOME\Togs\

C:\Program Files\IBM\
WebSphere\AppServer\logs\

WAS_HOME/10gs/

/opt/1BM/WebSphere/AppServer/
Tog/

Linux
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Table 12. Location of installation log files (continued)

Log File

Description

Location

migration.log

After you migrate
existing data (earlier
version) into the new
installation, you can
review the migration log
file to verify whether the
process was successful,
or for troubleshooting
purposes.

Windows systems
drive:\<IM App Data
Dir>\1ogs\skimLogs\

C:\ProgramData\IBM\
Installation
Manager\logs\sklmLogs\

Linux systems
/<IM App Data
Dir>/1ogs/skimLogs/

/var/ibm/InstallationManager/
Togs/skimLogs/

skimInstall*.log

IBM Security Key
Lifecycle Manager
installer log files.

Windows
%temp%/skimInstallerx.log*

(precheck.1og) and for
the results of the scan
(results.txt).

Linux ${TMPDIR}/skimInstaller=.log
The log files are created
when each step of the
installation is run. You
can read these log fines
to verify whether the
product is installed
successfully.
Log files in skImPRS | The skimPRS folder .
. . Windows
contains log files for Stemns/sk1mPRS/
detailed output of the sLemps
prerequisite scan activity |Linux ${TMPDIR}/PRS/

Log files to troubleshoot problems

The timing of an error can provide an idea of which log file to use first. The two
places an error might occur are immediately after the DB2 phase, and immediately
after the middleware phase. Use this list to determine where to start.

During or immediately after the DB2 installation phase

1. If the error occurs early enough, you might want to check the db2_install.log,
prsResults.xml, and skimInstallerx.log files.

2. If the error occurs later during this phase, the skImV27properties directory
might contain results of some of the DB2 configuration, or results from the
other subprograms that run during this phase.

3. The location of the error log file can vary depending on whether the error
occurs during the DB2 phase, or at the end of the DB2 phase.

At the end of the DB2 phase, the log files are copied from the
skImV27properties directory to the <IM App Data Dir>\1ogs\sklmLogs directory.

See [Table 12 on page 92| for the location of the files.
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During or immediately after WebSphere Application Server
installation phase

The log files to examine for errors are db_config.log and skimInstallerx.log files.

Migration log file names and location

During the migration process, the migration program creates log files when it calls
other programs or tools.

After you upgrade IBM Security Key Lifecycle Manager, and migrate your existing
data into the new installation, you can review the migration.log file to verify
whether the process was successful, or for troubleshooting purposes.

Windows systems
drive:\<IM App Data Dir>\1ogs\skIimLogs

For example: C:\ProgramData\IBM\Installation Manager\logs\skimLogs\
migration.log

Linux systems
/<<IM App Data Dir>>/Togs/skimLogs

For example: /var/ibm/InstallationManager/logs/skimLogs/migration.log

Examining an error log file

IBM Security Key Lifecycle Manager generates several log files that you can use to
troubleshoot problems that occur when you install and configure IBM Security Key
Lifecycle Manager.

Procedure

1. Review the list of log files. The log file to start with depends on the operating
system and the phase of the installation. The list in [“Log files to troubleshoot|
[problems” on page 93| can provide a starting point. You might examine several
log files before you find the one with the error messages.

2. Go to the directory with the log file, and open it with a text editor. On a
Windows system, use a text editor that can process UNIX-style newline
characters, such as Microsoft WordPad.

3. The most recent log entries are at the end of the file. Starting at the last entry in
the log file, examine each entry. Take note of the program that is involved and
the time stamp of the entry if it has one.

After the final entry is reviewed, look at the entry before it. Review this entry
as you did the previous entry. Scan for anything that is mentioned in both
places such as file names or error conditions.

Repeat the previous step, moving upward in the log file. There might be
several entries with information that is related to the error condition. If the
information in this log file is insufficient, look for more information in another
log file.

If there are no messages about an error, go to another log file.

Other information to gather

You must run several actions that might provide more information to verify
installation.
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Check your free disk space. See [“Hardware requirements” on page 7| for
minimum space requirements.

See whether the DB2 instance is created. If so, this validates the DB2 installation.
To verify that the DB2 instance was created, log in as the IBM Security Key

Lifecycle Manager DB2 instance owner, go to the DB_INSTANCE_HOME
directory, and run:

db2ilist

A list of the configured instances is displayed. The instance name for IBM
Security Key Lifecycle Manager such as skimdb27 is typically in the list.

Start and stop the IBM Security Key Lifecycle Manager database server by using
the instance owner user ID. This validates the database creation.

To start and stop the database, log in as the IBM Security Key Lifecycle Manager
DB2 instance owner, go to the DB_LINSTANCE_HOME directory, and run the
db2start and db2stop commands on the database.

Display a list of the tables in the DB2 database. This validates the Dynamic Data
Language process.

To display the list of tables, log in as the IBM Security Key Lifecycle Manager
DB2 instance owner, go to the DB_INSTANCE_HOME directory, and run these
commands:

db2 connect to sklm_database user sklm_instance_owner_userid \
using sklm_instance_owner_passwd

db2 T1ist tables

db2 describe table table_name

Determine whether the Java process for WebSphere Application Server is
running. A running process validates the WebSphere Application Server
installation.

To determine whether the Java process is running, stop and restart the server by
going to the WAS_HOME/bin directory and running these commands:

stopServer.sh serverl
startServer.sh serverl

If global security is enabled, add these parameters to the commands to stop and
restart your server:

-username was_admin_id -password was_admin_passwd

On Windows systems, you can also open the Windows Services console and
verify that the service for the KLMProfile is started.

Start the IBM Security Key Lifecycle Manager application to validate the IBM
Security Key Lifecycle Manager installation and the overall installation.

To start the IBM Security Key Lifecycle Manager application, start the
WebSphere Application Server, and look for the IBM Security Key Lifecycle
Manager task.
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Installation error messages

Messages indicate events that occur during the operation of the system. Depending
on the outcome of an operation, IBM Security Key Lifecycle Manager provides an
informational, warning, or error message.

Message format

Messages that are logged by IBM Security Key Lifecycle Manager adhere to the
Tivoli Message Standard. Each message consists of a message identifier (ID) and
accompanying message text.

Messages have the following syntax:

CTGUUXXXXZ
where:
CTG Identifies the IBM Security Key Lifecycle Manager product.
[8]8) Identifies the component or subsystem of IBM Security Key Lifecycle
Manager. For example:
KM  IBM Security Key Lifecycle Manager server messages.
KO Password policy messages.
KS IBM Security Key Lifecycle Manager key server messages.
XXXX Indicates serial or message number, such as 0001.
V4 One-character type code indicates the severity of the message:

* I for informational message
* W for warning message

* E for error message

For example:

CTGKMO545E: An error occurred exporting a certificate.

Error and warning messages

IBM Security Key Lifecycle Manager generates error and warning messages that
are based on the action you take.

CTGKM9002E The administrator ID must be eight
characters or less.

Explanation: The user ID is restricted to a maximum
length of eight characters.

System action: Installation cannot continue until you
correct the error.

User response:
characters or less.

Select a different user ID that is eight

CTGKM9003E The administrator ID must begin with
an alphabetic character.

Explanation: The user ID must start with a letter.

Additionally, the user ID can only use alphabetical
characters, numeric characters, and the underscore
(A-Z, a-z, 0-9, and ).

System action: Installation cannot continue until you
correct the error.

User response: Select a different user ID that starts
with a letter.
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CTGKM9004E « CTGKM9044lI

CTGKM9004E The administrator ID cannot begin
with: ibm, sql, or sys.

Explanation: The administrator user ID cannot start
with ibm, sql, or sys.

System action: Installation cannot continue until you
correct the error.

User response: Select a different user ID that does not
start with one of the restricted strings.

CTGKM9005E The administrator ID cannot be: db2,
users, admins, guests, public, private,
properties, local, or root.

Explanation: DB2 reserved keywords cannot be used
as an administrator user ID.

System action: Installation cannot continue until you
correct the error.

User response: Select a different user ID that is not a
DB2 keyword.

CTGKM9006E The administrator ID is a required
field.

Explanation: You must specify an administrator user
1D.

System action: Installation cannot continue until you
enter a value in the field.

User response: Enter a user ID in the Administrator
ID field.

CTGKM9007E The password is a required field.
Explanation: You must specify a password.

System action: Installation cannot continue until you
enter a value in the field.

User response: Enter a password for the user ID.

CTGKM9010E The password confirmation field is
required.

Explanation: You must specify a password.

System action: Installation cannot continue until you
enter a value in the field.

User response: Enter a password for the user ID.

CTGKM9011E The database home is a required
field.

Explanation: You must specify the database home
directory.

System action: Installation cannot continue until you
enter a value in the field.
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User response: Enter the directory in which to store
the database files.

CTGKM9012E The database name is a required
field.

Explanation: You must specify a name for the
database.

System action: Installation cannot continue until you
enter a value in the field.

User response: Enter a name for the database.

CTGKM9037E The port number must be a positive
integer among 443, 80, or between 1024
and 65536.

System action: Installation cannot continue until you
correct the error.

User response: Enter a port number that is among
443, 80, or between 1024 and 65536.

CTGKM9038E The port is a required field.
Explanation: You must specify a port.

System action: Installation cannot continue until you
enter a value in the field.

User response: Enter a port number.

CTGKM9041E The password and password
confirmation fields do not match.
Reenter matching passwords for these
two fields.

Explanation: The passwords in both fields must
match.

System action: Installation cannot continue until you
correct the error.

User response: Re-enter the values in the fields.

CTGKM9042I Passwords cannot contain spaces.

Explanation: Passwords can only contain
alphanumeric characters and the underscore (a-z, A-Z,
0-9, and _).

System action: Installation cannot continue until you
correct the error.

User response: Enter a different password that
conforms to the rules.

CTGKM90441 The Administrator ID cannot be an
SQL reserved word.

Explanation: The Administrator ID cannot be an SQL
reserved word.



System action: Installation cannot continue until you
correct the error.

User response: Enter a different value for the
Administrator ID.

CTGKM90491 The Windows DB2 DB Home field
must be a drive letter [A-Z] followed by
a colon.

Explanation: On Windows systems, you must select
the drive on which to install the IBM Security Key
Lifecycle Manager database. A Windows drive indicator
is a letter, following by a colon (:). For example, C:.

System action: Installation cannot continue until you
correct the error.

User response: Enter a correctly formatted drive letter.

CTGKM9050E The DB Name must be 8 characters or
less.

Explanation: The DB Name must be 8 characters or
less.

System action: Installation cannot continue until you
correct the error.

User response: Select a different name.

CTGKM9050I The Windows DB2 DB Home field
must be a drive letter that can be
written to.

Explanation: The drive must be writable for
installation to proceed.

System action: Installation cannot continue until you
correct the error.

User response: Use the operating system utilities to
make the drive writable, or select a different drive.

CTGKM9051E The DB Name cannot contain special
characters.

Explanation: The name contains one or more incorrect
characters.

User response: Reenter the name and try again.

CTGKM9052E The DB Name must begin with an
alphabetic character.

Explanation: The DB Name can only use alphabetical
characters, numeric characters, and the underscore
(A-Z, a-z, 0-9, and _).

System action: Installation cannot continue until you
correct the error.

User response: Select a different name.

CTGKM9049] « CTGKM9058E

CTGKM9053E The DB2 version currently selected
for use is not supported. The supported
version is 11.1 and above.

Explanation: IBM Security Key Lifecycle Manager
requires a supported version of DB2.

System action: The installation task fails.

User response: Obtain a supported version of DB2.
Try again.

CTGKM9054E The location specified is not a valid
DB2 installation directory

Explanation: The specified directory does not contain
the existing DB2 installation.

User response: Select a valid DB2 installation
directory.

CTGKM9055E The user name/password fields
cannot have more than {0} characters.

Explanation: The value you specified exceeds the
maximum length.

System action: Installation cannot continue until you
correct the error.

User response: Specify a value that does not exceed
the limit. Then, try the operation again.

CTGKM9056E Password and the confirmation does
not match for {0}.

Explanation: The Password and Confirm Password
fields must have the same value.

System action: Installation cannot continue until you
correct the error.

User response: Specify the same value for the
Password and Confirm Password fields, and try the
operation again.

CTGKM9057E The Application Server Administrator
Confirm Password field is empty.

Explanation: User has not specified the password
confirmation value.

System action: Installation cannot continue until you
correct the error.

User response: Enter a value in the Confirm Password
field. Try again.

CTGKM9058E The Application Server Administrator
User field is empty.

Explanation: This message is displayed when the
Application Server Administrator User field is empty.
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System action: Installation cannot continue until you
correct the error.

User response: Specify a value and try again.

CTGKM9059E The IBM Security Key Lifecycle
Manager Administrator User field is
empty.

Explanation: This message is displayed when the IBM
Security Key Lifecycle Manager Administrator User
field is empty.

System action: Installation cannot continue until you
correct the error.

User response: Specify a value and try again.

CTGKM9060E The user name field cannot contain
any special characters.

Explanation: The user name contains one or more
incorrect characters.

System action: Installation cannot continue until you
correct the error.

User response: Reenter the user name with valid
characters and try again.

CTGKM9061E The port specified is already in use.

Explanation: The port number that is entered must be
available for use. The port number is already in use.

System action: Installation cannot continue until you
correct the error.

User response: Select another port number. Ensure
that the specified port number is available.

CTGKM9062E The IBM Security Key Lifecycle
Manager Administrator Password field
is empty.

Explanation: This message is displayed when the IBM
Security Key Lifecycle Manager Administrator
Password field is empty.

System action: Installation cannot continue until you
correct the error.

User response: Specify a value and try again.

CTGKM9063E The Application Server Administrator
Password field is empty.

Explanation: This message is displayed when the
Application Server Administrator Password field is
empty.

System action: Installation cannot continue until you
correct the error.

User response: Specify a value and try again.
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CTGKM9064E The Encryption Key Manager
Property File field is empty.

Explanation: This message is displayed when the
Encryption Key Manager Property File field is empty.

System action: Installation cannot continue until you
correct the error.

User response: Specify a value.

CTGKM9065E The IBM Security Key Lifecycle
Manager Administrator Confirm
Password field is empty.

Explanation: User has not specified the password
confirmation value.

System action: Installation cannot continue until you
correct the error.

User response: Specify a value and try again.

CTGKM9066E IBM Security Key Lifecycle Manager
Application Port Number is empty.

Explanation: This message is displayed when the IBM
Security Key Lifecycle Manager Application Port
Number field is empty.

System action: Installation cannot continue until you
correct the error.

User response: Specify a value and try again.

CTGKM9067E The password for Database
Administrator field is empty.

Explanation: This message is displayed when the
password field for Database Administrator field is

empty.

System action: Installation cannot continue until you
correct the error.

User response: Specify a value and try again.

CTGKM9068E The password for keystore is empty.

Explanation: You must specify a password for the
keystore.

User response: Specify a password for the keystore
and try again.

CTGKM9069E The user name {0} or password is not
valid.

Explanation: The operation requires a valid user name
and password.

System action: The operation fails.

User response: Specify a valid user name and
password. Then, try again.



CTGKM9070E The credentials could not be validated
at the moment.

Explanation: The specified credentials might be
incorrect.

System action: Installation cannot continue until you
correct the error.

User response: Refer to the WebSphere Application
Server logs for more information and correct the
problem.

CTGKM9071E The WebSphere Application Server
instance could not be started.

Explanation: The WebSphere Application Server
instance could not be started.

System action: Installation cannot continue until you
correct the error.

User response: Refer to the WebSphere Application
Server logs for more information and correct the
problem.

CTGKMO9072E The DB2 installation details file {0}
cannot be found.

Explanation: The DB2 instance data file was not
found.

System action: Installation cannot continue until you
correct the error.

User response: Ensure that the following files exist.

Windows systems
The db2srcit.txt file under the following
directories:
e C:\tkimtemp

e C:\skImV27properties
Linux and AIX systems
Check for the missing properties in the

db2unix.srcit file under the following
directories:

e /tkimtemp
* /root/skimV27properties

CTGKM9073E DB2InstallResponseUpdater requires
minimum {0} parameters. Only had {1}
parameters.

Explanation: The installer is not passing in the correct
parameters for a binary which it is trying to execute.
This is an internal error which cannot be resolved by
the Installation Manager.

System action: The installation fails.

User response: Identify the package that has the issue
by looking at the installation history. In Installation
Manager, click File > Installation History. In console

CTGKM9070E « CTGKM9078E

mode, enter S on the main menu to select “View
Installation History”. Contact IBM customer support.

CTGKM9074E File {0} does not exist.

Explanation: A binary which the installer is executing
is attempting to access a file which does not exist. This
is an internal error which cannot be resolved by the
Installation Manager.

System action: The installation fails.

User response: Identify the package that has the issue
by looking at the installation history. In Installation
Manager, click File > Installation History. In console
mode, enter S on the main menu to select “View
Installation History”. Contact IBM customer support.

CTGKM9075E File {0} is not writable.

Explanation: A binary which the installer is executing
is attempting to modify a read-only file. This is an
internal error which cannot be resolved by the
Installation Manager.

System action: The installation fails.

User response: Identify the package that has the issue
by looking at the installation history. In Installation
Manager, click File > Installation History. In console
mode, enter S on the main menu to select “View
Installation History”. Contact IBM customer support.

CTGKM9076E The specified path for existing DB2
installation is not valid.

Explanation: The specified path for existing DB2
installation is incorrect.

System action: Installation cannot continue until you
correct the error.

User response: Specify the correct path. Then, try
again.

CTGKM9077E The response file object is null.
Explanation: You must specify the response file.

User response: Specify a value. Then, try again.

CTGKM9078E {0} requires {1} parameters. Only had
{2} parameters.

Explanation: The installer is not passing in the correct
parameters for a binary which it is trying to execute.
This is an internal error which cannot be resolved by
the Installation Manager.

System action: The installation fails.

User response: Identify the package that has the issue
by looking at the installation history. In Installation
Manager, click File > Installation History. In console
mode, enter S on the main menu to select “View
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Installation History”. Contact IBM customer support.

CTGKM9079E The file/folder specified by the path
{0} does not exist on the file system.

Explanation: A binary which the installer is executing
is attempting to access a file which does not exist. This
is an internal error which cannot be resolved by the
Installation Manager.

System action: The installation fails.

User response: Identify the package that has the issue
by looking at the installation history. In Installation
Manager, click File > Installation History. In console
mode, enter S on the main menu to select “View
Installation History”. Contact IBM customer support.

CTGKM9080E IBM Tivoli Key Lifecycle Manager
server version {0} has been detected on
the system. This version cannot be
upgraded to v2.6. To continue with the
installation, upgrade IBM Tivoli Key
Lifecycle Manager to version {1}.

Explanation: The installation fails.

System action: Installation cannot continue until you
correct the error.

User response: Upgrade IBM Tivoli Key Lifecycle
Manager to the supported version.

CTGKM9081E Error while executing the command
{0}

Explanation: There was a problem when running the
specified command.

System action: The installation fails.

User response: Check the Installation Manager log
files and take necessary corrective actions. Then, try
again.

CTGKM9082E Cannot find a running process for the
server.

Explanation: There was a problem when trying to
stop WebSphere Application Server.

System action: The installation fails.

User response: Manually start the server and try
again.

CTGKM9083E Unable to determine the install
location for WebSphere Application
Server v8.5.

Explanation: The Installer could not identify the
location of WebSphere Application Server, version 8.5.

System action: The installation fails.
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User response: Uninstall Installation Manager and
rerun the installation process.

CTGKM9084E Invalid DB2 installation details file.
Cannot find an entry for {0}.

Explanation: The details present in the DB2 instance
data file is incorrect.

System action: The installation fails.
User response:

Windows systems
Check for the missing properties in the
db2srcit.txt file under the following
directories:
+ C:\tkimtemp

e C:\skimV27properties

Linux and AIX systems
Check for the missing properties in the
db2unix.srcit file under the following
directories:
e /tkImtemp

e /root/skimV27properties

CTGKM9085E The DB2 installation details file {0}
cannot be found.

Explanation: The DB2 instance data file was not
found.

System action: Installation cannot continue until you
correct the error.

User response: Ensure that the following files exist.

Windows systems
The db2srcit.txt file under the following
directories:
e C:\tkimtemp

* C:\skimV27properties
Linux and AIX systems
Check for the missing properties in the

db2unix.srcit file under the following
directories:

e /tkimtemp
« /root/skimV27properties

CTGKM9086E No WebSphere Application Server
installation found in the registry.

Explanation: Instance of the WebSphere Application
Server, version 8.5 was not found in the install registry.

System action: Installation cannot continue until you
correct the error.

User response: Uninstall Installation Manager and
rerun the installation program.



CTGKM9087E « CTGKM9096E

CTGKM9087E Could not load data from the ports
definition file {0}.

Explanation: The ports definition file for the
WebSphere Application Server could not be read.

System action: Installation cannot continue until you
correct the error.

User response: Clean up any existing installation and
rerun the installation program.

CTGKM9088E The ports definition file {0} does not
contain the required keys - {1}.

Explanation: Details in the ports definition file is
incorrect.

System action: Installation cannot continue until you
correct the error.

User response: Clean up any existing installation and
rerun the installation program.

CTGKM9089E Could not get the key store file
location.

Explanation: Keystore location was not found.
System action: Installation fails.

User response: Make sure that the Tivoli Key Lifecycle
Manager database is up and running and rerun the
installation program.

CTGKM9090E IBM DB2 and IBM WebSphere
Application Server offerings must be
selected for IBM Security Key Lifecycle
Manager installation to proceed. Go
back to the previous screen and select
IBM DB2 V11.1 and IBM WebSphere
Application Server V9.0 offerings.

Explanation: The details that you specified are
incorrect.

User response: Specify the correct values.

CTGKM9091E IBM DB2 and IBM WebSphere
Application Server offerings associated
with IBM Security Key Lifecycle
Manager must be selected for IBM
Security Key Lifecycle Manager
uninstallation to proceed. Go back to
the previous screen and select IBM DB2
V11.1 and IBM WebSphere Application
Server V9.0 offerings.

Explanation: The details that you specified are
incorrect.

System action: Uninstallation cannot continue until
you correct the error.

User response: Specify the correct values.

CTGKM9092E One or more prerequisites failed to
meet the requirements. The report is
given below.

Explanation: The prerequisite requirements for the
installation are not met. All prerequisites must be
satisfied for the installation.

System action: Installation cannot continue until you
correct the error.

User response: Take corrective actions to meet the
requirements. Then, try again.

CTGKM9093E None of the drives on the system has
the required space ({0}) to install the
product.

Explanation: The minimum space to install the
product is not available in the system.

System action: Installation cannot continue until you
correct the error.

User response: Increase the amount of space available
on the specified drive to the minimum required. Then,
try again.

CTGKM9094E Unable to read the prerequisite
scanner results.

Explanation: The prerequisite output file was not
found after Prerequisite Scanner is run.

System action: Installation cannot continue until you
correct the error.

User response: Rerun the installation without deleting
any files from the system.

CTGKM9095E The password does not meet the
operating system password policy
requirements. Check the minimum
password length and password
complexity requirements.

Explanation: The password the you specified violates
the password rules.

System action: The password is not updated on the
server.

User response: Check the minimum password length,
password complexity and password history
requirements.

CTGKM9096E The credentials provided for
WebSphere Application Server
Administrator is not valid.

Explanation: Incorrect credentials are specified for the
WebSphere Application Server administrator.

System action: Installation cannot continue until you
correct the error.
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CTGKM9099E « CTGKM9106E

User response: Specify the correct user name and
password for WebSphere Application Server
administrator. Then, try again.

CTGKM9099E WebSphere Administrator credentials
are required to proceed with
uninstallation.

Explanation: The user name or password for
WebSphere Application Server is not specified or
incorrect.

User response: Specify the correct user name and
password for the WebSphere Application Server
administrator and then try again.

CTGKM9100E DB?2 installation details file {0} cannot
be found

Explanation: The DB2 instance data file was not
found.

System action: Installation cannot continue until you
correct the error.

User response: Ensure that the following files exist.

Windows systems
The db2srcit.txt file under the following
directories:
o C:\tkimtemp

* C:\skImV27properties
Linux and AIX systems
Check for the missing properties in the

db2unix.srcit file under the following
directories:

e /tkimtemp
* /root/skimV27properties

CTGKM9101E The path "<Variable
formatSpec="{0}'"'>VALUE_0</Variable>"
is either on a network file system or not
writable. Select a local file system path
for installation.

Explanation: The installation is attempted on a

location that is not on the local hard disk of the system.

System action: Installation cannot continue until you
correct the error.

User response: Change the installation path and
specify a local path on the system.

CTGKM9102E The path "<Variable
formatSpec="{0}">VALUE_0</Variable>"
is either on a network drive or not
writable. Select a local drive for
installation.

Explanation: The installation is attempted on a

location that is not on the local hard disk of the system.
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System action: Installation cannot continue until you
correct the error.

User response: Change the installation path and
specify a local path on the system.

CTGKM9103E Unable to find the location of
prerequisite scanner tool.

Explanation: Location of Prerequisite Scanner was not
found.

System action: Installation cannot continue until you
correct the error.

User response: Rerun the installation without deleting
any files from the system.

CTGKM9104E Required permission is not available
on {0} to perform the installation.

Explanation: You might not have the read, write, and
execute permissions to the installation directories.

System action: Installation cannot continue until you
correct the error.

User response: Verify permissions to the installation
directories for performing installation of each
component of IBM Security Key Lifecycle Manager and
try the installation again.

CTGKM9105E Java TEMP location and environment
variable TEMP location are different.
The location paths must be same.

Explanation: Java temporary directory location and
the TEMP environment variable location might not be
same.

System action: Installation cannot continue until you
correct the error.

User response: Ensure that the location paths for Java
temporary directory and the TEMP environment
variable are same.

CTGKM9106E DB2 installation path must not
contain spaces.

Explanation: DB2 installation path cannot contain a
space character.

System action: Installation cannot continue until you
correct the error.

User response: Ensure that the installation path does
not contain space characters and try the installation
again.




CTGKM9107E {0} environment variable not set OR is
null, please set the environment
variable to proceed further.

Explanation: The TEMP (Windows) or TMPDIR (Linux)
environment variable is not set or empty.

System action: Installation cannot continue until you
correct the error.

User response: Ensure that the environment variable
value is set to a valid temporary directory, for example
TMPDIR=/tmp.

CTGKM9108E The port FCM_PORT_NUMBER {0}
that is required for DB2 installation is
in use. Release the port to continue with
the installation.

System action: Installation cannot continue until you
correct the error.

User response: Release the port by stopping the
application, which is using this port. Then, try the
installation again.

CTGKM9109E Port number {0} is in conflict with
FCM_PORT_NUMBER value. Choose a
different port and try again.

System action: Installation cannot continue until you
correct the error.

User response: Specify a valid port, which does not
cause a port conflict. Then, try the installation again.

CTGKM9110W IBM Security Key Lifecycle Manager
is being installed on an unsupported
operating system.

User response: Ensure you are running on a
supported operating system. For a list of supported
operating systems, see the IBM Security Key Lifecycle
Manager product documentation in IBM Knowledge
Center.

CTGKM9111W The product installer cannot detect
the operating system on the host.

User response: Ensure you are running on a
supported operating system. For a list of supported
operating systems, see the IBM Security Key Lifecycle
Manager product documentation in IBM Knowledge
Center.

CTGKM9112E You must specify different port
numbers.

Explanation: Port numbers that are mentioned on the
form must not be the same.

System action: Installation cannot continue until you
correct the error.

CTGKM9107E » CTGKM9116E

User response: Ensure that the port numbers are
different and try the installation again.

CTGKM9113E The port {0} is in conflict with DB2
port. Choose a different port to proceed
with the installation.

Explanation: Selected value for the port is in conflict
with the DB2 port.

System action: Installation cannot continue until you
correct the error.

User response: Specify a free port and try the
installation again.

CTGKM9114E Ports 441, 5696, 3801 are reserved for
other services. Specify a different port to
continue with the installation.

Explanation: Selected value for the port is reserved for
another service.

System action: Installation cannot continue until you
correct the error.

User response: Check to ensure that the port value is
not reserved for any other services.

CTGKM9115E Unable to create the port definition
property file.

Explanation: Unable to modify the portsDef.props file
with the port number settings for WebSphere
Application Server profile creation.

System action: Installation cannot continue until you
correct the error.

User response: Check for the following information
and try the installation:

* Check that you have the read, write, and execute
permission to the TEMP (Windows) and $HOME (Linux)
location.

* Ensure that the property file with the same name
does not exist.

* Ensure that the file is not in use by another program.

CTGKM9116E The password must be different from
the user name. Specify a different
password.

Explanation: A password cannot be the same as your
user name or user ID.

System action: Installation cannot continue until you
correct the error.

User response: Enter a different password that
conforms to the rules and try again.
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Sample response files

You might want to use sample response files for Windows and other systems.
Before installation, you must also read and agree to the license terms for this
product. To locate the response files and license term files, look in the root
directory of the installation image files. The /1icense subdirectory has the license
files in text format.

Installation fails unless you take these steps.

In the response file, make following changes to the line that specifies the license:

* Set the default value to true to indicate that you agree with the terms of the
license.

* Uncomment the line by removing the pound sign (#) character at the beginning
of the line.

New installation of version 2.7 on Windows systems

The example response file contains responses for an installation of IBM Security
Key Lifecycle Manager, Version 2.7 onto a Windows system or an installation in
which Encryption Key Manager migration occurs.

<?xml version='1.0' encoding='UTF-8'?>
<agent-input acceptlLicense='true' clean='true' >

<server>

<repository location='C:\diskl\im'/>
<repository location='C:\diskl\'/>
</server>
<profile id='IBM Installation Manager' installlLocation='C:\Program Files\IBM\Installation Manager\eclipse' kind='s

<data
<data
<data
<data
<data

key="eclipselLocation' value='C:\Program Files\IBM\Installation Manager\eclipse'/>
key="user.import.profile' value='false'/>

key='cic.selector.os' value='win32'/>

key='cic.selector.arch' value='x86_64'/>

key='cic.selector.ws' value='win32'/>

</profile>

<install modify='false'>
<offering profile='IBM Installation Manager' id='com.ibm.cic.agent' features='agent_core,agent_jre,agent_web' in
<offering profile='IBM DB2 SKLM27' id='com.ibm.skim27.db2.win.ofng' features='main.feature' installFixes='none'/:
<offering profile='IBM WebSphere Application Server V9.0' id='com.ibm.websphere.BASE.v90' features='core.feature

embeddablecontainer' installFixes="'none'/>

<offering profile='IBM WebSphere Application Server V9.0' id='com.ibm.java.jdk.v8' features='com.ibm.sdk.8' inst
<offering profile='IBM Security Key Lifecycle Manager v2.7' id='com.ibm.skim27.win' features='main.feature' inst

</install>

<profile id='IBM DB2 SKLM27' installLocation='C:\Program Files\IBM\DB2SKLMV27'>

<data
<data
<data
<data
<data
<data
<data
<data
<data
<data
<data
<data
<data
<data

key="eclipselLocation' value='C:\Program Files\IBM\DB2SKLMV27'/>

key="user.import.profile' value='false'/>

key='cic.selector.os' value='win32'/>

key='cic.selector.arch' value='x86_64'/>

key='cic.selector.ws' value='win32'/>

key="'user.DB2_ADMIN_ID,com.ibm.sk1lm27.db2.win.ofng' value='skimdb27'/>
key="user.DB2_ADMIN_PWD,com.ibm.skim27.db2.win.ofng' value='m4oQ5vWqvwGUw0OgZaAiFqg=="/>
key="user.CONFIRM_PASSWORD,com.ibm.skim27.db2.win.ofng' value='mdoQ5vWqvwGUwOgZaAiFqg=="/>
key="'user.DB2_DB_HOME,com.ibm.skim27.db2.win.ofng' value='C:'/>
key="'user.DB2_DB_NAME,com.ibm.sk1m27.db2.win.ofng' value='SKLMDB27'/>
key="'user.DB2_DB_PORT,com.ibm.skim27.db2.win.ofng' value='50030"'/>
key="user.DB2_EXISTS,com.ibm.skim27.db2.win.ofng' value='false'/>
key="user.DB2_LOCATION,com.ibm.sk1m27.db2.win.ofng' value='C:\\Program Files\\IBM\\DB2SKLMV27"'/>
key='cic.selector.nl' value='en'/>

</profile>

<profile id="'IBM WebSphere Application Server V9.0' installlLocation='C:\Program Files\IBM\WebSphere\AppServer'>

<data
<data
<data
<data
<data

key='eclipselLocation' value='C:\Program Files\IBM\WebSphere\AppServer'/>
key="'user.import.profile' value='false'/>

key='cic.selector.os' value='win32'/>

key='cic.selector.arch' value='x86_64'/>

key='cic.selector.ws' value='win32'/>
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<data key='cic.selector.nl' value='en'/>

</profile>

<profile id="IBM Security Key Lifecycle Manager v2.7' installlLocation="'C:\Program Files\IBM\SKLMV27'>
<data key='eclipselLocation' value='C:\Program Files\IBM\SKLMV27'/>
<data key='user.import.profile' value='false'/>
<data key='cic.selector.os' value='win32'/>
<data key='cic.selector.arch' value='x86_64'/>
<data key='cic.selector.ws' value='win32'/>
<data key='user.IS_SILENT_MODE,com.ibm.skim27.win' value='false'/>
<data key='user.EKM_PROPFILE,com.ibm.skim27.win' value='C:\KeyManagerConfig.properties'/>
<data key='user.EKM_MIGRATION,com.ibm.skim27.win' value='false'/>
<data key='user.PROFILE_NAME,com.ibm.sk1m27.win' value='KLMProfile'/>
<data key='user.WAS_ADMIN_ID,com.ibm.sk1m27.win' value='wasadmin'/>
<data key='user.WAS_ADMIN_PASSWORD,com.ibm.skim27.win' value='e9PjNI3MeQxwnSsIVXIFMw=="/>
<data key='user.WAS_ADMIN_CONF_PWD,com.ibm.sk1m27.win' value="'e9PjN93MeQxwnSs9VXJIFMw=="/>
<data key='user.SKLM_ADMIN_USER,com.ibm.sk1lm27.win' value='SKLMAdmin'/>
<data key='user.SKLM_ADMIN_PASSWORD,com.ibm.skIm27.win' value='9YTRIMRIydDSdfhaHPslag=="'/>
<data key='user.SKLM_ADMIN_CONF_PWD,com.ibm.skIm27.win' value='9YTRIMRIydDSdfhaHPslag=="'/>
<data key='user.SKLM_APP_PORT,com.ibm.skim27.win' value='443"'/>

<data key='user.WAS_ADMIN_PORT,com.ibm.skim27.win' value='9083"'/>

<data key='user.SKLM_APP_NS_PORT,com.ibm.skim27.win' value='80"'/>
<data key='cic.selector.n1' value='en'/>

</profile>

<preference name='com.ibm.cic.common.core.preferences.eclipseCache' value='C:\Program Files (x86)\IBM\IBMIMShared'/>
<preference name='com.ibm.cic.common.core.preferences.connectTimeout' value='30'/>
<preference name='com.ibm.cic.common.core.preferences.readTimeout' value='45'/>
<preference name='com.ibm.cic.common.core.preferences.downloadAutoRetryCount' value='0'/>
<preference name='offering.service.repositories.areUsed' value='true'/>
<preference name='com.ibm.cic.common.core.preferences.ssl.nonsecureMode' value='false'/>
<preference name='com.ibm.cic.common.core.preferences.http.disablePreemptiveAuthentication' value='false'/>
<preference name='http.ntim.auth.kind' value='NTLM'/>
<preference name='http.ntim.auth.enableIntegrated.win32' value='true'/>
<preference name='com.ibm.cic.common.core.preferences.preserveDownloadedArtifacts' value='true'/>
<preference name='com.ibm.cic.common.core.preferences.keepFetchedFiles' value='false'/>
<preference name='PassportAdvantageIsEnabled' value='false'/>
<preference name='com.ibm.cic.common.core.preferences.searchForUpdates' value='false'/>
<preference name='com.ibm.cic.agent.ui.displayInternalVersion' value='false'/>
<preference name='com.ibm.cic.common.sharedUI.showErrorLog' value='true'/>
<preference name='com.ibm.cic.common.sharedUI.showWarninglLog' value='true'/>
<preference name='com.ibm.cic.common.sharedUI.showNoteLog' value='true'/>
</agent-input>

New installation of version 2.7 on Linux systems

The example response file contains responses for an installation of IBM Security
Key Lifecycle Manager, Version 2.7 onto a system, such as Linux, or an installation
in which Encryption Key Manager migration occurs.

<?xml version='1.0' encoding='UTF-8'?>
<agent-input clean='true' >
<server>
<repository Tocation='/root/Downloads/diskl/im'/>
<repository location='/root/Downloads/disk1/'/>
</server>
<profile id='IBM Installation Manager' installlLocation='/opt/IBM/InstallationManager/eclipse' kind='self'>
<data key='eclipselLocation' value='/opt/IBM/InstallationManager/eclipse'/>
<data key='user.import.profile' value='false'/>
<data key='cic.selector.os' value='linux'/>
<data key='cic.selector.arch' value='x86_64'/>
<data key='cic.selector.ws' value='gtk'/>
</profile>
<install modify="'false'>
<offering profile='IBM Installation Manager' id='com.ibm.cic.agent' features='agent_core,agent_jre,agent_web' insta
<offering profile='IBM DB2 SKLM27' id='com.ibm.skim27.db2.1in.ofng' features='main.feature' installFixes='none'/>
<offering profile='IBM WebSphere Application Server V9.0' id='com.ibm.websphere.BASE.v90' features='core.feature,ejbde
embeddablecontainer' installFixes='none'/>
<offering profile='IBM WebSphere Application Server V9.0' id='com.ibm.java.jdk.v8' features='com.ibm.sdk.8' installFix
<offering profile='IBM Security Key Lifecycle Manager v2.7' id='com.ibm.skim27.1inux' features='main.feature' installF
</install>
<profile id='IBM DB2 SKLM27' installlLocation="'/opt/IBM/DB2SKLMV27'>
<data key='eclipselLocation' value='/opt/IBM/DB2SKLMV27"'/>
<data key='user.import.profile' value='false'/>
<data key='cic.selector.os' value='linux'/>
<data key='cic.selector.arch' value='x86_64'/>
<data key='cic.selector.ws' value='gtk'/>
<data key='user.DB2_ADMIN_ID,com.ibm.skim27.db2.1in.ofng' value='sklmdb27'/>
<data key='user.DB2_ADMIN_PWD,com.ibm.skim27.db2.1in.ofng' value='mdoQ5vWqvwGUwOgZaAiFqg=="/>
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<data key='user.CONFIRM_PASSWORD,com.ibm.sk1m27.db2.1in.0fng" value='m4oQ5viqvwGUwOgZaAiFqg=="/>
<data key="user.DB2_DB_HOME,com.ibm.skim27.db2.1in.ofng' value='/home/skimdb27"'/>
<data key='user.DB2_DB_NAME,com.ibm.sk1lm27.db2.1in.ofng' value='SKLMDB27'/>
<data key='user.DB2_DB_PORT,com.ibm.sk1lm27.db2.1in.ofng' value='50030"'/>
<data key='user.DB2_EXISTS,com.ibm.skim27.db2.1in.ofng' value='false'/>
<data key='user.DB2_LOCATION,com.ibm.skim27.db2.Tin.ofng' value='/opt/IBM/DB2SKLMV27'/>
<data key='user.DB2_DB_LHOME,com.ibm.sk1m27.db2.Tin.ofng' value='/home/skimdb27'/>
<data key='user.DB2_ADMIN_GRP,com.ibm.skim27.db2.1in.ofng' value='root'/>
<data key='cic.selector.nl' value='en'/>
</profile>
<profile id='IBM WebSphere Application Server V9.0' installlLocation='/opt/IBM/WebSphere/AppServer'>
<data key='eclipselLocation' value='/opt/IBM/WebSphere/AppServer'/>
<data key='user.import.profile' value='false'/>
<data key='cic.selector.os' value='linux'/>
<data key='cic.selector.arch' value='x86_64'/>
<data key='cic.selector.ws' value='gtk'/>
<data key='cic.selector.nl' value='en'/>
</profile>
<profile id='IBM Security Key Lifecycle Manager v2.7' installlocation="'/opt/IBM/SKLMV27'>
<data key='eclipselLocation' value='/opt/IBM/SKLMV27'/>
<data key='user.import.profile' value='false'/>
<data key='cic.selector.os' value='linux'/>
<data key='cic.selector.arch' value='x86_64"'/>
<data key='cic.selector.ws' value='gtk'/>
<data key='user.IS_SILENT_MODE,com.ibm.skim27.1inux' value='false'/>
<data key='user.EKM_PROPFILE,com.ibm.sk1m27.1inux' value='/opt/IBM/KeyManagerConfig.properties'/>
<data key='user.EKM_MIGRATION,com.ibm.sk1m27.1inux' value='false'/>
<data key='user.PROFILE_NAME,com.ibm.skIm27.1inux' value='KLMProfile'/>
<data key='user.WAS_ADMIN_ID,com.ibm.skIm27.1inux' value='wasadmin'/>
<data key='user.WAS_ADMIN_PASSWORD,com.ibm.sk1m27.1inux' value='e9PjN9I3MeQxwnSsOVXIFMw=="/>
<data key='user.WAS_ADMIN_CONF_PWD,com.ibm.sk1m27.7inux' value='e9PjN9I3MeQxwnSsOVXIFMw=="/>
<data key='user.SKLM_ADMIN_USER,com.ibm.skim27.1inux' value='SKLMAdmin'/>
<data key='user.SKLM_ADMIN_PASSWORD,com.ibm.sk1m27.1inux' value='9YTRIJMRIydDSdfhaHPslag=="/>
<data key='user.SKLM_ADMIN_CONF_PWD,com.ibm.skim27.1inux' value='9YTRIJMRIydDSdfhaHPslag=="/>
<data key='user.SKLM_APP_PORT,com.ibm.sk1m27.1inux' value='443"/>
<data key="user.WAS_ADMIN_PORT,com.ibm.skim27.1inux' value='9083'/>
<data key="user.SKLM_APP_NS_PORT,com.ibm.sk1m27.1inux' value='80"'/>
<data key='cic.selector.n1' value='en'/>
</profile>
<preference name='com.ibm.cic.common.core.preferences.eclipseCache' value='/opt/IBM/IBMIMShared'/>
<preference name='com.ibm.cic.common.core.preferences.connectTimeout' value='30"'/>
<preference name='com.ibm.cic.common.core.preferences.readTimeout' value='45"'/>
<preference name='com.ibm.cic.common.core.preferences.downloadAutoRetryCount' value='0'/>
<preference name='offering.service.repositories.areUsed' value='true'/>
<preference name='com.ibm.cic.common.core.preferences.ssl.nonsecureMode' value='false'/>
<preference name='com.ibm.cic.common.core.preferences.http.disablePreemptiveAuthentication' value='false'/>
<preference name='http.ntim.auth.kind' value='NTLM'/>
<preference name='http.ntim.auth.enableIntegrated.win32' value='true'/>
<preference name='com.ibm.cic.common.core.preferences.preserveDownloadedArtifacts' value='true'/>
<preference name='com.ibm.cic.common.core.preferences.keepFetchedFiles' value='false'/>
<preference name='PassportAdvantagelsEnabled' value='false'/>
<preference name='com.ibm.cic.common.core.preferences.searchForUpdates' value='false'/>
<preference name='com.ibm.cic.agent.ui.displayInternalVersion' value='false'/>
<preference name='com.ibm.cic.common.sharedUI.showErrorLog' value='true'/>
<preference name='com.ibm.cic.common.sharedUI.showWarninglLog' value='true'/>
<preference name='com.ibm.cic.common.sharedUI.showNoteLog' value='true'/>
</agent-input>

New installation of version 2.7 on Linux for System z

The example response file contains responses for an installation of IBM Security
Key Lifecycle Manager, Version 2.7 on Linux for System z or an installation in
which Encryption Key Manager migration occurs.

<?xml version="1.0" encoding="UTF-8"?>
<!--The "acceptLicense" attribute has been deprecated. Use
<agent-input acceptlLicense='true' clean='true' >
<server>
<repository location='/products/diskl/im'/>
<repository location='/products/diskl/'/>
</server>
<profile id='IBM Installation Manager' installlLocation='/products/opt/IBM/InstallationManager/eclipse' kind='self'>
<data key='eclipselLocation' value='/products/opt/IBM/InstallationManager/eclipse'/>
<data key='user.import.profile' value='false'/>
<data key='cic.selector.os' value='linux'/>
<data key='cic.selector.arch' value='s390x'/>
<data key='cic.selector.ws' value='gtk'/>
</profile>
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<install modify='false'>

<offering id='com.ibm.cic.agent'
<offering id='com.ibm.skim27.db2.1in.ofng'

<offering id='com.ibm.websphere.BASE.v90' profile='
embeddablecontainer' installFixes="'none'/>
<offering id='com.ibm.java.jdk.v8' profile='IBM WebSphere Application Server V9.0' features='com.ibm.sdk.8'

<offering id='com.ibm.sk1m27.Tinux'

</install>

profile="IBM Installation Manager' features='agent_core,agent_jre' installFixes='no
profile="'IBM DB2 SKLM27' features='main.feature' installFixes='none'/>

IBM WebSphere Application Server V9.0' features='core.feature,ejl

installF

profile='IBM Security Key Lifecycle Manager v2.7' features='main.feature' instal’

<profile id='IBM DB2 SKLM27' installLocation='/products/opt/IBM/DB2SKLMV27'>
<data key='eclipselLocation' value='/products/opt/IBM/DB2SKLMV27"'/>

<data key='user.import.profile' value='false'/>
<data key='cic.selector.os' value='linux'/>
<data key='cic.selector.arch' value='s390x'/>
<data key='cic.selector.ws' value='gtk'/>

<data key='user.DB2_ADMIN_ID,com.ibm.skim27.db2.1in.ofng' value='skimdb27'/>

<data key="'user.DB2_ADMIN_GRP,com.ibm.sk1m27.db2.1in.ofng' value='root'/>

<data key='user.DB2_ADMIN_PWD,com.ibm.skim27.db2.1in.ofng' value='m4oQ5vWqvwGUwOgZaAiFqg=="/>
<data key='user.CONFIRM_PASSWORD,com.ibm.skim27.db2.1in.0ofng' value='m4oQ5viqvwGUwOgZaAiFqg=="/>
<data key='user.DB2_DB_HOME,com.ibm.skim27.db2.1in.ofng' value='/products/home/skimdb27"'/>

<data key='user.DB2_DB_LHOME,com.ibm.sk1lm27.db2.Tin.ofng' value='/products/home/skimdb27"'/>
<data key='user.DB2_DB_NAME,com.ibm.sk1m27.db2.1in.ofng' value='SKLMDB27'/>

<data key='user.DB2_DB_PORT,com.ibm.sk1im27.db2.1in.0fng' value='50030"'/>

<data key='user.DB2_EXISTS,com.ibm.skim27.db2.1in.0ofng' value='false'/>

<data key='user.DB2_LOCATION,com.ibm.skim27.db2.1in.ofng' value='/products/opt/IBM/DB2SKLMV27"'/>
<data key='cic.selector.nl' value='en'/>

</profile>

<profile id="'IBM WebSphere Application Server V9.0' installlocation='/products/opt/IBM/WebSphere/AppServer's>
<data key='eclipselLocation' value='/products/opt/IBM/WebSphere/AppServer'/>

<data key='user.import.profile' value='false'/>
<data key='cic.selector.os' value='linux'/>
<data key='cic.selector.arch' value='s390x'/>
<data key='cic.selector.ws' value='gtk'/>

<data key='cic.selector.nl' value='en'/>

</profile>

<profile id="'IBM Security Key Lifecycle Manager v2.7' installlLocation='/products/opt/IBM/SKLMV27"'>
<data key='eclipselLocation' value='/products/opt/IBM/SKLMV27'/>

<data key='user.import.profile' value='false'/>
<data key='cic.selector.os' value='linux'/>
<data key='cic.selector.arch' value='s390x'/>
<data key='cic.selector.ws' value='gtk'/>

<data key='user.IS_SILENT_MODE,com.ibm.skim27.1inux' value='false'/>

<data key='user.EKM_PROPFILE,com.ibm.sk1m27.1inux' value='/opt/IBM/KeyManagerConfig.properties'/>
<data key='user.EKM_MIGRATION,com.ibm.skim27.1inux' value='false'/>

<data key='user.PROFILE_NAME,com.ibm.sk1m27.1inux' value='KLMProfile'/>

<data key='user.WAS_ADMIN_ID,com.ibm.sk1m27.1inux' value='wasadmin'/>

<data key='user.WAS_ADMIN_PASSWORD,com.ibm.sk1m27.1inux' value='e9PjN9I3MeQxwnSsIVXJIFMw=="/>

<data key="'user.WAS_ADMIN_CONF_PWD,com.ibm.skim27.1inux" value='e9PjN9I3MeQxwnSsIVXJIFMw=="/>

<data key="user.SKLM_ADMIN_USER,com.ibm.skim27.1inux" value='SKLMAdmin'/>

<data key="'user.SKLM_ADMIN_PASSWORD,com.ibm.sk1m27.1inux' value='9YTRIMRIydDSdfhaHPslag=="/>
<data key='user.SKLM_ADMIN_CONF_PWD,com.ibm.skim27.1inux' value='9YTRIJMRIydDSdfhaHPslag=="'/>
<data key='user.SKLM_APP_PORT,com.ibm.skim27.1inux' value="'443"/>

<data key='user.WAS_ADMIN_PORT,com.ibm.skim27.1inux' value='9083'/>

<data key='user.SKLM_APP_NS_PORT,com.ibm.skim27.Tinux' value='80"'/>

<data key='cic.selector.nl' value='en'/>

</profile>

<preference name='com.
<preference name='com.
<preference name='com.
<preference name='com.

ibm
ibm
ibm
ibm

.cic.
.cic.
.cic.
.cic.

common.
common.
common.
.core.preferences

common

core.preferences
core.preferences
core.preferences

.eclipseCache' value='/products/opt/IBM/IBMIMShared'/>
.connectTimeout' value='30'/>

.readTimeout' value='45'/>

.downloadAutoRetryCount' value='0"'/>

<preference name='offering.service.repositories.areUsed' value='true'/>
<preference name='com.ibm.cic.common.core.preferences.ssl.nonsecureMode' value='false'/>
<preference name='com.ibm.cic.common.core.preferences.http.disablePreemptiveAuthentication' value='false'/>

<preference name='http.ntim.auth.kind' value='NTLM'/>

<preference name='http.ntim.auth.enableIntegrated.win32' value='true'/>

<preference name='com.ibm.cic.common.core.preferences.preserveDownloadedArtifacts' value='true'/>
<preference name='com.ibm.cic.common.core.preferences.keepFetchedFiles' value='false'/>
<preference name='PassportAdvantagelsEnabled' value='false'/>
common.core.preferences.searchForUpdates' value='false'/>
agent.ui.displayInternalVersion' value='false'/>
common.sharedUI.showErrorLog' value='true'/>
common.sharedUI.showWarninglLog' value='true'/>
common.sharedUI.showNoteLog' value='true'/>

<preference name='com.
<preference name='com.
<preference name='com.
<preference name='com.
<preference name='com.

</agent-input>
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New installation of version 2.7 on AIX systems

The example response file contains responses for an installation of IBM Security
Key Lifecycle Manager, Version 2.7 on AIX systems or an installation in which
Encryption Key Manager migration occurs.

<?xml version="1.0" encoding="UTF-8"?>

<!--The "acceptLicense" attribute has been deprecated. Use
<agent-input acceptlLicense='true' clean='true' >
<server>

<repository location='/diskl/im'/>

<repository location='/diskl/'/>

</server>

<profile id='IBM Installation Manager' installlLocation='/opt/IBM/InstallationManager/eclipse' kind='self'>
<data key='eclipseLocation' value='/opt/IBM/InstallationManager/eclipse'/>

<data key='user.import.profile' value='false'/>

<data key='cic.selector.os' value='aix'/>

<data key='cic.selector.arch' value='ppc'/>

<data key='cic.selector.ws' value='gtk'/>

</profile>

<install modify="'false'>

<offering id='com.ibm.cic.agent' profile='IBM Installation Manager' features='agent_core,agent_jre' installFixes='n
<offering id='com.ibm.skim27.db2.aix.ofng' profile='IBM DB2 SKLM27' features='main.feature' installFixes='none'/>
<offering id='com.ibm.websphere.BASE.v90' profile='IBM WebSphere Application Server V9.0' features='core.feature,ej
embeddablecontainer' installFixes='none'/>

<offering id='com.ibm.java.jdk.v8"' profile='IBM WebSphere Application Server V9.0' features='com.ibm.sdk.8' installF
<offering id='com.ibm.skim27.aix' profile='IBM Security Key Lifecycle Manager v2.7' features='main.feature' installF
</install>

<profile id='IBM DB2 SKLM27' installlLocation='/opt/IBM/DB2SKLMV27'>

<data key='eclipselLocation' value='/opt/IBM/DB2SKLMV27'/>

<data key='user.import.profile' value='false'/>

<data key='cic.selector.os' value='aix'/>

<data key='cic.selector.arch' value='ppc64'/>

<data key='cic.selector.ws' value='gtk'/>

<data key='user.DB2_ADMIN_ID,com.ibm.skim27.db2.aix.ofng' value='skimdb27'/>

<data key='user.DB2_ADMIN_GRP,com.ibm.skim27.db2.aix.ofng' value='bin'/>

<data key='user.DB2_ADMIN_PWD,com.ibm.skim27.db2.aix.ofng' value='mdoQ5vWqvwGUwOgZaAiFqg=="/>

<data key='user.CONFIRM_PASSWORD,com.ibm.sk1m27.db2.aix.ofng" value='m4oQ5viqvwGUw0OgZaAiFqg=="/>

<data key='user.DB2_DB_HOME,com.ibm.sk1m27.db2.aix.ofng' value='/home/skimdb27"'/>

<data key='user.DB2_DB_NAME,com.ibm.sk1m27.db2.aix.ofng' value='SKLMDB27'/>

<data key='user.DB2_DB_PORT,com.ibm.sk1m27.db2.aix.ofng' value='50030"'/>

<data key='user.DB2_EXISTS,com.ibm.skim27.db2.aix.ofng' value='false'/>

<data key='user.DB2_LOCATION,com.ibm.skim27.db2.aix.ofng' value='/opt/IBM/DB2SKLMV27"'/>

<data key='cic.selector.n1' value='en'/>

</profile>

<profile id='IBM WebSphere Application Server V9.0' installLocation='/usr/IBM/WebSphere/AppServer'>

<data key='eclipselLocation' value='/usr/IBM/WebSphere/AppServer'/>

<data key='user.import.profile' value='false'/>

<data key='cic.selector.os' value='aix'/>

<data key='cic.selector.arch' value='ppc64'/>

<data key='cic.selector.ws' value='gtk'/>

<data key='cic.selector.n1' value='en'/>

</profile>

<profile id='IBM Security Key Lifecycle Manager v2.7' installlLocation="'/opt/IBM/SKLMV27'>

<data key='eclipselLocation' value='/opt/IBM/SKLMV27'/>

<data key='user.import.profile' value='false'/>

<data key='cic.selector.os' value='aix'/>

<data key='cic.selector.arch' value='ppc64'/>

<data key='cic.selector.ws' value='gtk'/>

<data key='user.IS_SILENT_MODE,com.ibm.skim27.Tinux' value='false'/>

<data key='user.EKM_PROPFILE,com.ibm.skim27.aix' value='/opt/IBM/KeyManagerConfig.properties'/>

<data key='user.EKM_MIGRATION,com.ibm.skim27.aix' value='false'/>

<data key='user.PROFILE_NAME,com.ibm.sk1m27.aix' value='KLMProfile'/>

<data key='user.WAS_ADMIN_ID,com.ibm.skim27.aix' value='wasadmin'/>

<data key='user.WAS_ADMIN_PASSWORD,com.ibm.skim27.aix' value='e9PjNI3MeQxwnSsIVXIFMw=="/>

<data key='user.WAS_ADMIN_CONF_PWD,com.ibm.skim27.aix' value='e9PjN93MeQxwnSsOVXJFMw=="/>

<data key='user.SKLM_ADMIN_USER,com.ibm.sk1m27.aix' value='SKLMAdmin'/>

<data key='user.SKLM_ADMIN_PASSWORD,com.ibm.skim27.aix' value='9YTRIMRIydDSdfhaHPslag=="'/>

<data key='user.SKLM_ADMIN_CONF_PWD,com.ibm.sk1m27.aix' value='9YTRIJMRIydDSdfhaHPslag=="'/>

<data key='user.SKLM_APP_PORT,com.ibm.skim27.aix"' value='443"'/>

<data key='user.WAS_ADMIN_PORT,com.ibm.skim27.aix' value='9083'/>

<data key='user.SKLM_APP_NS_PORT,com.ibm.skIm27.aix' value='80"'/>

<data key='cic.selector.nl' value='en'/>

</profile>

<preference name='com.ibm.cic.common.core.preferences.eclipseCache' value='/opt/IBM/IBMIMShared'/>
<preference name='com.ibm.cic.common.core.preferences.connectTimeout' value='30'/>

<preference name='com.ibm.cic.common.core.preferences.readTimeout' value='45"'/>

<preference name='com.ibm.cic.common.core.preferences.downloadAutoRetryCount' value='0"/>
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<preference name='offering.service.repositories.areUsed' value='true'/>

<preference name='com.ibm.cic.common.core.preferences.ssl.nonsecureMode' value='false'/>
<preference name='com.ibm.cic.common.core.preferences.http.disablePreemptiveAuthentication' value='false'/>
<preference name='http.ntim.auth.kind' value='NTLM'/>

<preference name='http.ntim.auth.enableIntegrated.win32' value='true'/>

<preference name='com.ibm.cic.common.core.preferences.preserveDownloadedArtifacts' value='true'/>
<preference name='com.ibm.cic.common.core.preferences.keepFetchedFiles' value='false'/>
<preference name='PassportAdvantagelsEnabled' value='false'/>

<preference name='com.ibm.cic.common.core.preferences.searchForUpdates' value='false'/>
<preference name='com.ibm.cic.agent.ui.displayInternalVersion' value='false'/>

<preference name='com.ibm.cic.common.sharedUI.showErrorLog' value='true'/>

<preference name='com.ibm.cic.common.sharedUI.showWarninglog' value='true'/>

<preference name='com.ibm.cic.common.sharedUIl.showNoteLog' value='true'/>

</agent-input>

Earlier version to version 2.7 migration on Windows systems

The example response file contains responses for an installation onto a Windows
system in which IBM Security Key Lifecycle Manager earlier version to version 2.7
migration occurs.

Note: To determine whether IBM Security Key Lifecycle Manager earlier version
exists and requires migration, use the tkImVersionInfo command. For example,
type this command in a Jython session:

print AdminTask.tkIimVersionInfo<>

<?xml version="1.0" encoding="UTF-8"?>
<agent-input clean='true' >
<server>
<repository Tocation='C:\diskl'/>
<repository location='C:\diskl\im'/>
</server>
<install modify='false'>
<offering profile="IBM Installation Manager' id='com.ibm.cic.agent' features='agent_core,agent_jre,agent_web' install
<offering profile='IBM DB2 SKLM27' id='com.ibm.skIlm27.db2.win.ofng' version='11.1.0.0"' features='main.feature' inst:
<offering profile='IBM WebSphere Application Server V9.0' id='com.ibm.websphere.BASE.v90' features='core.feature,e;
embeddablecontainer' installFixes='none'/>
<offering profile='IBM WebSphere Application Server V9.0' id='com.ibm.java.jdk.v8' features='com.ibm.sdk.8' install
<offering profile='IBM Security Key Lifecycle Manager v2.7' id='com.ibm.skim27.win' version='2.7.0.0' features='mair
</install>
<profile id='IBM DB2 SKLM27' installLocation='C:\Program Files\IBM\DB2SKLMV27'>
<data key='eclipselLocation' value='C:\Program Files\IBM\DB2SKLMV27'/>
<data key='user.import.profile' value='false'/>
<data key='cic.selector.os' value='win32'/>
<data key='cic.selector.arch' value='x86_64'/>
<data key='cic.selector.ws' value='win32'/>
<data key='cic.selector.nl' value='en'/>
<data key='user.DB2_ADMIN_ID,com.ibm.skim27.db2.win.ofng' value='skimdb27'/>
<data key='user.DB2_ADMIN_PWD,com.ibm.skim27.db2.win.ofng' value='mdoQ5vWqvwGUwOgZaAiFqg=="/>
<data key='user.CONFIRM_PASSWORD,com.ibm.sk1m27.db2.win.ofng' value='m4oQ5viqvwGUw0OgZaAiFqg=="/>
<data key='user.DB2_DB_HOME,com.ibm.sk1m27.db2.win.ofng' value='C:'/>
<data key='user.DB2_DB_NAME,com.ibm.sk1m27.db2.win.ofng' value='SKLMDB27'/>
<data key='user.DB2_DB_PORT,com.ibm.sk1m27.db2.win.ofng' value='50030"'/>
<data key='user.DB2_EXISTS,com.ibm.skIm27.db2.win.ofng' value='false'/>
<data key='user.DB2_LOCATION,com.ibm.skim27.db2.win.ofng' value='C:\\Program Files\\IBM\\DB2SKLMV27'/>
</profile>
<profile id='IBM WebSphere Application Server V9.0' installlLocation='C:\Program Files\IBM\WebSphere\AppServer'>
<data key='eclipselLocation' value='C:\Program Files\IBM\WebSphere\AppServer'/>
<data key='user.import.profile' value='false'/>
<data key='cic.selector.os' value='win32'/>
<data key='cic.selector.arch' value='x86_64'/>
<data key='cic.selector.ws' value='win32'/>
<data key='cic.selector.n1' value='en'/>
</profile>

<profile id='IBM Security Key Lifecycle Manager v2.7' installlLocation='C:\Program Files\IBM\SKLMV27'>
<data key='eclipseLocation' value='C:\Program Files\IBM\SKLMV27'/>
<data key='user.import.profile' value='false'/>
<data key='cic.selector.os' value='win32'/>
<data key='cic.selector.arch' value='x86_64'/>
<data key='cic.selector.ws' value='win32'/>
<data key='user.EKM_PROPFILE,com.ibm.skim27.win' value='C:\KeyManagerConfig.properties'/>
<data key='user.EKM_MIGRATION,com.ibm.sk1m27.win' value='false'/>
<data key='user.IS_SILENT_MODE,com.ibm.skim27.win' value='false'/>
<data key='cic.selector.n1' value='en'/>
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<data key='user.PROFILE_NAME,com.ibm.skim27.win' value='KLMProfile'/>
<data key="user.WAS_ADMIN_ID,com.ibm.skim27.win' value='wasadmin'/>
<data key='user.WAS_ADMIN_PASSWORD,com.ibm.skim27.win' value='e9PjNI3MeQxwnSsIVXIFMw=="/>
<data key='user.WAS_ADMIN_CONF_PWD,com.ibm.skim27.win' value='e9PjN9I3MeQxwnSsIVXJIFMw=="/>
<data key='user.SKLM_ADMIN_USER,com.ibm.skim27.win' value='SKLMAdmin'/>
<data key='user.SKLM_ADMIN_PASSWORD,com.ibm.sk1m27.win' value='9YTRIMRIydDSdfhaHPslag=="/>
<data key='user.SKLM_ADMIN_CONF_PWD,com.ibm.sk1m27.win' value='9YTRIMRIydDSdfhaHPslag=="/>
<data key='user.TKLM_VERSION,com.ibm.skIm27.win' value='2.5.0.4"'/>
<data key='user.TKLM_TIP_HOME,com.ibm.sk1m27.win' value='C:\Program Files (x86)\IBM\WebSphere\AppServer'/>
<data key='user.TKLM_INSTALLED,com.ibm.skim27.win' value='true'/>
<data key='user.TKLM_DB_PWD,com.ibm.sk1m27.win' value='SwIhGBTDHcJok80Ux4Sbh3g=="/>
<data key="user.TKLM_KEYSTORE_PWD,com.ibm.skim27.win' value='fufgZbY47EfxLYarBAIxeQ=="/>
<data key="user.SKLM_APP_PORT,com.ibm.skim27.win' value='443'/>
<data key="user.WAS_ADMIN_PORT,com.ibm.skim27.win' value='9083"'/>
<data key='user.SKLM_APP_NS_PORT,com.ibm.sk1m27.win' value='80"'/>
</profile>

<preference name='com.ibm.cic.common.core.preferences.eclipseCache' value='C:\Program Files (x86)\IBM\IBMIMShared"
<preference name='com.ibm.cic.common.core.preferences.connectTimeout' value='30'/>
<preference name='com.ibm.cic.common.core.preferences.readTimeout' value='45"'/>
<preference name='com.ibm.cic.common.core.preferences.downloadAutoRetryCount' value='0'/>
<preference name='offering.service.repositories.areUsed' value='true'/>
<preference name='com.ibm.cic.common.core.preferences.ssl.nonsecureMode' value='false'/>
<preference name='com.ibm.cic.common.core.preferences.http.disablePreemptiveAuthentication' value='false'/>
<preference name='http.ntim.auth.kind' value='NTLM'/>
<preference name='http.ntim.auth.enableIntegrated.win32' value='true'/>
<preference name='com.ibm.cic.common.core.preferences.preserveDownloadedArtifacts' value='true'/>
<preference name='com.ibm.cic.common.core.preferences.keepFetchedFiles' value='false'/>
<preference name='PassportAdvantagelsEnabled' value='false'/>
<preference name='com.ibm.cic.common.core.preferences.searchForUpdates' value='false'/>
<preference name='com.ibm.cic.agent.ui.displayInternalVersion' value='false'/>
<preference name='com.ibm.cic.common.sharedUI.showErrorLog' value='true'/>
<preference name='com.ibm.cic.common.sharedUI.showWarninglLog' value='true'/>
<preference name='com.ibm.cic.common.sharedUI.showNotelLog' value='true'/>
</agent-input>

Earlier version

to version 2.7 migration on Linux systems

The example response file contains responses for an installation Linux system in
which IBM Security Key Lifecycle Manager earlier version to version 2.7 migration
occurs.

Note: To determine whether IBM Security Key Lifecycle Manager earlier version
exists and requires migration, use the tkimVersionInfo command. For example,
type this command in a Jython session:

print AdminTask.tkImVersionInfo<>

<?xml version='1.0"' encoding='UTF-8'?>
<agent-input clean='true' >
<server>
<repository location='/diskl'/>
<repository location='/diskl/im'/>
</server>
<install modify='false'>
<offering profile='IBM Installation Manager' id='com.ibm.cic.agent' features='agent_core,agent_jre,agent_web' ins
<offering profile='IBM WebSphere Application Server V9.0' id='com.ibm.websphere.BASE.v90' features='core.featur
embeddablecontainer' installFixes="'none'/>
<offering profile='IBM WebSphere Application Server V9.0' id='com.ibm.java.jdk.v8' features='com.ibm.sdk.8' inst
<offering profile='IBM DB2 SKLM27' id='com.ibm.skIim27.db2.T7in.ofng' version='11.1.0.0"' features='main.feature' il
<offering profile='IBM Security Key Lifecycle Manager v2.7' id='com.ibm.skim27.1inux' version='2.7.0.0"' features:
</install>
<profile id="'IBM DB2 SKLM27' installlLocation="'/opt/IBM/DB2SKLMV27'>
<data key='eclipselLocation' value='/opt/IBM/DB2SKLMV27'/>
<data key='user.import.profile' value='false'/>
<data key='cic.selector.os' value='linux'/>
<data key='cic.selector.arch' value='x86_64'/>
<data key='cic.selector.ws' value='gtk'/>
<data key='cic.selector.n1' value='en'/>
<data key='user.DB2_ADMIN_ID,com.ibm.sk1m27.db2.1in.ofng' value='skimdb27'/>
<data key='user.DB2_ADMIN_PWD,com.ibm.sk1m27.db2.1in.ofng' value='m4oQ5vWqvwGUwOgZaAiFqg=="/>
<data key='user.CONFIRM_PASSWORD,com.ibm.sk1m27.db2.1in.0fng" value='m4oQ5viqvwGUw0OgZaAiFqg=="/>
<data key='user.DB2_DB_HOME,com.ibm.skim27.db2.1in.0fng' value='/home/skimdb27"'/>
<data key='user.DB2_DB_NAME,com.ibm.sk1im27.db2.1in.ofng' value='SKLMDB27'/>
<data key='user.DB2_DB_PORT,com.ibm.sk1lm27.db2.1in.ofng' value='50030"'/>
<data key='user.DB2_EXISTS,com.ibm.skim27.db2.1in.ofng' value='false'/>
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<data key='user.DB2_LOCATION,com.ibm.skim27.db2.1in.ofng' value='/opt/IBM/DB2SKLMV27"'/>
<data key='user.DB2_DB_LHOME,com.ibm.sk1m27.db2.1in.ofng' value='/home/skimdb27"'/>
<data key='user.DB2_ADMIN_GRP,com.ibm.skim27.db2.1in.ofng' value='root'/>
</profile>
<profile id='IBM Installation Manager' installlocation='/opt/IBM/InstallationManager/eclipse' kind='self'>
<data key='eclipseLocation' value='/opt/IBM/InstallationManager/eclipse'/>
<data key='user.import.profile' value='false'/>
<data key='cic.selector.os' value='linux'/>
<data key='cic.selector.arch' value='x86_64'/>
<data key='cic.selector.ws' value='gtk'/>
</profile>
<profile id='IBM WebSphere Application Server V9.0' installlLocation='/opt/IBM/WebSphere27/AppServer'>
<data key='eclipseLocation' value='/opt/IBM/WebSphere27/AppServer'/>
<data key='user.import.profile' value='false'/>
<data key='cic.selector.os' value='linux'/>
<data key='cic.selector.arch' value='x86_64'/>
<data key='cic.selector.ws' value='gtk'/>
<data key='cic.selector.nl' value='en'/>
</profile>

<profile id="'IBM Security Key Lifecycle Manager v2.7' installlocation="'/opt/IBM/SKLMV27'>
<data key='eclipselLocation' value='/opt/IBM/SKLMV27'/>
<data key='user.import.profile' value='false'/>
<data key='cic.selector.os' value='linux'/>
<data key='cic.selector.arch' value='x86_64"'/>
<data key='cic.selector.ws' value='gtk'/>
<data key='user.IS_SILENT_MODE,com.ibm.skim27.1inux' value='false'/>
<data key='cic.selector.nl' value='en'/>
<data key='user.PROFILE_NAME,com.ibm.skim27.1inux' value='KLMProfile'/>
<data key='user.WAS_ADMIN_ID,com.ibm.skim27.1inux' value='wasadmin'/>
<data key='user.WAS_ADMIN_PASSWORD,com.ibm.sk1m27.1inux' value='e9PjN93MeQxwnSs9OVXIFMw=="/>
<data key='user.WAS_ADMIN_CONF_PWD,com.ibm.sk1m27.1inux' value="'e9PjN93MeQxwnSs9OVXIFMw=="/>
<data key='user.SKLM_ADMIN_USER,com.ibm.sk1m27.1inux' value='SKLMAdmin'/>
<data key='user.SKLM_ADMIN_PASSWORD,com.ibm.skim27.1inux' value='9YTRIMRIydDSdfhaHPslag=="'/>
<data key='user.SKLM_ADMIN_CONF_PWD,com.ibm.skim27.1inux' value='9YTRIMRIydDSdfhaHPslag=="'/>
<data key='user.TKLM_VERSION,com.ibm.sk1m27.1inux' value='2.5.0.4'/>
<data key='user.TKLM_TIP_HOME,com.ibm.skim27.1inux' value='/opt/IBM/WebSphere/AppServer'/>
<data key='user.TKLM_INSTALLED,com.ibm.skim27.1inux' value='true'/>
<data key='user.TKLM_DB_PWD,com.ibm.sk1m27.1inux' value='SwIhGBTDHcJok80Ux4Sb3g=="/>
<data key='user.SKLM_APP_PORT,com.ibm.skim27.1inux' value="'443'/>

<data key='user.WAS_ADMIN_PORT,com.ibm.skim27.1inux' value='9083'/>

<data key='user.SKLM_APP_NS_PORT,com.ibm.skim27.1inux' value='80"'/>

</profile>

<preference name='com.ibm.cic.common.core.preferences.eclipseCache' value='/opt/IBM/IBMIMShared'/>
<preference name='com.ibm.cic.common.core.preferences.connectTimeout' value='30'/>
<preference name='com.ibm.cic.common.core.preferences.readTimeout' value='45"'/>
<preference name='com.ibm.cic.common.core.preferences.downloadAutoRetryCount' value='0"'/>
<preference name='offering.service.repositories.areUsed' value='true'/>
<preference name='com.ibm.cic.common.core.preferences.ssl.nonsecureMode' value='false'/>
<preference name='com.ibm.cic.common.core.preferences.http.disablePreemptiveAuthentication' value='false'/>
<preference name='http.ntim.auth.kind' value='NTLM'/>
<preference name='http.ntim.auth.enableIntegrated.win32' value='true'/>
<preference name='com.ibm.cic.common.core.preferences.preserveDownloadedArtifacts' value='true'/>
<preference name='com.ibm.cic.common.core.preferences.keepFetchedFiles' value='false'/>
<preference name='PassportAdvantagelsEnabled' value='false'/>
<preference name='com.ibm.cic.common.core.preferences.searchForUpdates' value='false'/>
<preference name='com.ibm.cic.agent.ui.displayInternalVersion' value='false'/>
<preference name='com.ibm.cic.common.sharedUI.showErrorLog' value='true'/>
<preference name='com.ibm.cic.common.sharedUI.showWarninglLog' value='true'/>
<preference name='com.ibm.cic.common.sharedUI.showNoteLog' value='true'/>

</agent-input>

Earlier version to version 2.7 migration on Linux for System z

The example response file contains responses for a Linux for System z installation
in which IBM Security Key Lifecycle Manager earlier version to version 2.7
migration occurs.

Note: To determine whether IBM Security Key Lifecycle Manager earlier version
exists and requires migration, use the tkImVersionInfo command. For example,
type this command in a Jython session:

print AdminTask.tklmVersionInfo<>
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<?xml version="1.0" encoding="UTF-8"?>
<!--The "acceptLicense" attribute has been deprecated. Use
<agent-input acceptlLicense='true' clean='true' >

-acceptLicense" command line option to accept Ticense ag

<server>

<repository location='/diskl/im'/>
<repository location='/diskl/'/>
</server>

<install modify="'false'>

<offering profile='IBM Installation Manager' id='com.ibm.cic.agent' features='agent_core,agent_jre' installFixes='no
<offering profile='IBM DB2 SKLM27' id='com.ibm.skim27.db2.1in.ofng' features='main.feature' installFixes='none'/>
<offering profile='IBM WebSphere Application Server V9.0' id='com.ibm.websphere.BASE.v90' features='core.feature,
ejbdeploy,thinclient,embeddablecontainer' installFixes='none'/>

<offering profile='IBM WebSphere Application Server V9.0' id='com.ibm.java.jdk.v8"' features='com.ibm.sdk.8' installF
<offering profile='IBM Security Key Lifecycle Manager v2.7' id='com.ibm.skIlm27.1inux' features="main.feature' inst
</install>

<profile id='IBM DB2 SKLM27' installlocation="'/opt/IBM/DB2SKLMV27'>

<data key='eclipselLocation' value='/opt/IBM/DB2SKLMV27'/>

<data key='user.import.profile' value='false'/>

<data key='cic.selector.os' value='linux'/>

<data key='cic.selector.arch' value='s390x'/>

<data key='cic.selector.ws' value='gtk'/>

<data key='user.DB2_ADMIN_ID,com.ibm.sk1m27.db2.1in.ofng' value='skimdb27'/>

<data key='user.DB2_ADMIN_GRP,com.ibm.skim27.db2.1in.ofng' value='root'/>

<data key='user.DB2_ADMIN_PWD,com.ibm.skim27.db2.1in.ofng' value='mdoQ5vWqvwGUwOgZaAiFqg=="/>
<data key='user.CONFIRM_PASSWORD,com.ibm.sk1m27.db2.1in.0fng" value='mdoQ5viqvwGUw0gZaAiFqg=="/>
<data key='user.DB2_DB_LHOME,com.ibm.skim27.db2.1in.ofng' value='/home/skimdb27"'/>

<data key='user.DB2_DB_NAME,com.ibm.sk1m27.db2.Tin.ofng' value='SKLMDB27'/>

<data key='user.DB2_DB_PORT,com.ibm.sk1m27.db2.1in.ofng' value='50030"'/>

<data key='user.DB2_EXISTS,com.ibm.sk1im27.db2.1in.ofng' value='false'/>

<data key='user.DB2_LOCATION,com.ibm.skim27.db2.1in.ofng' value='/opt/IBM/DB2SKLMV27"'/>
<data key='cic.selector.n1' value='en'/>

</profile>

<profile id='IBM Installation Manager' installLocation='/opt/IBM/InstallationManager/eclipse' kind='self'>
<data key='eclipselLocation' value='/opt/IBM/InstallationManager/eclipse'/>

<data key='user.import.profile' value='false'/>

<data key='cic.selector.os' value='linux'/>

<data key='cic.selector.arch' value='s390x'/>

<data key='cic.selector.ws' value='gtk'/>

</profile>

<profile id='IBM WebSphere Application Server V9.0' installlLocation='/opt/IBM/WebSphere27/AppServer'>
<data key='eclipselocation' value='/opt/IBM/WebSphere27/AppServer'/>

<data key='user.import.profile' value='false'/>

<data key='cic.selector.os' value='linux'/>

<data key='cic.selector.arch' value='s390x'/>

<data key='cic.selector.ws' value='gtk'/>

<data key='cic.selector.n1' value='en'/>

</profile>

<profile id='IBM Security Key Lifecycle Manager v2.7' installlLocation="'/opt/IBM/SKLMV27"'>
<data key='eclipselocation' value='/opt/IBM/SKLMV27'/>

<data key='user.import.profile' value='false'/>

<data key='cic.selector.os' value='linux'/>

<data key='cic.selector.arch' value='s390x'/>

<data key='cic.selector.ws' value='gtk'/>

<data key='user.EKM_PROPFILE,com.ibm.skim27.1inux' value="'/opt/IBM/KeyManagerConfig.properties'/>
<data key='user.EKM_MIGRATION,com.ibm.skim27.1inux' value='false'/>

<data key='user.PROFILE_NAME,com.ibm.skim27.1inux' value='KLMProfile'/>

<data key='user.WAS_ADMIN_ID,com.ibm.sk1m27.1inux' value='tipadmin'/>

<data key='user.WAS_ADMIN_PASSWORD,com.ibm.skim27.Tinux' value='e9PjN93MeQxwnSs9OVXJIFMw=="/>
<data key='user.WAS_ADMIN_CONF_PWD,com.ibm.skim27.1inux" value='e9PjN9I3MeQxwnSsOVXIFMw=="/>
<data key='user.SKLM_ADMIN_USER,com.ibm.sk1m27.1inux' value='TKLMAdmin'/>

<data key='user.SKLM_ADMIN_PASSWORD,com.ibm.skim27.1inux' value='9YTRIMRIydDSdfhaHPslag=="'/>
<data key='user.SKLM_ADMIN_CONF_PWD,com.ibm.skim27.1inux' value='9YTRIMRIydDSdfhaHPslag=="'/>
<data key='user.TKLM_VERSION,com.ibm.skim27.1inux' value='2.0.1'/>

<data key='user.TKLM_TIP_HOME,com.ibm.skim27.1inux' value='/opt/IBM/tivoli/tiptkimv2/'/>
<data key='user.TKLM_INSTALLED,com.ibm.skim27.1inux' value='true'/>

<data key='user.TKLM_DB_PWD,com.ibm.sk1m27.1inux' value="'/6vJK3fcU3QxHY+RVfCFVw=="/>

<data key='user.TKLM_KEYSTORE_PWD,com.ibm.skim27.1inux' value='fufgZbY47EfxLYarBAIxeQ=="'/>
<data key='user.SKLM_APP_PORT,com.ibm.skim27.1inux' value="'443"'/>

<data key='user.WAS_ADMIN_PORT,com.ibm.skim27.1inux" value='9083'/>

<data key='user.SKLM_APP_NS_PORT,com.ibm.skim27.1inux' value='80"'/>

<data key='cic.selector.nl' value='en'/>

</profile>

<preference name='com.ibm.cic.common.core.preferences.eclipseCache' value='/opt/IBM/IBMIMShared'/>
<preference name='com.ibm.cic.common.core.preferences.connectTimeout' value='30"'/>
<preference name='com.ibm.cic.common.core.preferences.readTimeout' value='45"'/>

<preference name='com.ibm.cic.common.core.preferences.downloadAutoRetryCount' value='0'/>
<preference name='offering.service.repositories.areUsed' value='true'/>
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<preference name='com.ibm.cic.common.core.preferences.ssl.nonsecureMode' value='false'/>
<preference name='com.ibm.cic.common.core.preferences.http.disablePreemptiveAuthentication' value='false'/>
<preference name='http.ntIm.auth.kind' value='NTLM'/>

<preference name='http.ntim.auth.enableIntegrated.win32' value='true'/>

<preference name='com.ibm.cic.common.core.preferences.preserveDownloadedArtifacts' value='true'/>
<preference name='com.ibm.cic.common.core.preferences.keepFetchedFiles' value='false'/>
<preference name='PassportAdvantagelsEnabled' value='false'/>

<preference name='com.ibm.cic.common.core.preferences.searchForUpdates' value='false'/>
<preference name='com.ibm.cic.agent.ui.displayInternalVersion' value='false'/>

<preference name='com.ibm.cic.common.sharedUI.showErrorLog' value='true'/>

<preference name='com.ibm.cic.common.sharedUI.showWarninglog' value='true'/>

<preference name='com.ibm.cic.common.sharedUIl.showNoteLog' value='true'/>

</agent-input>

Earlier version

to version 2.7 migration on AIX systems

The example response file contains responses for an installation on AIX system in
which IBM Security Key Lifecycle Manager earlier version to version 2.7 migration
occurs.

Note: To determine whether IBM Security Key Lifecycle Manager earlier version
exists and requires migration, use the tkImVersionInfo command. For example,
type this command in a Jython session:

print AdminTask.tkImVersionInfo<>

<?xml version="1.0" encoding="UTF-8"?>

<!--The "acceptLicense" attribute has been deprecated. Use "-acceptLicense" command Tine option to accept Ticense agreer
<agent-input clean='true'>

<server>

<repository location='/diskl/im'/>

<repository location='/diskl/'/>

</server>

<install modify="'false'>

<offering profile="IBM Installation Manager' id='com.ibm.cic.agent' features='agent_core,agent_jre' installFixes="none',
<offering profile='IBM DB2 SKLM27' id='com.ibm.skim27.db2.aix.ofng' features='main.feature' installFixes='none'/>
<offering profile='IBM WebSphere Application Server V9.0' id='com.ibm.websphere.BASE.v90' features='core.feature,ejbdep
embeddablecontainer' installFixes='none'/>

<offering profile='IBM WebSphere Application Server V9.0' id='com.ibm.java.jdk.v8"' features='com.ibm.sdk.8' installFixe
<offering profile='IBM Security Key Lifecycle Manager v2.7' id='com.ibm.skim27.aix' features='main.feature' installFixe
</install>

<profile id="IBM DB2 SKLM27' installlocation="'/opt/IBM/DB2SKLMV27'>

<data key='eclipselLocation' value='/opt/IBM/DB2SKLMV27'/>

<data key='user.import.profile' value='false'/>

<data key='cic.selector.os' value='aix'/>

<data key='cic.selector.arch' value='ppc64'/>

<data key='cic.selector.ws' value='gtk'/>

<data key='user.DB2_ADMIN_ID,com.ibm.skim27.db2.aix.ofng' value='skimdb27'/>

<data key='user.DB2_ADMIN_GRP,com.ibm.skim27.db2.aix.ofng' value='bin'/>

<data key='user.DB2_ADMIN_PWD,com.ibm.skim27.db2.aix.ofng' value='mdoQ5vWqvwGUwOgZaAiFqg=="/>

<data key='user.CONFIRM_PASSWORD,com.ibm.sk1m27.db2.aix.ofng' value='m4oQ5viqvwGUw0OgZaAiFqg=="/>

<data key='user.DB2_DB_HOME,com.ibm.sk1m27.db2.aix.ofng' value='/home/skimdb27'/>

<data key='user.DB2_DB_NAME,com.ibm.sk1m27.db2.aix.ofng' value='SKLMDB27'/>

<data key='user.DB2_DB_PORT,com.ibm.sk1m27.db2.aix.ofng' value='50030"'/>

<data key='user.DB2_EXISTS,com.ibm.skim27.db2.aix.ofng' value='false'/>

<data key='user.DB2_LOCATION,com.ibm.skim27.db2.aix.ofng' value='/opt/IBM/DB2SKLMV27'/>

<data key='cic.selector.nl' value='en'/>

</profile>

<profile id='IBM Installation Manager' installlLocation='/opt/IBM/InstallationManager/eclipse' kind='self'>

<data key='eclipselLocation' value='/opt/IBM/InstallationManager/eclipse'/>

<data key='user.import.profile' value='false'/>

<data key='cic.selector.os' value='aix'/>

<data key='cic.selector.arch' value='ppc'/>

<data key='cic.selector.ws' value='gtk'/>

</profile>

<profile id='1IBM WebSphere Application Server V9.0' installlLocation='/usr/IBM/WebSphere27/AppServer'>

<data key='eclipselLocation' value='/usr/IBM/WebSphere27/AppServer'/>

<data key='user.import.profile' value='false'/>

<data key='cic.selector.os' value='aix'/>

<data key='cic.selector.arch' value='ppc64'/>

<data key='cic.selector.ws' value='gtk'/>

<data key='cic.selector.nl' value='en'/>

</profile>

<profile id='IBM Security Key Lifecycle Manager v2.7' installlocation="'/opt/IBM/SKLMV27'>

<data key='eclipselocation' value='/opt/IBM/SKLMV27'/>

<data key='user.import.profile' value='false'/>
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<data key='cic.selector.os' value='aix'/>

<data key='cic.selector.arch' value='ppc64'/>

<data key='cic.selector.ws' value='gtk'/>

<data key='user.EKM_PROPFILE,com.ibm.skim27.aix' value='/opt/IBM/KeyManagerConfig.properties'/>
<data key='user.EKM_MIGRATION,com.ibm.skim27.aix' value='false'/>

<data key='user.PROFILE_NAME,com.ibm.skim27.aix' value='KLMProfile'/>

<data key='user.WAS_ADMIN_ID,com.ibm.skim27.aix' value='tipadmin'/>

<data key='user.WAS_ADMIN_PASSWORD,com.ibm.skim27.aix' value='e9PjNI3MeQxwnSsIVXIFMw=="/>

<data key='user.WAS_ADMIN_CONF_PWD,com.ibm.skim27.aix' value='e9PjN9I3MeQxwnSsIVXIFMw=="/>

<data key='user.SKLM_ADMIN_USER,com.ibm.skim27.aix' value='TKLMAdmin'/>

<data key='user.SKLM_ADMIN_PASSWORD,com.ibm.skim27.aix' value='9YTRIMRIydDSdfhaHPslag=="/>
<data key='user.SKLM_ADMIN_CONF_PWD,com.ibm.sk1m27.aix' value='9YTRIJMRIydDSdfhaHPslag=='/>
<data key='user.TKLM_VERSION,com.ibm.skim27.aix' value='2.0.1'/>

<data key='user.TKLM_TIP_HOME,com.ibm.skim27.aix' value='/opt/IBM/tivoli/tiptkimv2/'/>

<data key='user.TKLM_INSTALLED,com.ibm.skim27.aix' value='true'/>

<data key='user.TKLM_DB_PWD,com.ibm.skim27.aix"' value="'/6vJIK3fcU3QxHY+RVfCFVw=="/>

<data key='user.TKLM_KEYSTORE_PWD,com.ibm.sk1m27.aix' value='fufgZbY47EfxLYarBAIxeQ=="/>

<data key='user.SKLM_APP_PORT,com.ibm.skIm27.aix" value='@SKLMSECUREPORT@'/>

<data key='user.WAS_ADMIN_PORT,com.ibm.skim27.aix' value='9083'/>

<data key='user.SKLM_APP_NS_PORT,com.ibm.sk1m27.aix' value='80"'/>

<data key='cic.selector.nl' value='en'/>

</profile>

<preference name='com.ibm.cic.common.core.preferences.eclipseCache' value='/opt/IBM/IBMIMShared'/>
<preference name='com.ibm.cic.common.core.preferences.connectTimeout' value='30'/>

<preference name='com.ibm.cic.common.core.preferences.readTimeout' value='45"'/>

<preference name='com.ibm.cic.common.core.preferences.downloadAutoRetryCount' value='0"'/>
<preference name='offering.service.repositories.areUsed' value='true'/>

<preference name='com.ibm.cic.common.core.preferences.ssl.nonsecureMode' value='false'/>
<preference name='com.ibm.cic.common.core.preferences.http.disablePreemptiveAuthentication' value='false'/>
<preference name='http.ntim.auth.kind' value='NTLM'/>

<preference name='http.ntim.auth.enableIntegrated.win32' value='true'/>

<preference name='com.ibm.cic.common.core.preferences.preserveDownloadedArtifacts' value='true'/>
<preference name='com.ibm.cic.common.core.preferences.keepFetchedFiles' value='false'/>
<preference name='PassportAdvantagelsEnabled' value='false'/>

<preference name='com.ibm.cic.common.core.preferences.searchForUpdates' value='false'/>
<preference name='com.ibm.cic.agent.ui.displayInternalVersion' value='false'/>

<preference name='com.ibm.cic.common.sharedUI.showErrorLog' value='true'/>

<preference name='com.ibm.cic.common.sharedUI.showWarningLog' value='true'/>

<preference name='com.ibm.cic.common.sharedUI.showNoteLog' value='true'/>

</agent-input>

Uninstallation on Windows systems

The example response file contains responses for uninstall on Windows systems.

<?xml version="1.0" encoding="UTF-8"?>

<agent-input clean='true' >

<profile id='IBM Security Key Lifecycle Manager v2.7'>

<data key='user.WAS_ADMIN_ID,com.ibm.skim27.win' value='wasadmin'/>

<data key='user.WAS_ADMIN_PASSWORD,com.ibm.skim27.win' value='e9PjN9I3MeQxwnSsIVXIFMw=="/>

</profile>

<uninstall modify='false'>

<offering id='com.ibm.skim27.win' profile='IBM Security Key Lifecycle Manager v2.7' features='main.feature'/>
<offering id='com.ibm.websphere.BASE.v90' profile='IBM WebSphere Application Server V9.0' features='core.feature,ej
embeddablecontainer' />

<offering id='com.ibm.java.jdk.v8' profile='IBM WebSphere Application Server V9.0' features='com.ibm.sdk.8'/>
<offering id="'com.ibm.skim27.db2.win.ofng' profile='IBM DB2 SKLM27' features='main.feature'/>

</uninstall>

</agent-input>

Uninstallation on Linux systems

The example response file contains responses for uninstall on a Linux system.

<?xml version="1.0" encoding="UTF-8"?>

<agent-input clean='true' >

<profile id="IBM Security Key Lifecycle Manager v2.7'>

<data key='user.WAS_ADMIN_ID,com.ibm.skim27.1inux' value='wasadmin'/>

<data key='user.WAS_ADMIN_PASSWORD,com.ibm.skim27.1inux" value='e9PjN9I3MeQxwnSsIVXIFMw=="/>

</profile>

<uninstall modify='false'>

<offering id='com.ibm.skim27.1inux' profile='IBM Security Key Lifecycle Manager v2.7' features='main.feature'/>
<offering id='com.ibm.websphere.BASE.v90' profile='IBM WebSphere Application Server V9.0' features='core.feature,ej
embeddablecontainer'/>
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<offering id='com.ibm.java.jdk.v8"' profile='IBM WebSphere Application Server V9.0' features='com.ibm.sdk.8'/>
<offering id='com.ibm.skim27.db2.1in.ofng' profile='IBM DB2 SKLM27' features='main.feature'/>

</uninstall>

</agent-input>

Uninstallation on Linux for System z

The example response file contains responses for uninstall on Linux for System z.

<?xml version="1.0" encoding="UTF-8"?>

<agent-input clean='true' >

<profile id='IBM Security Key Lifecycle Manager v2.7'>

<data key='user.WAS_ADMIN_ID,com.ibm.skim27.1inux' value='wasadmin'/>

<data key='user.WAS_ADMIN_PASSWORD,com.ibm.sk1m27.1inux' value='e9PjN93MeQxwnSsOVXIFMw=="/>

</profile>

<uninstall modify='false'>

<offering id='com.ibm.skim27.1inux' profile='IBM Security Key Lifecycle Manager v2.7' features='main.feature'/>
<offering id='com.ibm.websphere.BASE.v90' profile='IBM WebSphere Application Server V9.0' features='core.feature,ejbde
embeddablecontainer'/>

<offering id='com.ibm.java.jdk.v8' profile='IBM WebSphere Application Server V9.0' features='com.ibm.sdk.8' />
<offering id='com.ibm.sk1m27.db2.7in.ofng"' profile='IBM DB2 SKLM27' features='main.feature'/>

</uninstall>

</agent-input>

Uninstallation on AIX systems

The example response file contains responses for uninstall on a AIX system.

<?xml version="1.0" encoding="UTF-8"?>

<agent-input clean='true' >

<profile id="IBM Security Key Lifecycle Manager v2.7'>

<data key='user.WAS_ADMIN_ID,com.ibm.skim27.aix' value='wasadmin'/>

<data key='user.WAS_ADMIN_PASSWORD,com.ibm.skim27.aix' value='e9PjN9I3MeQxwnSsIVXJIFMw=="/>

</profile>

<uninstall modify='false'>

<offering id='com.ibm.skim27.aix' profile='IBM Security Key Lifecycle Manager v2.7' features='main.feature'/>
<offering id='com.ibm.websphere.BASE.v90' profile="IBM WebSphere Application Server V9.0' features='core.feature,ejbde
embeddablecontainer'/>

<offering id='com.ibm.java.jdk.v8"' profile='IBM WebSphere Application Server V9.0' features='com.ibm.sdk.8'/>
<offering id='com.ibm.skim27.db2.aix.ofng' profile='IBM DB2 SKLM27' features='main.feature'/>

</uninstall>

</agent-input>
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Notices

This information was developed for products and services offered in the U.S.A.
IBM may not offer the products, services, or features discussed in this document in
other countries. Consult your local IBM representative for information on the
products and services currently available in your area. Any reference to an IBM
product, program, or service is not intended to state or imply that only that IBM
product, program, or service may be used. Any functionally equivalent product,
program, or service that does not infringe any IBM intellectual property right may
be used instead. However, it is the user's responsibility to evaluate and verify the
operation of any non-IBM product, program, or service.

IBM may have patents or pending patent applications covering subject matter
described in this document. The furnishing of this document does not give you
any license to these patents. You can send license inquiries, in writing, to:

IBM Director of Licensing

IBM Corporation

North Castle Drive

Armonk, NY 10504-1785 U.S.A.

For license inquiries regarding double-byte character set (DBCS) information,
contact the IBM Intellectual Property Department in your country or send
inquiries, in writing, to:

Intellectual Property Licensing

Legal and Intellectual Property Law
IBM Japan, Ltd.

19-21, Nihonbashi-Hakozakicho, Chuo-ku
Tokyo 103-8510, Japan

The following paragraph does not apply to the United Kingdom or any other
country where such provisions are inconsistent with local law :

INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS
PUBLICATION "AS IS" WITHOUT WARRANTY OF ANY KIND, EITHER
EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS
FOR A PARTICULAR PURPOSE.

Some states do not allow disclaimer of express or implied warranties in certain
transactions, therefore, this statement might not apply to you.

This information could include technical inaccuracies or typographical errors.
Changes are periodically made to the information herein; these changes will be
incorporated in new editions of the publication. IBM may make improvements
and/or changes in the product(s) and/or the program(s) described in this
publication at any time without notice.

Any references in this information to non-IBM Web sites are provided for
convenience only and do not in any manner serve as an endorsement of those Web
sites. The materials at those Web sites are not part of the materials for this IBM
product and use of those Web sites is at your own risk.
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IBM may use or distribute any of the information you supply in any way it
believes appropriate without incurring any obligation to you.

Licensees of this program who wish to have information about it for the purpose
of enabling: (i) the exchange of information between independently created
programs and other programs (including this one) and (ii) the mutual use of the
information which has been exchanged, should contact:

IBM Corporation

274A /101

11400 Burnet Road
Austin, TX 78758 U.S.A.

Such information may be available, subject to appropriate terms and conditions,
including in some cases payment of a fee.

The licensed program described in this document and all licensed material
available for it are provided by IBM under terms of the IBM Customer Agreement,
IBM International Program License Agreement or any equivalent agreement
between us.

Any performance data contained herein was determined in a controlled
environment. Therefore, the results obtained in other operating environments may
vary significantly. Some measurements may have been made on development-level
systems and there is no guarantee that these measurements will be the same on
generally available systems. Furthermore, some measurement may have been
estimated through extrapolation. Actual results may vary. Users of this document
should verify the applicable data for their specific environment.

Information concerning non-IBM products was obtained from the suppliers of
those products, their published announcements or other publicly available sources.
IBM has not tested those products and cannot confirm the accuracy of
performance, compatibility or any other claims related to non-IBM products.
Questions on the capabilities of non-IBM products should be addressed to the
suppliers of those products.

All statements regarding IBM's future direction or intent are subject to change or
withdrawal without notice, and represent goals and objectives only.

All IBM prices shown are IBM's suggested retail prices, are current and are subject
to change without notice. Dealer prices may vary.

This information is for planning purposes only. The information herein is subject to
change before the products described become available.

This information contains examples of data and reports used in daily business
operations. To illustrate them as completely as possible, the examples include the
names of individuals, companies, brands, and products. All of these names are
fictitious and any similarity to the names and addresses used by an actual business
enterprise is entirely coincidental.

COPYRIGHT LICENSE:

This information contains sample application programs in source language, which
illustrate programming techniques on various operating platforms. You may copy,
modify, and distribute these sample programs in any form without payment to
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IBM, for the purposes of developing, using, marketing or distributing application
programs conforming to the application programming interface for the operating
platform for which the sample programs are written. These examples have not
been thoroughly tested under all conditions. IBM, therefore, cannot guarantee or
imply reliability, serviceability, or function of these programs. You may copy,
modify, and distribute these sample programs in any form without payment to
IBM for the purposes of developing, using, marketing, or distributing application
programs conforming to IBM's application programming interfaces.

Each copy or any portion of these sample programs or any derivative work, must
include a copyright notice as follows:

© (your company name) (year). Portions of this code are derived from IBM Corp.
Sample Programs. © Copyright IBM Corp. _enter the year or years_. All rights
reserved.

If you are viewing this information in softcopy form, the photographs and color
illustrations might not be displayed.

Terms and conditions for product documentation

Permissions for the use of these publications are granted subject to the following
terms and conditions.

Applicability
These terms and conditions are in addition to any terms of use for the IBM
website.

Personal use
You may reproduce these publications for your personal, noncommercial
use provided that all proprietary notices are preserved. You may not
distribute, display or make derivative work of these publications, or any
portion thereof, without the express consent of IBM.

Commercial use
You may reproduce, distribute and display these publications solely within
your enterprise provided that all proprietary notices are preserved. You
may not make derivative works of these publications, or reproduce,
distribute or display these publications or any portion thereof outside your
enterprise, without the express consent of IBM.

Rights Except as expressly granted in this permission, no other permissions,
licenses or rights are granted, either express or implied, to the publications
or any information, data, software or other intellectual property contained
therein.

IBM reserves the right to withdraw the permissions granted herein
whenever, in its discretion, the use of the publications is detrimental to its
interest or, as determined by IBM, the above instructions are not being
properly followed.

You may not download, export or re-export this information except in full
compliance with all applicable laws and regulations, including all United
States export laws and regulations

IBM MAKES NO GUARANTEE ABOUT THE CONTENT OF THESE
PUBLICATIONS. THE PUBLICATIONS ARE PROVIDED "AS-IS" AND
WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESSED OR
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IMPLIED, INCLUDING BUT NOT LIMITED TO IMPLIED WARRANTIES
OF MERCHANTABILITY, NON-INFRINGEMENT, AND FITNESS FOR A
PARTICULAR PURPOSE.

Trademarks

IBM, the IBM logo, and ibm.com are trademarks or registered trademarks of

International Business Machines Corp., registered in many jurisdictions worldwide.
Other product and service names might be trademarks of IBM or other companies.
A current list of IBM trademarks is available on the web at Ihtt‘p: / /www.ibm.com/ |
[legal / copytrade.shtmil

Adobe, Acrobat, PostScript and all Adobe-based trademarks are either registered
trademarks or trademarks of Adobe Systems Incorporated in the United States,
other countries, or both.

IT Infrastructure Library is a registered trademark of the Central Computer and
Telecommunications Agency which is now part of the Office of Government
Commerece.

Intel, Intel logo, Intel Inside, Intel Inside logo, Intel Centrino, Intel Centrino logo,
Celeron, Intel Xeon, Intel SpeedStep, Itanium, and Pentium are trademarks or
registered trademarks of Intel Corporation or its subsidiaries in the United States
and other countries.

Linux is a trademark of Linus Torvalds in the United States, other countries, or
both.

Microsoft, Windows, Windows NT, and the Windows logo are trademarks of
Microsoft Corporation in the United States, other countries, or both.

ITIL is a registered trademark, and a registered community trademark of the Office

of Government Commerce, and is registered in the U.S. Patent and Trademark
Office.

UNIX is a registered trademark of The Open Group in the United States and other
countries.

Java and all Java-based trademarks and logos are trademarks or registered
— trademarks of Oracle and/or its affiliates.

Java

COMPATIBLE
Cell Broadband Engine is a trademark of Sony Computer Entertainment, Inc. in the
United States, other countries, or both and is used under license therefrom.

Linear Tape-Open, LTO, the LTO Logo, Ultrium, and the Ultrium logo are
trademarks of HP, IBM Corp. and Quantum in the U.S. and other countries.
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